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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided on the Web. Go to www.keysight.com and type in your product number in 
the Search field at the top of the page.

General This product is a Protection Class 1 instrument (provided with a protective earth terminal) 
and has been manufactured and tested according to international safety standards. The 
protective features of this product may be impaired if it is used in a manner not specified 
in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per 
IEC 60825-1:2014.

Environment Conditions This instrument is intended for indoor use in an Overvoltage Category II, pollution degree 
2 environment. It is designed to operate at a maximum relative humidity of 85% RH, 
non-condensing and at altitudes of up to 2000 meters. Refer to the specifications tables 
for the AC mains voltage requirements and ambient operating temperature range.

Temperature The instrument should be protected from temperature extremes and changes in 
temperature that may cause condensation within it.

The operating temperature is from 5 °C to +40 °C.

The storage temperature is from -40 °C to +70 °C.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the AC power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

http://www.keysight.com
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Instrument Markings

Instrument Marking Description

The instruction manual symbol. The product is marked with this warning symbol when it 
is necessary for the user to refer to the instructions in the manual.

Standby supply. Unit is not completely disconnected from AC mains when switch is
off. 

The CE mark is a registered trademark of the European Community.

The CSA mark with the 'c' and 'us' subscript indicates the instrument is certified to the 
applicable Canadian and United States of America standards respectively. 

 The RCM mark is a registered trademark of the Australian Communications and Media 
Authority

The KC mark is the Korean certification mark. This equipment is Class A suitable for 
professional use and is for use in electromagnetic environments outside of the home.

The recycling symbol indicates the general ease with which the instrument can be 
recycled.

China Restricted Substance Product Label. The EPUP (environmental protection use
period) number in the center indicates the time period during which no hazardous
or toxic substances or elements are expected to leak or deteriorate during normal
use and generally reflects the expected useful life of the product.
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Compliance and Environmental Information

Table 1  Compliance and Environmental Information

Declaration of Conformity
Declarations of Conformity for this product and for the Keysight products may be 
downloaded from the Web. Go to http://www.keysight.com/go/conformity. You can then 
search by product number to find the latest Declaration of Conformity.

Contact Keysight Technologies
To contact an expert, visit www.keysight.com/find/contactus.

Safety Symbol Description

The crossed out wheeled bin symbol indicates that separate collection for waste 
electric and electronic equipment (WEEE) is required, as obligated by the EU 
DIRECTIVE and other National legislation. 
Please refer to http://www.keysight.com/go/takeback to understand your Trade in 
options with Keysight in addition to product takeback instructions.

http://www.keysight.com/go/conformity
https://www.keysight.com/go/takeback
www.keysight.com/find/contactus
https://www.keysight.com/go/takeback
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Acronyms
The following acronyms are used in this document:

• O-RU – O-RAN Radio Unit

• O-DU – O-RAN Distributed Unit

• mmWave – millimeter wave

• OTA – Over the Air

• O-RAN CUS – O-RAN Control, User, and Synchronization Plane

• RF – Radio Frequency

• DL – Downlink

• UL – Uplink

• PBCH – Physical Broadcast Channel

• PDCCH – Physical Downlink Control Channel

• PDSCH – Physical Downlink Shared Channel

• PSS – Primary Synchronization Signal

• SSS – Secondary Synchronization Signal

• PUSCH – Physical Uplink Shared Channel

• PUCCH - Physical Uplink Control Channel

• PRACH – Physical Random Access Channel

• CSI-RS – Channel State Information Reference Signal

• GUI - Graphical User Interface

• IQ - In-Phase, Quadrature

• symInc - symbol number increment command

• rb - resource block indicator

• reMask - resource element mask

• rbgSize - resource block group size

• rbgMask - resource block group bit mask

• symbolMask - symbol bit mask
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1 Introduction
 

Section 1.1: Overview

Open RAN Studio provides a test environment that includes and integrates 
with Keysight tools, in both RF and Protocol Domains, to help you 
completely exercise an O-RAN CUS (Control, User, and Synchronization 
Plane) compliant Radio Unit (O-RU).

To ensure measurement consistency between both RF and Baseband sides 
of the O-RU, Open RAN Studio software leverages the same industry 
leading 5G signal generation and measurement science used in Keysight 
spectrum analyzers and signal sources. This tight coupling ensures 
CU-plane messages and baseband information match exactly with the 
signals captured on the RF side of the Radio Unit.

Designed for LTE and 5G O-RAN Radio Unit (O-RU) testing, Keysight Open 
RAN Studio provides powerful, yet easy to use, capabilities to:

• Build O-RAN compliant CUS-plane test vectors.

• Emulate an O-RAN Distributed Unit (O-DU) to generate the test vectors 
against a Device Under Test (DUT).

• Capture and accurately timestamp the DUT’s responses.

• Perform measurements needed to validate if the O-RU meets standard 
compliant operation and radio performance.

Open RAN Studio includes powerful O-RAN focused tools to construct, 
play, capture, and measure O-RAN traffic over 10 Gbps / 25 Gbps 
(fronthaul) Ethernet interfaces. Out of the box integration with Keysight’s 
industry-leading PathWave Signal Generator and 89600 VSA software 
enables sophisticated 5G signal creation and easy capture, extraction, and 
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export of IQ vectors – for advanced modulation analysis of received RF / 
mmWave signals and radio performance. Additionally, when combined 
with Keysight spectrum analyzers and signal sources, the integrated Open 
RAN Studio solution delivers the most comprehensive cross domain, 
multi-channel RF / mmWave and O-RAN protocol measurements 
available in the industry, for both FR1 and FR2 radios, downlink (DL) and 
uplink (UL) paths.

Figure 1 Integrated Open RAN Studio solution for comprehensive O-RU testing

Figure 1 illustrates a simplified architecture for the Open RAN Studio suite 
of integrated tools and optional elements, which include:

1 PathWave Signal Generation Desktop 2022 creates 3GPP compliant 
5G NR waveforms for emulation through Open RAN Studio to an O-RU 
/ DUT and subsequent transmission to a downstream signal analyzer, 
DUT, or complaint UE.

2 N7624C Signal Studio Pro for LTE/LTE-Advanced FDD and N7625C 
Signal Studio Pro for LTE/LTE-Advanced TDD create 3GPP compliant 
LTE FDD/TDD waveforms. These waveforms can be imported using the 
Open RAN Studio FDD/TDD Support applications and then loaded into 
Open RAN Studio for emulation and subsequent transmission to a 
downstream signal analyzer, DUT, or complaint UE.
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3 Open RAN Studio integrates five powerful O-RAN development tools 
to construct, play, capture, measure, and extract IQ vectors for split 
option 7.2x O-RAN traffic over a 10 or 25 Gbps fronthaul Interface.

a Open RAN Studio Builder helps you easily construct diverse O-RAN 
test vectors. The PCAPNG formatted output file includes the 
complete Ethernet / VLAN / eCPRI / O-RAN stack.

b Open RAN Studio Player is a hardware-based exerciser that 
emulates a DU and transmits ORAN Studio build test vectors to an 
O-RU / DUT through the O-RAN interface – honoring O-RAN 
CUS-plane timing windows.

c Open RAN Studio Capture is a hardware-based analyzer that 
captures the bidirectional Tx and Rx information flows between the 
DU and O-RU over the O-RAN interface.

d Open RAN Studio Explorer decodes and visualizes the O-RAN 
protocol information and enables measurement in both protocol and 
RF / mmWave domains.

e Open RAN Studio IQ Extractor is an optional application that 
reconstructs a time domain IQ file from an O-RAN trace capture for 
further modulation measurements with 89600 VSA software.

4 89600 VSA for 5G NR may optionally receive captured IQ vectors from 
Open RAN Studio IQ Extractor to perform 5G NR modulation and radio 
performance measurements.

 1.1.1: 5G NR Channels/Signals supported by O-RAN Studio

The O-RAN Studio supports the following 5G NR Channels/Signals:

Downlink Physical Channels

• Physical Broadcast Channel (PBCH)

• Physical Downlink Control Channel (PDCCH)

• Physical Downlink Shared Channel (PDSCH)

Downlink Physical Signals

• Primary Synchronization Signal (PSS)

• Secondary Synchronization Signal (SSS)

Uplink Physical Channels

• Physical Uplink Shared Channel (PUSCH)

• Physical Random Access Channel (PRACH)
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Section 1.2: References

• For conceptual information about the various elements in the Open 
RAN standards, refer to the O-RAN Fronthaul Control, User and 
Synchronization Plane Version 4.0 (ORAN-WG4.CUS.0-v4.00). 

• To download a copy of the specification, visit 
https://www.o-ran.org/specifications.

https://www.o-ran.org/specifications
https://www.o-ran.org/specifications
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Section 1.3: BittWare Hardware

Figure 3 shows the front view of a BittWare TeraBox 1000S FPGA server. 
The SMB male connectors connect O-RU and Keysight instrumentation. 
Note that the Clock Input can either be a 10 MHz square waveform or 100 
MHz sine or square waveform.

Figure 2 Front view of the BittWare Hardware

Figure 3 depicts the right side of the front panel of BittWare server:

Figure 3 Depiction of the front panel of the BittWare Hardware

It has the following input/output ports:

1 CLK IN – This is a reference clock in that is used for the internal clock 
reference.

2 PPS IN – This is a Pulse Per-Second (PPS) in that can be used for 
reference. (Not implemented in the current version).
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3 TRIG IN – This is used for trigger in, which means it will start playing 
+ delta, whatever is queued up to be play by ORAN Studio. (Not 
implemented in the current version).

4 TRIG OUT – This is used to generate trigger output when Player or 
Recorder starts ± delta.

5 PPS OUT – This is an output Pulse Per-Second (PPS) that can be used 
for reference.

NOTE
In the BittWare hardware, QSFP0 and QSFP2 are the only slots that can 
be currently used. Only the first 10G/25G set of lanes on that QSFP can 
be used.
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Section 1.4: Understanding SFP / QSFP modules & Cable types

This section describes the various cable types, various SFP and QSFP 
modules along with their insertion/removal procedures. To understand 
these parts, let us consider the various connectivity options available with 
the BittWare server. Note that the left side of each illustration (with the 
module inserted into the QSFP28 to SFP28 adapter) is connected into the 
BittWare server.

Figure 4 QSFP28 to SFP28 Multi-mode Fiber Breakout

Figure 5 QSFP28 to SFP28 adapter with MMF

Figure 6 QSFP28 to SFP28 adapter with SMF
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Figure 7 QSFP28 to SFP28 adapter with Bi-directional SFP28

Figure 8 QSFP28 to SFP28 adapter with 10GBASE-T Copper

 1.4.1: Cable types

For the connectivity option shown in Figure 4, the MTP Female to 4 x LC (8 
Fibers) Duplex Multi-mode Type B Breakout Cables are shown in Figure 9. 
Type B indicates that it crosses over Tx and Rx in the fibers as required.

These cables are required to connect from a QSFP28 100GBASE-SR4 
modules. The four fiber pairs, which are available with the LC connectors, 
are labeled 1 to 4, which correspond to the four Ethernet lanes in the 
QSFP28 module. Table 2 shows the mappings of the lanes to fibers.

Note that there a 12 fibers in the MPO connector, but for the 25G/100G 
Ethernet, fibers 5 to 8 are not used. Each lane has two fibers for Tx / Rx.
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Table 2 Lane-to-fiber mapping

Figure 9 MTP Female to 4 x LC cables (full-length view)

Lane Fibers

1 1/12

2 2/11

3 3/10

4 4/9
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Figure 10 MTP Female to 4 x LC cables (close-up)

Figure 11 LC connector (close-up view)

Figure 12 MTP Female connector (top view)
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Figure 13 MTP Female connector (front view)

The Cat-5 cable, as depicted in Figure 8, is inserted into the SFP and the 
BittWare server.

Figure 14 Cat-5 cable (connected to SFP and server)
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The LC Duplex cable, shown in Figure 15, can be used for loopback 
connections.

Figure 15 LC fiber duplex cable

 1.4.2: Modules

The modules that you may use with the BittWare server are:

• SFP — Small Form-Factor Pluggable modules. The three categories are:

• SFP — supports 100 Mbps to 4 Gbps per lane

• SFP+ — supports up to 10 Gbps per lane

• SFP28 — supports up to 25 Gbps per lane

• QSFP — Quad Small Form-Factor Pluggable modules. The three 
categories are:

• QSFP — supports up to 4 Gbps (4 lanes x 1 Gbps per lane)

• QSFP+ — supports up to 40 Gbps (4 lanes x 10 Gbps per lane)

• QSFP28 — supports up to 100 Gbps (4 lanes x 25 Gbps per lane)

Note that the BittWare server has four QSFP28 ports. You may plug in 
QSFP modules without adapters.

Also, SFP28 modules can be used with QSFP28 to SFP28 adapters. 
Similarly, SFP+ modules can be used with QSFP+ to SFP+ adapters.
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Figure 16 QSFP28 to SFP28 adapter (top view)

Figure 17 QSFP28 module (lateral view)

Figure 18 SFP28 module (top view)

Figure 19 Copper SFP module (top view)

NOTE
Keysight recommends that if you are using 10G data rates, use 10G only 
(SFP+) modules, or if using SFP28 25G optics, verify that CRC errors are 
0 for a sustained time on both ends of the link (which means inspecting 
O-RU statistics as well).
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 1.4.3: Inserting & removing modules and cables

Inserting MTP connector to QSFP28 module

The MTP connector is keyed, so it cannot be inserted upside down. 
Figure 20 shows the QSFP28 module with the key down and Figure 21 
shows the MTP connector with the key up.

Figure 22 show how to insert the MTP connector to the QSFP28 module.

Figure 20 QSFP28 module (rear view) with key down

Figure 21 MTP connector with key up
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Figure 22 Inserting MTP Connector to the QSFP28 module

When inserted properly, the MTP connector fits in with a ‘click’.
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Inserting LC fiber connectors to SFP28 module

After inserting the MTP connector into the QSFP28 module, let us insert 
the other end of the cable (LC fibers) into an SFP28 25GBASE-SR module. 
Note that the Lane 1 is inserted into the module.

Figure 22 shows how to insert the LC fibers into the SFP28 module. Notice 
that the clip on the fiber must face the lower end of the SFP28 module.

Figure 23 Inserting Lane 1 of the LC fiber to the SFP28 module

When inserted properly, the cable fits in with a ‘click’.
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Figure 24 SFP28 module after LC fiber connectors are inserted
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Inserting QSFP28 module into BittWare server

Figure 25 shows the flow to insert the QSFP28 module into the BittWare 
server. When inserted properly, the module fits in with a ‘click’. 

Figure 25 Inserting QSFP28 module into BittWare server
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Removing QSFP28 module from the BittWare server

Figure 26 shows how to hold and pull the clasp in the outward direction to 
release the QSFP28 module.

Figure 26 Removing QSFP28 module from BittWare server
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Removing MTP Connector from the QSFP28 module

Figure 27 shows how to hold and pull back the blue clasp to release the 
MTP connector from the QSFP28 module.

Figure 27 Removing MTP Connector from the QSFP28 module
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Removing LC fiber connectors from the SFP28 module

Figure 28 shows how to pinch the clips to release the LC fibers from the 
SFP28 module.

Figure 28 Removing LC fiber connectors from the SFP28 module
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Inserting SFP28 module into a QSFP28 to SFP28 adapter

Figure 29 shows how to insert an SFP28 module into a QSFP28 to SFP28 
adapter.

Figure 29 Inserting SFP28 module to a QSFP28 to SFP28 adapter
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Removing SFP28 module from the QSFP28 to SFP28 adapter

Figure 30 shows how to remove an SFP28 module from a QSFP28 to 
SFP28 adapter.

Figure 30 Removing SFP28 module to a QSFP28 to SFP28 adapter
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Inserting the QSFP28 to SFP28 adapter into the BittWare server

Figure 31 shows how to insert the QSFP28 to SFP28 adapter, with the 
SFP28 module within, into Slot 0 of the BittWare server.

Figure 31 Inserting QSFP28 to SFP28 adapter into Slot 0 of BittWare server
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Inserting LC fiber connector into the SFP28 module

Figure 32 shows how to insert the LC fiber connector to the SFP28 
module, which has been inserted into Slot 0 of the BittWare server. When 
inserted properly, it should fit with a ‘click’, as shown in Figure 23.

Figure 32 Inserting LC fiber connector into the SFP28 module
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Removing LC fiber connector from the SFP28 module

Figure 33 shows how to remove the LC fiber connector from the SFP28 
module, which has been inserted into the QSFP28 to SFP28 adapter. The 
procedure is same as that shown in Figure 28, where you must pinch the 
clip to remove the cable.

Figure 33 Removing LC fiber connector from the SFP28 module
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Removing SFP28 module from the QSFP28 to SFP28 adapter

Figure 34 shows how to remove the SFP28 module from the QSFP28 to 
SFP28 adapter, which has been inserted into Slot 0 of the BittWare server. 
The procedure is same as that shown in Figure 30, where you must flip up 
the clasp to remove the module.

Figure 34 Removing SFP28 module from the QSFP28 to SFP28 adapter
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Removing the QSFP28 to SFP28 adapter from the BittWare server

Figure 35 shows how to remove the QSFP28 to SFP28 adapter from the 
Slot 0 of the BittWare server. Pull out the black clasp to release it.

Figure 35 Removing SFP28 module from the QSFP28 to SFP28 adapter
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 1.4.4: Copper SFP module for M-Plane Passthrough

Inserting the Copper SFP module into a QSFP28 to SFP28 adapter

The process for inserting the Copper SFP module is the same as that of 
inserting a fiber SFP28 module. See Inserting SFP28 module into a 
QSFP28 to SFP28 adapter on page 35. The inverted position of the 
QSFP28 to SFP28 adapter, with the Copper SFP module inserted within, is 
shown in Figure 36.

Figure 36 Inserting a Copper SFP module into a QSFP28 to SFP28 adapter

NOTE
In this section, an SFP+ 10GBASE-T module is shown for the purpose of 
illustration. While they are almost identical in appearance, for M-Plane 
Passthrough, a 1000BASE-T SFP module (1G) is actually required.
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Inserting the QSFP28 to SFP28 adapter into the BittWare server

The process for inserting the QSFP28 to SFP28 adapter, with the Copper 
SFP module, is the same as that of Inserting the QSFP28 to SFP28 adapter 
into the BittWare server on page 37. The only difference here is that this 
unit should be plugged into the QSFP Slot 2, which is the second slot from 
the left. A QSFP28 to SFP28 adapter being plugged into Slot 2 is shown in 
Figure 37.

Figure 37 Inserting the QSFP28 to SFP28 adapter to Slot 2 of BittWare server
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Inserting the Cat-5 cable

One end of a Cat-5 cable is inserted into the Copper SFP module, within 
the QSFP28 to SFP28 adapter, as shown in Figure 38.

Figure 38 Inserting the Cat-5 cable to the Copper SFP module
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The other end of the Cat-5 cable is inserted into the secondary Ethernet 
port on the BittWare server, as shown in Figure 39.

Figure 39 Inserting the Cat-5 cable to the secondary Ethernet port
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BittWare Server Connections

Figure 40 shows the overall BittWare server configuration, where:

• a QSFP28 module with MTP fiber is connected into the QSFP slot 0

• the other end is connected to the O-RU, where the LC fiber connector 
is inserted into an SFP28 25GBASE-SR module

• the Copper SFP module is connected via a QSFP28 to SFP28 adapter 
into the QSFP slot 2 and the secondary Ethernet port using a Cat-5 
cable

Figure 40 BittWare server after all connections are made
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 1.4.5: Creating a Loopback Fiber from a Duplex LC cable

In order to test an SFP28 25GBASE-SR or LR module, when there is no 
loopback available, an alternative method is to hold together two LC 
connectors at each end at a clip. If the clip is removed, you can connect 
both ends of the same fiber into the SFP, thereby, creating a loopback. 
Note the color coding on the fibers (one fiber has a yellow sleeve on each 
end).

Figure 41 Creating a Loopback Fiber
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Section 2.1: Launching O-RAN User Interface

You may launch the O-RAN Studio either in online or in offline mode.

In the online mode, the software is connected to BittWare hardware; 
whereas, hardware connection is neither required nor available in the 
offline mode. Moreover, several other features, including Player or 
Recorder functionality are not available in the offline mode.

To launch the O-RAN Studio interface in online mode, click Start > 
Keysight Open RAN Studio > U5040A Open RAN Studio.

Figure 42 O-RAN Studio listed on the Start menu

Click either U5040A Open RAN Studio or U5040A Open RAN Studio - 
Offline to launch the O-RAN Studio interface in online mode or offline 
mode, respectively.

NOTE
For installation instructions, refer to the Keysight U5040A Open RAN 
Studio Getting Started Guide document, which is available on the 
U5040BSCA Open RAN Studio for O-RAN Radio Unit (O-RU) Testing and 
Validation Technical Support page.

https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-31751.1288444&pid=3058136&pageMode=PL
https://www.keysight.com/main/techSupport.jspx?cc=IN&lc=eng&nid=-31751.1288444&pid=3058136&pageMode=PL
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A splash screen is displayed as shown in Figure 43.

Figure 43 Open RAN Studio splash screen
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The default user interface for the O-RAN Studio appears as shown in 
Figure 44. To understand the elements in the order shown in the image 
below, see Exploring O-RAN User Interface on page 53.

Figure 44 Default window of the O-RAN Studio (online)
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Section 2.2: Exploring O-RAN User Interface

The O-RAN user interface consists of the following GUI elements:

1 Title Bar

2 Menu Bar

3 Tool Bar

4 C-Plane Builder / Explorer / Interface Monitor

5 Status Bar

6 Dockable planes

The detailed information on these GUI elements are described in the 
following sections.

 2.2.1: Title Bar

The title bar contains the Keysight logo, product name, and standard
buttons to minimize, maximize or to close the window.

Figure 45 Title bar elements in the Open RAN Studio

 2.2.2: Menu Bar

The menu bar consists of various drop-down sub-menu options, which
provide access to different functions, and launch interactive GUI controls.

The menu bar includes the following drop-down menu options:
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File Menu

The File menu provides the following selections:

1 Recall—This sub-menu item contains the following options:

Figure 46 Elements in the Recall sub-menu

• Open RAN Studio Setup... - Launches the Open dialog, where you 
can navigate to select and load a O-RAN Studio setup file (‘.orstx’ 
file).

• Signal Studio Project... - Launches the Open dialog, where you can 
navigate to select and load a PathWave Signal Generator / Signal 
Studio project file (‘.scp’ file).

• Stimulus/Recording (Explorer)... - Launches the Open dialog, 
where you can navigate to select and load a Packet Capture file 
(‘.pcap’ file), which may either be a “stimulus” file created with 
O-RAN Studio or a “recording” captured with the Open RAN O-DU 
Emulator.

• Stimulus (Load Into Player)... - Launches the Open dialog, where 
you can navigate to select and load a Wireshark Capture file (‘.pcap’ 
file), which is just a “stimulus” file created with O-RAN Studio.

• Default Setup - Clears any loaded project (.scp file) and Open RAN 
Studio Setup (‘.orstx’ file) configuration and restores to default 
settings.

• Default Open RAN Studio Setup - Clears any loaded Open RAN 
Studio Setup (‘.orstx’ file) configuration only and restores to default 
settings.
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2 Save—This sub-menu item contains the following options:

Figure 47 Elements in the Save sub-menu

• Open RAN Studio Setup - Saves the current settings from the 
O-RAN Studio setup (as a ‘.orstx’ file) to the currently associated file 
name. If a file name is not associated, the software prompts you to 
use the ‘Open RAN Studio Setup as...’ option first.

• Open RAN Studio Setup as... - Launches the Save As dialog, where 
you can save the current settings from the O-RAN Studio setup (as a 
‘.orstx’ file) with a file name of your choice.
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3 Export—This sub-menu item contains the following option:

Figure 48 Elements in the Export sub-menu

• Generate Stimulus File - Functions in the same manner as the 
“Export O-RAN Stimulus File” toolbar button (For details, see Tool 
Bar on page 63).

• Generate BLER XML File - See Measuring BER / BLER on page 249 
for more details.

4 Import—This sub-menu item contains the following option:

Figure 49 Elements in the Import sub-menu

• Import LTE Setup for DSS - Lets you add an LTE SCP to a preloaded 
5G NR SCP. For more details, see Configuring LTE Coexistence - 
DSS on page 203.

5 Exit — Close the Open RAN Studio software.
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Control menu

The Control menu provides the following selections:

Figure 50 Elements in the Control menu

• Restart — Functions in the same manner as the “Play Stimulus” toolbar 
button. For details, see Tool Bar on page 63.

• Pause/Restart — Functions in the same manner as the “Pause 
Stimulus” toolbar button. For details, see Tool Bar on page 63.

• Record/Stop record — Functions in the same manner as the “Record” 
toolbar button. For details, see Tool Bar on page 63.

• Sweep — Functions in the same manner as the “Single / Continuous 
Sweep” toolbar button. For details, see Tool Bar on page 63.

Setup menu

The Setup menu provides the following selections:

Figure 51 Elements in the Setup menu

• C/U Plane Builder Configuration... - Opens the C/U Plane Builder 
Configuration dialog to generate O-RAN test vectors. For details, see 
C/U-Plane Builder on page 100.

• Instrument Configuration... - Opens the Instrument Configuration 
dialog. For details, see Instrument Configuration on page 91.
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Test Models menu

The Test Models menu provides the following selections:

Figure 52 Elements in the Test Models menu

• Conformance Tests: O-RAN.WG4.CONF.0-v1.00 - Displays the stock 
data test model patterns based on the O-RAN specification that can be 
applied to the loaded SCP / PCAP file to check for conformance of the 
data. For more information, see Applying Stock Data Test Definitions on 
page 267.

• Additional Test Patterns - Displays test patterns that may not 
completely adhere to the O-RAN specification but are tailored to verify 
conformance of user-defined data. For more information, see Applying 
Additional Test Patterns on page 279.

• Reset - Resets the SCP / PCAP file contents to its original state.

View menu

The View menu provides the following selections:

• Time Display Format > UTC Time of Day (01:02:03. 123456789) — 
Displays the capture time for each packet in the U-Plane, C-Plane 
Messages in the format HH:MM:SS.ninth decimal digit of seconds 
(same as the format for PTP epoch, which is 31 December 1969 
23:59:51.999918 UTC).
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Figure 53 Time display format option 1

• Time Display Format > Seconds Since Beginning of Capture 
(0.123456789s) — Displays the seconds elapsed, in the format of ninth 
decimal digit of seconds, in capturing each packet since the beginning 
of capture of U-Plane, C-Plane Messages.

Figure 54 Time display format option 2
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• Time Display Format > Seconds Since Previous Displayed Packet — 
Displays the seconds, in the format of ninth decimal digit of seconds, 
elapsed since the last packet was captured in the U-Plane, C-Plane 
Messages.

Figure 55 Time display format option 3
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Help menu

The Help menu provides the following selections:

Figure 56 Elements in the Help menu

• Show Help... - Opens the O-RAN Studio Online Help. 

• Search Help... - Allows you to search for any content in the O-RAN 
Studio Online Help.

• Show C-Plane Builder API Help... - Opens the O-RAN Studio C-Plane 
Builder API Online Help.

• Show REST API Help... - Opens the O-RAN Studio REST API Online 
Help.

• U5040A Open RAN Studio Website... - Launches the Open RAN Studio 
Software download page.

• License Manager... - Opens the Keysight License Manager 5 
application. 

• Technical Support... - Launches the U5040BSCA Open RAN Studio for 
O-RAN Radio Unit (O-RU) Testing and Validation Technical Support 
page. 

• Modules... - Opens “Open RAN Studio Diagnostic Information” window 
that displays all loaded DLL files. See Figure 57.
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• About U5040A Open RAN Studio... - Opens the “About U5040A Open 
RAN Studio” window that displays product information including 
current version, release date, build information and web link for product 
support. See Figure 58.

Figure 58 About O-RAN Studio window

 2.2.3: Tool Bar

The tool bar provides the following convenient functions:

Table 3  Tool bar

Elements Name Function

Open File Dialog This button allows you to navigate to an “.SCP” file containing an RF 
designed created under PathWave Signal Generation Desktop 
2022/Signal Studio or to a “.pcap” file, which may either be a 
“stimulus” file created with Oran Studio or a “recording” captured with 
the Open RAN O-DU Emulator.

Export O-RAN Stimulus File This button is used to create the CU-Plane “stimulus” file that 
encapsulates the required C-Plane signaling and the U-Plane payload 
necessary to represent the RF design in the “.SCP” file. This export 
functionality will also utilize any CU-Plane configurations you make.

C/U-Plane Builder Configuration This button allows you to manually tune and adapt CU-Plane 
parameters used in the creation of a “stimulus” CU-Plane “.pcap” file. 
For details, see Configuration Tool on page 70.
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 2.2.4: Functional tabs

The U5040A Open RAN Studio consists of three tabs where you can 
perform various functions:

• C-Plane Builder - For detailed information, see C/U-Plane Builder on 
page 100.

• Explorer - For detailed information, see Explorer on page 106.

• Interface Monitor - For detailed information, see Interface Monitor on 
page 114.

Instrument Configuration This button only shows up when connected to BittWare Hardware. This 
opens a dialog used for configuring the BittWare Hardware related 
features. For details, see Instrument Configuration on page 91.

Load Stimulus This button loads a stimulus PCAP file to the Open RAN O-DU 
Emulator.

Play Stimulus This button is used to remotely control playout of a “stimulus” file on 
the Open RAN O-DU Emulator.

Pause/Restart Stimulus This button is used to remotely pause “stimulus” playout on the Open 
RAN O-DU Emulator.

Single/Continuous Sweep This button is used to remotely control single or continuous “stimulus” 
playout on the Open RAN O-DU Emulator. In single mode the stimulus 
file is played “once” per press of the Play Stimulus button.

Record O-RAN Stimulus/Response 
between O-DU and O-RU

This button remotely initiates recording on the Open RAN O-DU 
Emulator of traffic between the O-DU Emulator and the O-RU DUT. 
Note that this feature interleaves downlink and uplink traffic into a 
single “.pcap” recording.

Record Length (in units of Radio 
Frames)

This button remotely controls the maximum number of RF frames 
recorded by the O-DU Emulator. You can chose a number of frames 
from the pull down menu or enter a value like “10” RF frames.

Elements Name Function
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 2.2.5: Status Bar

The status bar is located at the bottom of the O-RAN user interface, as 
shown in Figure 59:

Figure 59 Appearance of the Status bar

It displays the following information:

• File - Displays captured file name

• Size - Displays captured file size

File and Size are context sensitive depending on which tab is selected:

• C/U-Plane Builder – displays the currently loaded PathWave Signal 
Generator/Signal Studio (.scp) file.

• Explorer – displays the currently loaded stimulus/capture (.pcap) 
file.

• Interface Monitor – displays the currently loaded stimulus file used 
for playback.

• Port Status - Displays the actual port speed, which is color coded 
depending on the link status.

Table 4 Speed displayed in the Port Status field

Speed Description

10G Indicates that the port is running at 10Gbps

25G Indicates that the port is running at 25Gbps

Disabled Indicates that the port is disabled

LOOP Indicates that the port is in Loopback mode
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Table 5 Color coding displayed in the Port Status field

• PTP - Displays the current status of PTP synchronization and is color 
coded depending on the current state.

Table 6 Possible PTP states and color codes

• SyncE - Displays the PTP configuration mode

Color Code Description

Green Indicates that the link is ‘up’ on the port

Red Indicates that the link is ‘down’ on the port

Grey Indicates that the port is disabled

PTP Mode PTP Status Color Code Description

Master Master Green Indicates that PTP is in ‘Master’ mode

Note: This status does not give any indication 
if there is a synchronized PTP slave or not.

Slave

Slave Red Indicates that PTP is attempting to 
synchronize with a Master, but the time offset 
is greater than 0.1 seconds

Slave Yellow Indicates that PTP is synchronizing with a 
Master and the offset is between 100 
nanoseconds and 0.1 seconds

Slave Green Indicates that PTP is synchronized with a 
Master and the offset is less than 100 
nanoseconds

Listen Red Indicates that PTP is in Slave mode, but has 
not detected a suitable Master to synchronize 
with

Disabled Disabled Grey Indicates that PTP is disabled
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Table 7 SyncE modes and color codes

SyncE mode Color Code Description

Master Green Indicates that PTP is configured for ‘Master’ mode

Disabled Grey Indicates that PTP is either disabled or configured for 
‘Slave’ mode
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 2.2.6: Dockable Planes

The functional planes under each of the three tabs can now be moved or 
resized.

To move a plane from its default position, do one of the following:

• Click the white band (on top) of the plane you wish to move. Notice that 
the band turns blue. Hold down and drag the cursor to any of the 
positions that appear as you move the plane around.

Figure 60 Drag positions for dockable planes

• Alternatively, right-click the white / blue band (on top) or click the 
“Options” menu (as highlighted in Figure 61) of the plane you wish to 
move. Click “Float” to displace the selected plane.
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Figure 61 Options menu for dockable planes

To resize a plane that is “floating”:

• Use the two-headed arrows that appear at the edges of the “floating 
plane to resize it to a custom size.

• Double-click the blue band or click the “Maximize” button to expand 
the “floating” plane to the maximum display size.

To dock a “floating” plane:

• Right-click the white / blue band (on top) or click the “Options” menu 
(as highlighted earlier) of the plane you wish to dock. Click “Dock” to 
reposition the selected plane.

Figure 62 Docking and Maximizing options for dockable planes
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Section 2.3: Configuration Tool

The Configuration Tool is used to configure hardware as well as C/U-Plane 
specific parameters. The changes made through this tool are stored in a 
“persistence” meta data file (.orstx file) and recalled when you reload the 
same “.SCP” file.

NOTE
For any changes made to the “Configuration Tool” to take effect in the 
stimulus player, you must perform the following steps:

1. (Re)generate the stimulus file. From the main menu, click File > Export 
> Generate Stimulus File.

2. (Re)load the stimulus into the player. From the main menu, click File > 
Recall > Stimulus (Load Into Player)....
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Figure 63 shows an example of Configuration Tool:

Figure 63 Default view of the ORAN Interface Configuration Tool

It provides the following tabs:

• Flow/eAxC ID

• Compression

• C/U-Plane Coupling

• Numerology

• Beamforming

• Timing

• Options
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Each tab allows you to perform some settings which is explained in the 
sections that follow. 

 2.3.1: Flow/eAxC ID

Figure 64 shows settings provided by the “Flow/eAxC ID” tab:

Figure 64 Flow/eAxC options in the ORAN Interface Configuration Tool

For details of the settings, refer to the “Flow Summary” provided in this 
tab. 

The “Flow/eAxC ID” tab can be used to:

• Set a pattern for eAxC ID bit map to DU, BS, CC and RU field sizes 
(total size 16-bits).

• Use the default mapping of 4-bits each or add/remove new bitwidth 
patterns.

• Presently, the DU, BS, CC and RU fields cannot be edited separately, 
only the eAxC ID value (hex) can be edited (and thereby indirectly 
editing the DU, BS, CC and RU fields). 
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• The eAxC ID values are set individually for downlink and uplink flows.

• The configured flow parameters will be stored in setup file and thus 
may “persist” between Open RAN studio invocations.

• In the “C-Plane Builder”, assign a Flow/eAxC ID to each “Carrier”.

 2.3.2: Compression

Figure 65 shows settings provided by the “Compression” tab:

Figure 65 Compression options in the ORAN Interface Configuration Tool

For details of the settings, refer to the “Compression Summary” provided 
in this tab.

The “Compression” tab can be used to:

• Select compression strategy and method to be applied to downlink and 
uplink U-Plane PRBs on a per eAxC ID basis.

• Select between “static” or “dynamic” configuration. Under static mode, 
udCompHdr(s) are not used in U-Plane packet per PRB.

• The compression methods available are:

• no compression 
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• block floating point - Changes the IQ samples for each PRB into 
floating point format, where the data appear as a compressed bit 
sign, a mantissa and a shared exponent. 

• block scaling - Similar to block floating point, except that data is 
shown by post-scaled values and a multiplicative scale value, which 
are shared within a block.

• µ-law - Shifts a bit (for dynamic range) followed by combining with 
a nonlinear sub-function approximation, where for implementation 
efficiency, μ=8 and the sign & mantissa are 1 and 2-bits respectively.

• modulation compression (available for Downlink U-Plane messages 
only) - Uses limited number of I and Q bits to represent modulated 
data symbols.

For more information about these compression methods, refer to 
Annex A Compression Methods in the O-RAN specification.

• Full range of IQ bit widths is supported.

• A compression setting can be applied to all eAxC’s (DL or UL) by 
selecting the “Apply to All DL Flows” and “Apply to All UL Flows” 
buttons.
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 2.3.3: Numerology

Figure 66 shows settings provided by the “Numerology” tab:

Figure 66 Numerology tab of the Configuration tool

For details of the settings, refer to the “Numerology Summary” provided in 
this tab.
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The “Numerology” tab can be used to:

• Create carriers with slot numbering schemes that reflect section “5.3.2 
Mixed Numerology and PRACH Handling” in the ORAN CUS-Plane 
specification. Use the tick box to enable this feature when creating a 
signal or when recovering a carrier from a recording.

• Configure the bandwidth (drop-down options) and enable the carrier’s 
grid (Resource Grid), when recovering an IQ carrier from a recording, so 
that Open RAN Studio reassembles U-Plane data correctly.

• Configure Open RAN Studio to recover PRACH IQ carrier by identifying 
such PCAP files, which have not been generated using Open RAN 
Studio. Make sure that the PRACH Format, SCS and Freq. Offset values 
match with those that appear in the C-Plane PRACH message.

• Recover IQ data from the LTE signal, where you may additionally 
choose the option to include the null DC subcarrier during IQ recovery 
from the PCAP/ORSTX files for LTE signals only.
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 2.3.4: Beamforming

Figure 67 shows settings provided by the “Beamforming” tab:

Figure 67 Beamforming tab of the Configuration tool

For details of the settings, refer to the “Beamforming Summary” provided 
in this tab.

The “Beamforming” tab can be used to:

• Select a beamforming strategy. Available beamforming strategies are:

• no beamforming: (default) indicates that no beamforming has been 
applied.

• predefined-beam beamforming: an index to indicate a specific beam 
to use

• weight-based dynamic beamforming: an index to indicate the 
weight vector for a beam (with a specific Table Index value) along 
with compression technique

• attribute-based dynamic beamforming: an index to indicate a 
specific beam to use, along with specific attributes (described in 
Chapter 5.4.7.2 of the O-RAN specification).

• channel-information-based beamforming: an index based on 
channel information, for a specific ueID (instead of beamID)



78 Keysight U5040A Open RAN Studio User Guide

2 Understanding the O-RAN Studio User Interface
 

• flexible weight-based dynamic beamforming: an index to indicate 
the weight vector for a beam (with a specific beamID value) along 
with compression technique

• For the selected method, provide beam IDs, weights, attributes to be 
used with subsequent signals. See Setting Beam IDs / Ue IDs for Radio 
Allocations on page 303 to understand how to correctly configure 
Beam / Ue IDs.

• If ‘channel-information-based beamforming’ is the selected method, 
you must include a file containing the beam channel information. See 
Applying Channel-information-based beamforming on page 341 for 
more details.

• Configure flow parameters, which will be stored in setup file and thus 
may “persist” between Open RAN studio invocations. 

• Once these tables are set up, creating a new stimulus signal with a 
different strategy is simplified

• Use the radio buttons to activate strategy before creating the 
stimulus signal

• Ensure correct “Beam IDs” / “ueIds” are assigned to relevant 
sections in “C-Plane Builder”

For more information about the beamforming methods and the associated 
properties, refer to Beamforming Guidelines in the O-RAN specification.

NOTE
Beamforming in SRS Channel is supported in version 1.3 (and higher) of 
the U5040A Open RAN Studio software.
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 2.3.5: Timing

Figure 68 shows settings provided by the “Timing” tab:

Figure 68 Timing tab of the Configuration tool

For details of the settings, refer to the “Timing Summary” provided in this 
tab.

The “Timing” tab can be used to:

• Configure a fixed time displacement (relative to frame boundary) for all 
message times (Stimulus Alignment).

• Configure the method to define the boundaries (symbol / slot) from 
where to consider the timings for C-Plane (and U-Plane) messages on 
both DL & UL data. See example for Viewing C/U-Plane Timing 
Alignment in Explorer on page 82 to understand the difference in timing 
alignment based on this setting.

• For DL data, configure timing (as advance) for C-Plane messages and 
U-Plane messages. To understand timing relations per symbol IQ in DL, 
refer to Figure B-2 in Annex B Delay Management Use Cases in the 
ORAN specification. 
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• For UL data, configure the advance time for C-Plane messages and 
delay for U-Plane messages. To understand timing relations per symbol 
IQ in UL, refer to Figure B-3 in Annex B Delay Management Use Cases 
in the O-RAN specification.

• The O-RAN Studio GUI provides several parameters for configuring 
stimulus timing of radio frames used when generating the stimulus file, 
which are:

• The “Delay relative to frame boundary” parameter specifies how 
many of every total radio frame (holding the inter frame distribution 
of C-Plane and U-Plane messages dependent on “Tcp_adv_dl” 
parameter) is advanced (- value) or delayed (+ value) with respect to 
radio frame boundaries.

• Determine “Data message timing method” as either ‘symbol 
boundaries’ or ‘slot boundaries’. A radio frame always has the 
duration of 10 ms and consists of several slots (10, 20, 40) 
depending on numerology. A slot always consists of 14 symbols. 
ORS radio frames are played out relative to radio frame boundaries. 
C-Plane messages are always played out relative to slot boundaries. 
ORS U-Plane messages are played out relative to either slot 
boundaries or symbol boundaries.

• The “Tcp_adv_dl” parameter in the Downlink Timing is used to 
define inter radio frame distribution of C-plane and U-plane 
messages. The “Tcp_adv_dl” value specifies how many nanoseconds 
in advance to symbol boundaries the C-Plane messages starts to 
playout. 

Note that “C-Plane Time Advance (Tcp_adv_dl)” is a ‘read-only’ field 
and is calculated automatically as the difference of C-Plane and 
U-Plane Time Advance:

Tcp_adv_dl = T1a_cp_dl - T1a_up_dl

The block diagram depiction of the timing of C-Plane messages and 
U-Plane messages in a DL carrier is shown in Figure 69.
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Figure 69 Timings for C-Plane and U-Plane messages (DL)

• The block diagram depiction of the timing of C-Plane messages and 
U-Plane messages in a UL carrier is shown in Figure 70.

Figure 70 Timings for C-Plane and U-Plane messages (UL)

Note that by default, the Uplink carrier does not contain U-Plane 
messages. The “UL U-Plane Time Delay” is determined after you enable 
the “Create Uplink U-Plane” option in the “Options” tab of the “C/U Plane 
Builder Configuration Tool”. For more information on how to generate 
U-Plane data on Uplink carrier, see Creating U-Plane messages in Uplink 
Carrier on page 170.
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Viewing C/U-Plane Timing Alignment in Explorer

This section shows an example of how the C-Plane (and U-Plane) timing 
depends on the “C-Plane Timing Alignment” setting in the Timing tab of 
the C/U Plane Builder Configuration Tool. The SCP file used for this 
example has a section in slot 0 that starts on symbol 1.

1 Open the SCP file in O-RAN Studio.

2 Assign the “Flow/eXAC ID”.

Figure 71 SCP file with a section in slot 0 starting on symbol 1

By default, the “C-Plane Timing Alignment” setting is configured to 
‘symbol boundaries’.

3 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file. See Exporting O-RAN Stimulus File on page 122 for more 
information.
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4 Load the updated stimulus / recording PCAP file into O-RAN Studio.

The C-Plane symbol boundary alignment is displayed in Figure 72.

Figure 72 PCAP file showing C-Plane symbol boundary timing alignment

5 Launch the “C/U-Plane Builder Configuration Tool” window in the 
Open RAN Studio software.

6 Click the “Timing” tab.

7 Select ‘slot boundaries’ from the C-Plane Timing Alignment drop-down 
options.
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Figure 73 Changing C-Plane Timing Alignment setting

8 Exit the “C/U-Plane Builder Configuration Tool” window.

9 Export the O-RAN Stimulus file again for the configuration changes to 
take effect. See Exporting O-RAN Stimulus File on page 122 for more 
information.

10 Load the updated stimulus / recording PCAP file into O-RAN Studio.

The C-Plane slot boundary alignment is displayed in Figure 74.
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Figure 74 PCAP file showing C-Plane slot boundary timing alignment

For more information about the timing methods and the associated 
properties, refer to Annex B Delay Management Use Cases in the O-RAN 
specification. 
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 2.3.6: Options

The following figure shows settings provided by the “Options” tab:

Figure 75 Options tab in the Configuration tool

For details of the settings, refer to the “Options Summary” provided in this 
tab.

The “Options” tab can be used to:

• Set CU-Plane packet MTU size. This automatically invokes Application 
Layer Fragmentation (ALF), if required.
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• Enable or disable the addition of VLAN Tags in CU-Plane packets.

• Specify the VLAN ID that will be used in the generated stimulus.

• Set eCPRI sequence numbers to “0” in stimulus file.

• Currently, sequence numbers wrap per 10ms frame and hence 
possibly before reaching “255”.

• reMask defines the Resource Element (RE) mask within a PRB. Each bit 
setting in the reMask indicates if the section control is applicable to the 
RE sent in U-Plane messages (0=not applicable; 1=applicable). MSB 
indicates the value for the RE of the lowest frequency in a PRB. Table 8 
gives you an overview of the reMask feature for each carrier.

Table 8 reMask overview per carrier

• symInc indicates the symbol number that is relevant to the given 
sectionId. It is expected that for each C-Plane message a symbol 
number is maintained and starts with the value of startSymbolid. The 
same value is used for each section in the message as long as symInc is 
zero.

• RB Indicator indicates if every RB is used or every other RB is used. The 
starting RB is defined by startPrbc and total number of used RBs is 
defined by numPrbc.

Carrier Format Behavior when “Use reMask” is enabled

Uplink

UCI Divided into payload and DM-RS.

PUSCH Sections are split according to the positions of DM-RS and 
PT-RS. The reMask field is populated accordingly. Message 
bundling occurs, if “Use symInc” is also enabled.

SRS The reMask covers the reference signal.

PRACH - Not applicable.

Downlink

SS/PBCH Divides the SS-block into PSS, SSS, and PBCH parts, but without 
use of reMask.

PDCCH/DCI Divided into payload and DM-RS.

PDSCH Divided into payload, DM-RS, and PT-RS.

CSI-RS The reMask covers the reference signal, even for zero power. 
Separate mask for the case when RE used for PDSCH is false.
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• External Type 6 is a section extension that applies only to Section Types 
1 and 3. This section extension enables allocation of non-contiguous 
sets of PRBs (Resource Block Groups, or RBGs) in frequency and time 
domain. This reduces significantly the C-Plane overhead when users or 
channels are allocated with non-contiguous sets of PRBs in time and 
frequency.

• External Type 10 is a section extension that applies only to Section 
Types 1 and 3. This section extension can be used along with a 
‘representative eAxC ID’ to reduce C-plane overhead of sending 
multiple messages to the overhead of sending one single C-plane 
message.

• Enable “PRACH Type 3 as Type 1 Message” option to change the 
messages from ‘Type 3’ messages to ‘Type 1’ in the Message 
Interpretation area of the C-Plane Section.

• The “Section Type 0 Configurations” allows control of the instance to 
insert such C-Plane packets in the “stimulus” signal.

• Selecting generation of Section Type 0 messages will “grey out” the 
identified area(s) in the “Radio Allocations” grid in “C-Plane Builder”.



Keysight U5040A Open RAN Studio User Guide 89

Understanding the O-RAN Studio User Interface 2

 

• Configure the Digital Power Scaling (IQ data) according to Section 
6.1.3.1 Definition of IQ Power in dBFS in the O-RAN specification.

• FS adjustment (FS_Offset, default 0 is no scaling)—Adjust the FS 
(Full Scale) parameter to match with the FS_Offset parameter in the 
M-Plane. The value ‘0’ indicates that this parameter is not 
supported by the O-RU or not set by the O-DU. This parameter 
always uses a positive value to scale down IQ. The following 
example shows the representation of the constellation along with 
the formula to calculate IQ, when the value ‘2’ is set for scaling 
down IQ.

Figure 76 Scaling down IQ using FS adjustment

• Additional IQ Power Scaling—This parameter always uses a negative 
value to scale down IQ. The following example shows the 
representation of the constellation along with the formula to 
calculate IQ, when the value ‘-6’ is set for scaling down IQ. The 
lower the value for the IQ Power Scaling, the smaller is the 
‘udCompParam’ value in case of block floating point compression.

Figure 77 Scaling down IQ using Additional IQ power scaling

Note that the denominator in the scaling formulas is different for the 
two parameters. Normally, only one of these parameters is used for 
scaling, but not both.
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• Apply fixed 256QAM Scaler—Enabling this option scales down all 
modulations to the same level as the 256QAM scaler. The following 
example shows the representation of mixed constellations, with 
256QAM being the highest.

Figure 78 Applying fixed 256QAM scaling

Refer to Appendix I: IQ Scaling Flow in this document for additional details 
about IQ scaling flow.

 2.3.7: DSS

This configuration tab lets you combine 5G NR and LTE carriers, such that 
the configurations of the LTE carrier matches the LTE coexistence settings 
of the 5G NR carrier it is combined with.

The functionality of this tab is explained in the subsection Configuring DSS 
in Open RAN Studio software in the section Configuring LTE Coexistence - 
DSS on page 203.



Keysight U5040A Open RAN Studio User Guide 91

Understanding the O-RAN Studio User Interface 2

 

Section 2.4: Instrument Configuration

The Instrument Configuration is used to configure hardware settings. 
These settings are stored in a global file in the ‘Documents’ folder called 
“xRAN_StudioModuleConfig.xml”. This is automatically saved and the 
settings are restored when you start the application. 

The Open RAN Studio Player software and Integrated Hardware Appliance 
will playback Open RAN Studio Builder generated stimulus files to an 
O-RU Radio Unit over an Ethernet based O-RAN interface. The Open RAN 
Studio Player emulates and is seen by the DUT (O-RU) as an O-DU. The 
Keysight Open RAN Studio Player application is provided for use on the 
Integrated Hardware Appliance.

The Player/Recorder Tool window can be opened by clicking on the 
Player/Recorder Tool button available on the toolbar. 

This toolbar button is only visible when running the O-RAN Studio with the 
BittWare FPGA card (U5040A Open RAN Studio online mode).

Once, you click this toolbar, the Player/Recorder Tool window appears as 
shown in Figure 79:
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Figure 79 Ports tab in the Instrument Configuration

This window has the following tabs:

• Ports

• Time Sync

• Stimulus

• Trigger Out

These tabs are described in the sections that follow. 
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 2.4.1: Ports Tab

The “Ports” tab allows you to configure port settings.

Figure 80 Ports tab of the Instrument Configuration

The “Ports” tab provides the following settings:

• Port Assignments

• The Stimulus / Capture / PTP Port is QSFP slot 0, port 1. This is not 
configurable.

• Port Settings

• QSFP – this is the QSFP slot number of the port. Note that the 
M-Plane is configured on QSFP Slot 2.

• Port – this is the port within the QSFP.

• Speed – this is a drop-down that can be used to select the port 
speed:

• Disabled – the port is disabled and will not transmit or receive 
data.

• 10G - Speed is 10 Gbps. Note that there is no option for FEC in 
the 10G Ethernet standard.
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• 25G No FEC - Speed is equivalent to the “25G” setting in 
version 1.0 of the Open RAN Studio software. No FEC indicates 
that Forward Error Correction (FEC) is disabled.

• 25G RS-FEC - Speed is 25Gbps with Reed-Solomon Forward 
Error Correction (FEC) enabled. Note that KR-FEC is another 
FEC mode, which is not supported.

• Loopback - Sets the interface to do an internal loopback with a 
link speed of 25 Gbps. This setting is normally only used for 
demonstrations.

• 1G (M-Plane) - Speed of the 1 Gbps copper connection on the 
M-Plane Passthrough Port 

• Ethernet Address – this is a drop down that allows you to configure the 
Ethernet MAC Address of the port. All Stimulus and PTP played through 
the port will use this as the Ethernet source address set to this value. 
The O-RU (Destination) Ethernet Address is configured under the 
“Stimulus” tab. For M-Plane, the default Ethernet Address is 
configured.
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 2.4.2: Time Sync Tab

The “Time Sync” tab is used to configure time synchronization settings.

Figure 81 Time Sync tab of the Instrument Configuration

The “Time Sync” tab provides the following settings:

• Clock Settings - The Reference Clock setting determines the clock 
frequency source for the system including PTP. 

• Internal (default) - This setting uses the internal oscillator on the 
BittWare FPGA card for its clock.

• External 10 Mhz - This mode is used when connecting to an external 
10 MHz reference clock on the “Ref Clock In” Port (refer to BittWare 
Hardware on page 18). Note that when you use a 10 MHz external 
reference clock, make sure that the input clock waveform is a square 
wave with 50% duty cycle.
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• External 100 Mhz - This mode is used when connecting to an 
external 100 MHz reference clock on the “Ref Clock In” Port (refer to 
BittWare Hardware on page 18). Note that when you use a 100 MHz 
reference clock, it can be a square wave or a sine wave.

• PTP - uses the G.8275.1 profile

• Mode: 

• Master

• Slave (default) - For the “Slave” mode, the Open RAN Studio 
software synchronizes in time with a PTP Master. 

• Disabled

• Multicast:

• Forwardable (default): multicast address 01-1B-19-00-00-00, 
which is forwarded through switches

• Not Forwardable: multicast address 01-80-C2-00-00-0E, 
which is not forwarded through switches. Addresses in the 
range of 01-80-C2-00-00-00 to 01-80-C2-00-00-0F are not 
relayed by Ethernet switches conforming to IEEE 802.1D.

• Domain: 24

• The G.8275.1 profile allows values in the range of 24 to 43.

• This value must match what the radio is configured for or else 
the radio will ignore this value as a PTP source.

• Priority2: 128

• Priority2 is used in determining the Best Master Clock. Lower 
values for this field give a higher priority.

• UTC Offset:

• Specifies the offset between PTP time and UTC time. PTP time 
does not include leap seconds, whereas UTC time does.

• System Frame Number (SFN) - assigns radio frame numbers based on 
PTP time and is implemented according to Section 9.7.2 of the O-RAN 
specification. The eCPRI Frame Number is computed based on the 
current PTP time. In the previous versions of the software, it always 
started at ‘0’ and incremented for each frame transmitted.

• Beta: This parameter can be used to adjust the eCPRI Frame 
number forward or backwards.
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 2.4.3: Stimulus Tab

The “Stimulus” tab configures settings related to stimulus played at the 
Ethernet port in the Integrated Hardware Appliance. These settings 
determine the timing of stimulus as well as the O-RU address to which the 
stimulus will be sent.

Figure 82 Stimulus tab of the Instrument Configuration

The “Stimulus” tab provides the following settings:

• Ethernet Address - The O-RU Ethernet Address configures the address 
of the O-RU (radio).

NOTE
If Ethernet Address does not match with that on the O-RU, the latter 
discards all C/U-Plane packets.
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 2.4.4: Trigger Out Tab

The “Trigger Out” tab configures settings used to generate external Trigger 
out signals from the BittWare FPGA card.

Figure 83 Trigger Out tab of the Instrument Configuration

When Trigger Out is enabled, it will generate a trigger based on one of the 
following modes:
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• Pulse Per Second  – pulses once per second.

• Pulse Per Radio Frame (10ms)  – pulses every 10ms radio frame 
interval.

• Trigger on Start Stimulus  - pulses when the stimulus starts.

• Trigger on Start Stimulus, repeat every 10 ms  - pulses when the 
stimulus starts and repeats every 10ms until stimulus stops.

• Trigger on Start Capture  – pulses when capture starts.

• Trigger on Start Capture, repeat every 10ms  – pulses when capture 
starts and repeats every 10ms until capture stops.

The other features in this tab are:

• Delay - delays the trigger by the specified period in nanoseconds (must 
be positive).

• Pulse Duration - defines the duration of the trigger / pulse in 
microseconds. Note that in Pulse Per 10ms modes, the pulse duration 
cannot be more than 9500 microseconds.

NOTE
When PTP is enabled, PPS is aligned to 1 second PTP time and  triggers 
are aligned to 10ms radio frame boundaries based on PTP time. 
Otherwise, PPS and triggers are aligned to the Internal Reference Clock.
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Section 2.5: C/U-Plane Builder

Keysight Open RAN Studio Builder lets you quickly, easily, and reliably 
generate O-RAN test vectors compliant with the O-RAN specification. The 
generated test vectors represent Ethernet based O-RAN messages from a 
distributed unit to the device being tested – the O-RU (Radio Unit).

Open RAN Studio Builder is integrated with PathWave Signal Generation 
Desktop 2022 to create 3GPP NR standard-compliant signals and 
construct the corresponding Ethernet based O-RAN protocol test vectors, 
including complete and consistent C-plane and U-plane messages, ready 
for playout.

Downlink test vectors include both O-RAN C-plane and U-plane 
messages. C-plane messages are constructed to fully represent the 
allocations defined in the 5G NR signal definition, and the U-plane 
messages include frequency domain IQ for each resource block.

Uplink test vectors include only C-plane messages, as U-plane messages 
will be generated by the DUT. To ensure consistency, the C-plane 
messages match with the uplink test signal generated by Keysight signal 
sources.

The RF designs are generally created in PathWave Signal Generation 
Desktop / Signal Studio and the resulting file has the (.scp) extension, by 
default. 

For further details on its application and key features, refer to the product 
datasheet available on www.keysight.com.

The “C-Plane Builder” tab enables you to select the appropriate (.scp) file 
from the system.

NOTE
For any changes made to the “Configuration Tool” to take effect in the 
stimulus player, you must perform the following steps:

1. (Re)generate the stimulus file. From the main menu, click File > Export 
> Generate Stimulus File.

2. (Re)load the stimulus into the player. From the main menu, click File > 
Recall > Stimulus (Load Into Player)....
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To do so, follow the steps below:

1 With the “C-Plane Builder” tab selected, click the Open  icon. 

2 On the “Open” dialog that appears, select the appropriate (.scp) file, 
and then click Open.

The “C-Plane Builder” tab displays the information stored in the selected 
(.scp) file.

Figure 84 C/U Plane Builder displaying SCP file contents

The “C-Plane Builder” tab provides the following options:

1 Component Carriers

2 Resource Allocations

3 Radio Allocations

4 Radio Control Plane Data
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 2.5.1: Component Carriers (CC)

This pane displays the CCs and the relevant numerology set up in the RF 
design stage with PathWave Signal Generator/Signal Studio. At this point, 
by selecting a CC, you may assign an “eAxC ID” to each CC. The eAxC IDs 
for Uplink and Downlink carriers can be configured separately in the 
“Flow/eAxC” tab of the “C/U Plane Builder Configuration Tool”.

Figure 85 Component Carriers in the C/U Plane Builder

When the Flow/eAxC ID is not assigned to one or more carriers, the 
O-RAN Studio software returns the following error when you export the 
stimulus file:

Figure 86 Error when one or more carriers are not assigned eAxC ID
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 2.5.2: Resource Allocations

This pane enables you to select an allocation per channel level using the 
Resource Allocation drop-down list. Based on the channel allocation 
selected, the resource allocations per user, designed with PathWave 
Signal Generator/Signal Studio, are summarized. The details of the 
attributes listed depends on the channel allocation. There should be a 
1-to-1 mapping of allocation to blocks drawn in the “Radio Allocation” grid 
view.

Figure 87 Resource Allocations in the C/U Plane Builder

The “Select BeamId” drop-down box lets you select the Beam table index 
per channel allocation. The values here depend on the values set for 
“Beam IDs” for each ‘Table Index’ in the ‘Beamforming Mappings’ area of 
the’ Beamforming’ tab in the ‘C/U Plane Builder Configuration Tool’. The 
value is zero for ‘no beamforming’. For the ‘channel-information-based 
beamforming’ method, the GUI displays “Select UeId” instead of “BeamId”. 
See Applying Channel-information-based beamforming on page 341 for 
more information about “UeIDs”.
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 2.5.3: Radio Allocations

This pane displays the allocations designed using PathWave Signal 
Generation Desktop 2022 interface.

Figure 88 Radio Allocations in the C Plane Builder

Figure 88 highlights the “Frame Index” element, which enables switching 
between frame allocations using the index values. This feature works in the 
same manner as the ‘FrameInd’ feature in the PathWave Signal Generation 
Desktop 2022 interface.
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 2.5.4: Radio Control Plane Data

This pane displays the first logical break down into CU-Plane sections per 
slot. The section IDs are only unique per “slot” and are auto generated. 
This data is utilized to construct C-Plane messages per slot and to drive 
the application level fragmentation of PRBs into U-Plane packets.

Figure 89 Radio Control Plane Data in the C/U Plane Builder
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Section 2.6: Explorer

Radio Units combine O-RAN protocol operation with RF transmit and 
receive performance, creating new test challenges. Analysis and validation 
of O-RU performance requires cross-domain measurements in both RF 
and Protocol domains.

With the optional Open RAN Studio IQ extractor, Open RAN Studio 
Explorer helps you visualize and fully decode the captured trace and 
enables IQ centric extraction, which enables RF centric measurements and 
vector analysis using Keysight 89600 Vector Signal Analyzer (VSA).

Figure 90 Default view of the Explorer tab when PCAP file is loaded
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 2.6.1: Loading a PCAP File

1 With the “Explorer” tab selected, click the Open  button. 

2 On the “Open” dialog that appears, select the appropriate “.pcap” file, 
and click Open.

Figure 91 Open dialog for selecting pcap file

3 The “Explorer” tab displays the information stored in the selected 
“.pcap” file.
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Figure 92 Explorer tab view after a U-Plane/C-Plane message is selected

The “Explorer” tab displays the following sections:

1 U-Plane, C-Plane Messages

2 Message Interpretation

3 Hex Payload

4 Detected Flows

5 PRB View
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 2.6.2: U-Plane, C-Plane Messages

The U-Plane, C-Plane Messages pane displays a list of recovered packets 
from the “.pcap” file. It provides a quick and optimal description of the 
packet contents (frame, subframe, slot, symbol and PRB allocations).

 2.6.3: Message Interpretation

On selecting a message from the list in U-Plane, C-Plane Messages, the 
packet is fully decoded into a structure that has a “tree” like view.

This displays the interpreted contents of each header and payload that 
make up the packet.

 2.6.4: Hex Payload

When you select a message from the U-Plane, C-Plane Messages list, its 
full “hex payload” is displayed. 

Selecting a particular header or body part from the tree view highlights the 
“cells” with the exact hex data that makes up that field.

 2.6.5: PRB View

The PRB View window enables you to ensure that the compression method 
and IQ bit-width reflects the settings used when creating the “stimulus” 
file (Configuration Tool settings). If it is a “recording” and you don’t know 
what these values are, look at a C-Plane message Type 1 and in particular 
at the “User Data Compression Header” in the Message Interpretation tree 
view.

Adjust these parameters accordingly in Configuration Tool and “reload” 
the file for correct decoding or “select” a new message to trigger 
re-loading with new parameters.

NOTE
The timestamp accuracy for captured packets is currently about 80 ns. 
As a result, small consecutive packets may occasionally carry the same 
timestamp.
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Recovered frequency domain IQ

Selecting a PRB in the Message Interpretation tree view will not only 
highlight the “hex data” that makes it up but will also show the 12 RE’s 
values recovered:

• Decompressed format (uCmpI and uCmpQ)

• Mapping to standard constellation (I and Q)

This data is visible in the “Recovered IQ” tab. The “Constellation” tab 
shows a mapping of these 12 REs on a constellation chart.

Figure 93 Recovered RE values of the selected PRB view
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 2.6.6: Detected Flows

The “Detected Flows” view shows the “auto detected” flow of data by the 
“Explorer”. 

Figure 94 Detected Flows displaying ‘auto-detected’ data flow

These flows are distinguished through:

• ecpriPcid in U-Plane packets

• ecpriRtcid in C-Plane packets

In both cases, this 16-bit integer represents the ORAN eAxC ID. Due to 
required signaling in the downlink for uplink data, depending on the 
analyzed recording, there may be more eAxC IDs in the C-Plane than in the 
U-Plane.

NOTE
The U-Plane and C-Plane flows match if both the eAxC ID and Direction 
match.
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Note that the number of flows in the downlink, uplink (and if available, 
PRACH) carriers may be different, but the assigned eAxC ID can be the 
same. Figure 95 shows such an instance, where different carriers have the 
same eAxC ID.

Figure 95 Same eAxC ID for DL, UL and PRACH
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When U-Plane flow is added to the Uplink carrier, the Numerology (µ) 
displays a (?), as shown in Figure 96.

Figure 96 ? value for µ in U-Plane flow

In such cases, it is recommended to manually assign/verify the correct 
Numerology from the ‘Resource Grid’ of the ‘Numerology’ tab in the ‘C/U 
Plane Builder Configuration Tool’.

Figure 97 Manually assigning correct Numerology
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Section 2.7: Interface Monitor

The “Interface Monitor” tab displays the counters and port status of the 
hardware settings. This tab is only available when running with the 
BittWare FPGA card (U5040A Open RAN Studio online mode).

Figure 98 Interface Monitor tab in the online O-RAN Studio

The “Interface Monitor” tab displays the following sections:

1 Counters and KPIs

2 Port Status

3 PTP Status
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 2.7.1: Counters and KPIs

The “Counter” fields in this segment are:

• Rx Bytes - Received Bytes

• Rx Packets - Received Packets

• Rx Packets Bad FCS - Received Packets with bad FCS (Frame Check 
Sequence)

• Tx Bytes - Transmitted Bytes

• Tx Packets - Transmitted Packets

• Tx Packets Bad FCS - Transmitted Packets with bad FCS (Frame Check 
Sequence)

• Duration (msec) - the duration in milliseconds of the statistics sample

 2.7.2: Port Status

The fields in this segment for each port are:

• Port - the port number

• Link - current status (Up / Down) of the Link

• Configuration - current configured speed for the port (10G, 25G, and so 
on)

• Link Speed - the actual link speed

• FEC - the values that appear are:

• N/A - not applicable (only applies for 25G)

• None - no Forward Error Correction

• RS - Reed Solomon Forward Error Correction

• Tx Packets - number of packets transmitted in the last one second

• Rx Packets - number of packets received in the last one second

• CRC Errors - number of packets received with CRC Errors / Bad FCS 
(Frame Check Sequence)

 2.7.3: PTP Status

Shows the status of PTP Master / Slave. The fields in this segment are:

• PTP Status - shows the current status of the PTP (the values that are 
displayed here are the same as those described for “PTP Status” in 
Functional tabs on page 64). If PTP Status displays “Slave” mode, the 
following fields are also displayed:

• Clock Offset - the current computed offset of the PTP Slave Clock 
relative to the PTP Master Clock
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• Clock StdDev - the standard deviation of the offset between the PTP 
Slave Clock and the PTP Master Clock

• Clock Variance - the variance of the offset between the PTP Slave 
Clock and the PTP Master Clock



Keysight U5040A Open RAN Studio User Guide 117

Understanding the O-RAN Studio User Interface 2

 

Section 2.8: Overview on M-Plane in O-RAN Studio

This section describes only an overview on the M-Plane and M-Plane 
Pass-through implementation in the U5040A Open RAN Studio software. 
Detailed information will be provided in Implementing M-Plane & M-Plane 
Passthrough in ORAN Studio Solution (v1.1) Reference Guide.

The M-Plane Toolkit (including M-Plane software and FPGA Pass-through) 
is installed along with version 1.2 of the U5040A Open RAN Studio 
Software. The M-Plane Pass-through performs packet forwarding similar 
to the Ethernet switch, based on MAC address. Only packets between the 
BittWare FPGA and O-RU are recorded.

The M-Plane is capable of functioning as a DHCP server for IP address 
assignment and includes various M-Plane specific parameters to send 
Option 43: Vendor Specific Information: encoded IP address of the 
NETCONF controller and to receive/parse Option 60: Vendor Class 
Identifier.

The NETCONF controller comprises of an XML script that allows custom 
sequences and can be easily modified.

Figure 99 M-Plane Pass-through connection on BittWare HW with own NIC

Figure 99 shows a 1 Gb connection from M-Plane Pass-through port on 
FPGA to secondary Ethernet NIC on BittWare server, which is depicted in 
the second block diagram below. Following block diagrams represent the 
physical connections for M-Plane and M-Plane Pass-through.
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1 Connection from any PC to an O-RU using M-Plane only

This block diagram depicts a system where the Network Interface 
Controller (NIC) port on the BittWare server is connected directly to the 
O-RU port via 1 Gbps Copper M-Plane connection to send configuration 
messages only.

Figure 100 M-Plane connection between PC and O-RU

Because of the port limitation on the O-RU, an Ethernet Fronthaul Switch 
is required that can receive the M-Plane messages from the NIC port via a 
1Gbps / 10Gbps Copper connection and also the CUS-Plane messages 
from QSFP port 0 of the BittWare Server to send them together to the 
O-RU.

As depicted further, the M-Plane Pass-through helps you in sending 
M-Plane and CUS-Plane messages together without the need of the 
Ethernet Fronthaul Switch.
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2 Connection using M-Plane Pass-through on the BittWare hardware 
with BittWare NIC

This block diagram depicts a system where the M-Plane Pass-through port 
has been used. The M-Plane Pass-through port has a 1 Gbps Copper 
connection from the FPGA using QSFP28 to SFP28 adapter + 1G SFP 
Module. You can form a loopback connection from the BittWare NIC port 
as shown in the image below. Here, the O-RU is connected to QSFP port 0 
of the BittWare Server. Both the CUS-Plane and M-Plane messages are 
transmitted over an Ethernet connection at 25G No FEC speed.

Figure 101 M-Plane Pass-through connection on BittWare HW with own NIC
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3 Connection using M-Plane Pass-through with an external M-Plane 
source

This block diagram depicts a system where the M-Plane Pass-through port 
has been used to establish connection with a remote machine hosting the 
M-Plane client. In this case, the NIC port of the remote hardware is 
connected to the BittWare FPGA as shown in the image below. Here, the 
O-RU is connected to QSFP port 0 of the BittWare Server. Both the 
CUS-Plane and M-Plane messages are transmitted over an Ethernet 
connection at 25G No FEC speed.

Figure 102 M-Plane Pass-through connection with external M-Plane source
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Section 3.1: Exporting O-RAN Stimulus File

The Export O-RAN Stimulus File  button uses the following 
information to create a CU-Plane packet “stimulus” in a “.pcap” file format.

• C-Plane configuration parameters inherited from (.scp) file.

• Frequency domain IQ files generated by PathWave Signal 
Generator/Signal Studio.

• The configuration data that you provide via the C/U Plane Builder 
Configuration Tool.

This stimulus represents the 10 ms radio frame designed with PathWave 
Signal Generator/Signal Studio formatted as CU-Plane packets. If 
specified in PathWave Signal Generator/Signal Studio, the “.pcap” file may 
contain several radio frames (but with identical IQ data).

Opening the RAN Studio will step through each carrier and generate 
intermediate IQ data in “.setx” format. The resulting pcap file will have the 
base name from the (.scp) file and extension “.pcap”. Note that for the 
Uplink carrier, the Open RAN Studio software generates two “.pcap” files, 
one for C-Plane messages and the other for U-Plane messages. The name 
for the “.pcap” file containing U-Plane messages is suffixed with ‘_UL’. See 
Creating U-Plane messages in Uplink Carrier on page 170 for more 
information about the two “.pcap” files. The “.pcap” file is viewable with 
Wireshark but the Open RAN Studio software enables you to correctly 
interpret packet payloads.

During export, if empty frames are detected in the SCP file, the O-RAN 
Studio software returns the following warning message:
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Figure 103 Warning when stimulus detects empty frames

You can load the “.pcap” stimulus file onto the Open RAN Studio 
“Explorer” tab. This file also needs to be loaded onto the Open RAN O-DU 
Emulator for playback towards the O-RU DUT via “Load Stimulus” button.



124 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Section 3.2: Data Flow Filtering

Figure 104 shows the features within the Open RAN Studio software that 
enable filtering of data flow:

Figure 104 An example of Data Flow Filtering

1 Filter on Selected Flow—Select a flow and click the “Filter on Selected 
Flow” icon (appears like a funnel). Doing this populates the list view for 
both the C-Plane and U-Plane packets that match the eAxC ID.

2 Recover IQ Waveform — Click the “Recover IQ Waveform” icon 
(appears like a waveform) to extract IQ data. See Data Flow IQ 
Extraction on page 127 for more information about sample IQ data and 
the process to recover IQ data.

3 Clear Filter — Click the “Clear Filter” icon (Red X appearance) to select 
another flow for filtering.

4 Save filtered messages to JSON encoded file — Click the “Save filtered 
messages to JSON encoded file” (appearance of a standard Save 
button) to generate a JSON file that has the same base name from the 
SCP file.

In this example, the data flow shown in Figure 104 belongs to a PCAP 
file named “DL_VSA.pcap”, derived from “DL_VSA.scp”.



Keysight U5040A Open RAN Studio User Guide 125

Configuring Features in the O-RAN Studio UI 3

 

• When you click the save button, a ‘Progress Dialog’ is displayed.

Figure 105 Progress dialog when the Save button is clicked

• Click OK.
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• Navigate to the folder where the SCP file is placed to find the 
corresponding JSON encoded file.

Figure 106 JSON encoded file created by ORAN Studio software
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Section 3.3: Data Flow IQ Extraction

After filtering on a flow, clicking the “Waveform” button ensures that the 
software will attempt to recover the IQ and convert this to time domain IQ. 
If this is performed on a “stimulus” file for which we have “all” the 
necessary meta data in the working directory, no further action is required. 

The time domain IQ data will be saved as a ORB file in the same directory 
with and extension type of “.iqt.orb”; implying IQ in time domain. This ORB 
file will also contain a small header, which conveys the sampling frequency 
so that it can be interpreted by VSA.

If this is performed on a “recording”, it is important that the numerology is 
configured correctly in the “Numerology” tab of the “C/U Plane Builder 
Configuration Tool” to comply with actual numerology in the recorded file.
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 3.3.1: Recovering IQ flow in O-RAN Studio & 89600 VSA

This section describes step-by-step instructions to extract IQ flow and for 
its proper interpretation by the 89600 VSA software. The process for 
recovering IQ for DL and UL carriers is the same, except that recovering IQ 
carrier from UL involves the additional steps of creating Uplink U-Plane 
messages, so that the UL PCAP file can be processed in the same manner 
as the DL PCAP file.

1 Open the SCP file in O-RAN Studio.

2 Assign the “Flow/eXAC ID”.

Downlink

Figure 107 O-RAN Studio view for DL Carrier
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Uplink

Figure 108 O-RAN Studio view for UL Carrier
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3 Launch the “C/U-Plane Builder Configuration Tool” window.

4 Depending on the configuration of the SCP file, ensure that the proper 
configuration options (such as Compression method, IQ Bitwidth, 
Numerology settings, and so on) are selected (or cleared) for the 
respective DL / UL carrier.

Figure 109 Numerology settings for DL and UL Carrier

5 For the UL carrier, ensure that “Create Uplink U-Plane” is checked (see 
Creating U-Plane messages in Uplink Carrier on page 170 for more 
information).
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Figure 110 Creating Uplink U-Plane for UL Carrier

6 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file. See Exporting O-RAN Stimulus File on page 122 for more 
information.

7 Load the updated stimulus / recording PCAP file into O-RAN Studio. 
For the UL carrier, make sure that the PCAP file suffixed ‘_UL’ is loaded.

8 Select a row in the “U-Plane” area and click the “Filter on selected row” 
icon.
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Downlink

Figure 111 Explorer view for DL PCAP

Uplink

Figure 112 Explorer view for UL PCAP

9 Click the icon for “Recover IQ waveform” to proceed with IQ extraction 
in O-RAN Studio software.
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Downlink

Figure 113 Recovering IQ waveform from DL PCAP

Uplink

Figure 114 Recovering IQ waveform from UL PCAP
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10 To view the recovered IQ data and the corresponding Constellation 
diagram for a U-Plane message in O-RAN Studio,

a Highlight a row in the “U-Plane, C-Plane Messages” area that 
contains a U-Plane message.

b In the “Message Interpretation” area, click a PRB slot.

The “Hex Payload” area auto-highlights the corresponding data for the 
selected PRB slot.

The “Recovered IQ” tab shows the corresponding extracted IQ data.

The “Constellation” tab shows the plotted IQ data in constellation 
format.

Downlink

Figure 115 Recovered IQ data per PRB slot for DL Carrier
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Uplink

Figure 116 Recovered IQ data per PRB slot for UL Carrier

11 Notice that the folder location, where the original SCP file is saved, 
now contains additional files, including the SETX and ORB files, which 
are supported by the 89600 VSA software, for IQ analysis.
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Downlink

Figure 117 Files required for IQ recovery in 89600 VSA (DL)

Uplink

Figure 118 Files required for IQ recovery in 89600 VSA (UL)
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12 Launch the 89600 VSA software.

13 From the main menu, click File > Recall > Recall Setup....

14 On the Recall Setup window that appears, navigate to the folder where 
the SETX file, generated along with other stimulus files by the O-RAN 
Studio software, is located.

15 Select the SETX file and click Open.

Downlink

Figure 119 Loading SETX file for DL Carrier in 89600 VSA
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Uplink

Figure 120 Loading SETX file for UL Carrier in 89600 VSA

The setup file contents are plotted in 89600 VSA. However, this data is 
not sufficient for IQ measurements. For the VSA software to measure IQ 
data, you must load the ORB file that was generated by the O-RAN 
Studio software along with the other stimulus files.

Also, note that since we are loading a stimulus file, the amount of data 
is smaller and can be played for a duration of about 10ms, as 
compared to that of a recording. Since that amount of data is not 
sufficient for the 89600 VSA software to perform the required IQ 
measurements, we must configure the frames to appear in a repetitive 
mode.

16 From the main menu, click File > Recall > Recall Recording....
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17 On the Recall Recording window that appears, all stimulus files are 
displayed, which are associated with the SETX file loaded in the 
previous step. Select the ORB file.

18 On the right pane, under “Padding Selection”, select ‘Repetition’.

19 Modify “Factor” field to ‘3’.

20 Click Open.

Downlink

Figure 121 Loading DL ORB file for IQ measurement in 89600 VSA
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Uplink

Figure 122 Loading UL ORB file for IQ measurement in 89600 VSA

The constellation data for the recovered IQ and the radio frame allocations 
can be seen in the first two panels of the 89600 VSA and match those that 
were plotted by the O-RAN Studio software.
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Downlink

Figure 123 Recovered IQ data for DL in 89600 VSA
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Uplink

Figure 124 Recovered IQ data for UL in 89600 VSA

This section only describes the basic steps that must be performed to 
measure IQ carrier in the 89600 VSA software. For more information about 
the various features and the functionality of the VSA software, refer to the 
PathWave Vector Signal Analysis (89600 VSA) Online Help.
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Section 3.4: Emulating the Uplink Carrier

 3.4.1: Support for UCI format

Open RAN Studio supports Signal Generator project files for the uplink 
carrier, which has been configured by enabling the UCI format in the 
PathWave Signal Generation Desktop 2022 interface, as displayed in 
Figure 125. Note that the following configuration also includes the 
UL-SCH format.

Figure 125 Uplink carrier generated in PWSG with UCI format (PUCCH Ch.)
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1 Generate an SCP file after you have completed the configuration in 
PathWave Signal Generator.

2 On the O-RAN Studio software, click File > Recall > Signal Studio 
Project... to open that SCP file.

The SCP file contents are displayed as shown in Figure 126.

Figure 126 Uplink carrier with UCI format (PUCCH Ch.) in O-RAN Studio

Notice how the corresponding Frame allocation for UCI format is 
highlighted when the PUCCH Channel entry is selected.
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 3.4.2: Support for SRS format

Along with the UCI format, Open RAN Studio software version 1.3 (and 
higher) also support Signal Generator project files for the uplink carrier, 
which has been configured by enabling the SRS format in the PathWave 
Signal Generation Desktop 2022 interface, as displayed in Figure 127. 
Note that the following configuration also includes the UL-SCH and UCI 
formats.

Figure 127 Uplink carrier generated in PathWave Signal Generator with SRS format

NOTE
Configurations with multiple UL channels (including combinations of 
SRS, UCI, PUSCH) are supported in the Open RAN Studio software. 
However, make sure that the SRS Channel does not overlap with either 
PUSCH or PUCCH Channels.
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• MIMO configuration is enabled if you configure “Antenna Port(s) 
Generated” to a logical antenna port value, such as ‘p0’, ‘p1’, and so on.

• You may find “asymmetric masks” in the Radio Allocations if you set 
“SRS-for-positioning” to ‘On’.

1 Generate an SCP file after you have completed the configuration in 
PathWave Signal Generation Desktop 2022 software.

2 On the O-RAN Studio software, click File > Recall > Signal Studio 
Project... to open that SCP file.

The SCP file contents are displayed as shown in Figure 128.

Figure 128 Uplink carrier with SRS format (SRS Ch.) in O-RAN Studio

Notice that the corresponding Frame allocation for SRS format is 
highlighted when the SRS Channel entry is selected.
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Following images illustrate the appearance of Radio Allocations for various 
configuration of the SRS Channel in Open RAN Studio.

Configuration 1: No hopping and not periodic

Figure 129 SRS Channel without hopping nor periodic enabled
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Configuration 2: No hopping but periodic

Figure 130 SRS Channel without hopping but periodic only enabled

In this configuration, allocation spans over multiple symbols when reMask 
is disabled or when reMask is same on neighboring symbols.
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Configuration 3: Both hopping and periodic

Figure 131 SRS Channel with both hopping and periodic enabled

For the multi-frame SRS configuration, if you enable Uplink Emulation (as 
explained in Creating U-Plane messages in Uplink Carrier on page 170), a 
warning is displayed, as shown in Figure 132, when you generate the 
Uplink PCAP file. This warning message is displayed only when you export 

NOTE
Configurations with multiple SRS Channels in the same carrier are 
supported in the Open RAN Studio Software. However, overlapping of 
SRS Channels is currently not supported.
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the stimulus file after selecting the “Create Uplink U-Plane” option in the 
“Options” tab of the C/U Plane Builder Configuration Tool and the SRS 
configuration is not supported.

Figure 132 Warning displayed for unsupported SRS configuration
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Configuration 4: Multi-frame SRS configuration

Currently, Uplink Emulation for multi-frame SRS configuration is 
supported only when hopping is disabled and SRS allocations are identical 
in every frame.

Figure 133 SRS Channel with both hopping and periodic enabled

Use the “Frame Index” feature in Open RAN Studio to switch between 
frames.
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Enabling reMask with SRS Channel

In an Uplink carrier with SRS Channels, when you enable the reMask 
configuration option, allocations on two neighboring symbols are not 
merged because REs are in different patterns. To understand this behavior, 
consider the following steps:

1 Load a UL SCP file with SRS Channels.

Figure 134 Loading a UL SCP file with SRS Channels

2 Select the Flow/eXAC ID.

3 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

4 Switch to Explorer tab and load the stimulus file.
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Figure 135 Loading the corresponding PCAP file

5 Launch the “C/U-Plane Builder Configuration” window in the Open 
RAN Studio software.

6 Click the “Options” tab.

7 Select the “Use reMask” check box.
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Figure 136 Enabling the ‘Use reMask’ configuration option

8 Exit the “C/U-Plane Builder Configuration Tool” window.

9 Export the O-RAN Stimulus file again for the configuration changes to 
take effect.

10 In the Explorer tab, open the regenerated stimulus file.

11 In the ‘U-Plane, C-Plane Messages’ area, highlight the first row of 
C-Plane messages, which correspond to StartSymbolId: 2, as shown in 
Figure 137.
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Figure 137 Viewing reMask pattern for StartSymbolId: 2

12 Similarly, highlight the second row of C-Plane messages, which 
correspond to the neighboring StartSymbolId: 3, as shown in 
Figure 138.



156 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Figure 138 Viewing reMask pattern for neighboring StartSymbolId: 3

13 Switch to the C-Plane Builder tab to view the Radio Allocations and 
highlight the first symbol.

14 Open the regenerated SCP file (with reMask enabled) in the PathWave 
Signal Generation Desktop 2022 software.

Figure 139 validates the behavior of the SRS Channel, which was 
described earlier, when reMask is enabled. The RB Resource Mapping 
for SRS1 shows the startsymbolID on the corresponding pattern.
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Figure 139 Viewing allocations on two neighboring symbols

Enabling reMask and K_TC = 8 with SRS Channel

Let us consider the case where the SCP file from the previous example is 
modified in the PathWave Signal Generation Desktop 2022 software, such 
that the “Transmission Comb Number (K_TC)” value is changed to ‘8’.
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Figure 140 Setting K_TC = 8 in PathWave Signal Generation Desktop software

When the PCAP file is generated in Open RAN Studio software for this SCP 
file with the “Use reMask” option enabled, you shall notice separate 
allocation on each PRB. This is because SRS REs are in every 8th RE 
resulting in different reMask values for neighboring PRBs on a symbol. This 
behavior is displayed in the Message Interpretation area for neighboring 
PRBs, as shown in Figure 141 and the RB Resource Mapping for SRS1 
from the PathWave Signal Generation Desktop 2022 software and its 
corresponding allocation is shown in Figure 142.
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Figure 141 Viewing Message Interpretation area for reMasks
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Figure 142 Viewing allocations and corresponding mapping
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Enabling reMask in a MIMO configuration of SRS Channel

REs can be shifted for different antennas in a MIMO SRS configuration for 
same PRB. This can be checked by comparing reMasks in C-plane 
message with where the IQ data is placed in the U-plane message.

To view this behavior, perform the following steps:

1 Load an SCP file (for example, hop_n_SRS_cs.scp) with a MIMO 
configuration having two or more antennas and SRS Channel 
allocation.

Figure 143 Loading a MIMO SCP file with SRS Channel allocation
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2 Launch the “C/U Plane Builder Configuration Tool” and perform the 
following settings, as shown in Figure 144.

• Select the “Use reMask” check box

• Select the “Use Extension Type 10 (MIMO Only)” check box

• Select the “Create Uplink U-Plane” check box

Figure 144 Setting configuration options for shifting REs

3 Exit the “C/U-Plane Builder Configuration Tool” window.

4 Export the O-RAN Stimulus file for the configuration changes to take 
effect.
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5 In the Explorer tab,

a Open the PCAP file (hop_n_SRS_cs.pcap) containing C-Plane 
messages.

b Highlight the first C-Plane message in the U-Plane, C-Plane 
Messages area.

Notice the reMask pattern for the selected PRB, as highlighted in 
the Message Interpretation area in Figure 145.

Figure 145 reMask pattern for the selected PRB

c Highlight the second row in the U-Plane, C-Plane Messages area.
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Notice the shift in the reMask pattern for the same PRB, as 
highlighted in the Message Interpretation area in Figure 146.
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Figure 146 Shift in reMask pattern for the selected PRB

d To view the shift in the Recovered IQ data for the same PRBs, load 
the PCAP file (hop_n_SRS_cs_UL.pcap) containing U-Plane 
messages.

e Highlight the first U-Plane message in the U-Plane, C-Plane 
Messages area.

f Highlight PRB0 in the Message Interpretation area to view the 
corresponding Recovered IQ data, as shown in Figure 147. This data 
corresponds to the reMask selected in Figure 145.

Figure 147 Recovered IQ data for the selected PRB
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g Highlight the second row in the U-Plane, C-Plane Messages area.

h Highlight PRB0 in the Message Interpretation area to view the 
corresponding Recovered IQ data, as shown in Figure 147. This data 
corresponds to the reMask selected in Figure 145.

Figure 148 Shift in Recovered IQ data observed for the same PRB

 3.4.3: Applying reMask for PUSCH Channel
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Applying the reMask configuration option causes a recalculation of the 
sections displayed in the C-Plan Builder tab of the Open RAN Studio 
software. 

This section shows the appearance of Radio Allocations in the Open RAN 
Studio Software and the appearance of RB Resource Mapping for 
UL-SCH1, caused by enabling reMask (see Using reMask only on 
page 352) for PUSCH Channel, which has DM-RS setting inside PUSCH, 
DM-RS setting outside PUSCH and DM-RS setting with additional 
position.

Scenario 1: reMask enabled with DM-RS setting inside PUSCH

Figure 149 Radio allocations for DM-RS inside PUSCH with reMask enabled

NOTE
Transform Precoding in UL-SCH format of Uplink carrier is currently not supported.
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Scenario 2: reMask enabled with DM-RS setting outside PUSCH, where 
DM-RS is 2 REs high

Figure 150 Radio allocations for DM-RS outside PUSCH with reMask enabled
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Scenario 3: reMask enabled with DM-RS setting with additional position

Figure 151 Radio allocations for DM-RS with additional position and reMask enabled
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 3.4.4: Creating U-Plane messages in Uplink Carrier

By default, the uplink carrier contains only C-Plane messages. However, 
certain operations, such as extracting IQ flow is not possible without 
U-Plane messages in the carrier.

The “Create Uplink U-Plane” option in Configuration Tool of the Open RAN 
Studio software lets you create separate files for Uplink U-Plane 
messages.

1 Save a PathWave Signal Generation Desktop / Signal Studio project 
for the Uplink carrier with the Channel setup for UCI/UL-SCH/SRS 
formats.

Figure 152 SCP file for Uplink Carrier

2 In the Open RAN Studio software, open the .scp file for the uplink 
carrier.

NOTE
IQ recovery of Mixed Numerology in UL carrier is currently not supported.
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Figure 153 SCP file for Uplink Carrier opened in O-RAN Studio

3 Select the Flow/eXAC ID.
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4 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file. See Exporting O-RAN Stimulus File on page 122 for more 
information.

The folder that contained the SCP file now contains the additional files, 
including the PCAP file.

Figure 154 Stimulus files generated using O-RAN Studio
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5 Switch to Explorer tab and load the stimulus file.

Figure 155 Viewing the Uplink PCAP file contents in Explorer tab

Notice that the UL stimulus file consists of C-Plane messages only but 
not U-Plane message.
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6 Launch the “C/U-Plane Builder Configuration Tool” window in the 
Open RAN Studio software.

7 Click the “Options” tab.

8 In the ‘U-Plane Package’ area, select the check box for ‘Create Uplink 
U-Plane’.

Figure 156 Selecting option to create PCAP file with Uplink U-Plane messages

9 Exit the “C/U-Plane Builder Configuration Tool” window.
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10 Export the O-RAN Stimulus file again for the configuration changes to 
take effect. See Exporting O-RAN Stimulus File on page 122 for more 
information.

The folder that contained the SCP file now contains an additional PCAP 
file, which has ‘_UL’ suffixed to the file name. This PCAP file consists of 
only U-plane UL messages and can be used for operations similar to 
that for a DL PCAP.

Figure 157 PCAP file with ‘_UL’ suffix



176 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

11 In the Explorer tab, open the new stimulus file (which has the ‘_UL’ 
suffixed by O-RAN Studio software).

Figure 158 Opening the PCAP file with Uplink U-Plane messages
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The U-Plane UL PCAP file contents are visible in the Explorer tab and it 
does not contain any C-Plane messages. You may treat this file as you 
would process a DL PCAP file, especially for IQ extraction.

Figure 159 Viewing the PCAP file contents with Uplink U-Plane messages
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Section 3.5: Emulating the PRACH Carrier

The Open RAN Studio supports PRACH sequences in both 5G NR and 
LTE-TDD / LTE-FDD signals and allows you to:

• Generate PCAP files for PRACH C-plane

• Generate PCAP files for PRACH U-plane (currently for 5G NR signals 
only)

• View the PCAP files for PRACH in the Explorer tab

• Recover IQ data in frequency and time domains (currently for 5G NR 
signals only)

You may also add PRACH bursts to an LTE signal. See Configuring LTE 
signals with PRACH bursts on page 236 for more information.

Let us understand the format of the PRACH sequence for 5G NR signals, 
which is generated using the PathWave Signal Generation Desktop 2022.
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Figure 160 Setting up PRACH Channel in PathWave Signal Generation Desktop 2022

As seen in Figure 160, PRACH carrier consists of a single PRACH channel. 
PRACH channel can have multiple bursts (of same preamble format) 
spread in time and frequency domains. The image above shows a single 
burst only but you can add more bursts to the PRACH Channel.
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 3.5.1: Generating & viewing PCAP files for PRACH

1 Load the SCP file that contains the PRACH sequence into the O-RAN 
Studio software.

Figure 161 Loading SCP file with the PRACH sequence

2 Assign a ‘Flow/eAxC ID’.

3 Note down the details that are highlighted in Figure 161, which are 
required for configuration settings.

4 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file. See Exporting O-RAN Stimulus File on page 122 for more 
information.
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5 Load the stimulus / recording PCAP file into O-RAN Studio.

Figure 162 Loading PCAP file with the PRACH sequence

Open RAN standard uses C-plane Section Type 3 for PRACH. As seen in 
Figure 162, the U5040A Open RAN Studio software currently supports a 
single C-plane message for each PRACH burst. Each PRACH sequence 
repetition is considered as a separate symbol. PRBs are numbered from ‘0’ 
for each burst.
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 3.5.2: Viewing PRACH Type 3 as Type 1 messages

1 Load the stimulus / recording PCAP file into O-RAN Studio that 
contains Section Type 3 C-Plane messages for the PRACH carrier. See 
Figure 162.

2 Launch the “C/U Plane Builder Configuration Tool” window.

3 In the ‘Options’ tab, select the “PRACH Type 3 as Type 1 Message” 
check box in the ‘C-Plane Section handling’ area.

Figure 163 Configuring PRACH Type 3 as Type 1 Message

4 Close the “C/U Plane Builder Configuration Tool” window.
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5 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

6 Load the modified stimulus / recording PCAP file into O-RAN Studio.

Figure 164 Modified PCAP file with the Section Type 1 C-Plane messages

Figure 164 shows Section Type 1 C-Plane Messages instead of Type 3 
Messages for the PRACH carrier.
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 3.5.3: Recovering IQ data from PRACH carrier

If you have a PCAP file that is not produced by the U5040A Open RAN 
Studio software and has been captured from an O-RU device, the “PRACH 
IQ Recovery” option enforces Open RAN Studio software to treat the 
U-Plane flow as PRACH flow during IQ recovery.

1 Load the PCAP file, containing a U-Plane flow, captured from an 
external source into O-RAN Studio.

Figure 165 External PCAP file containing U-Plane data for PRACH IQ recovery

2 Launch the “C/U Plane Builder Configuration Tool” window.



Keysight U5040A Open RAN Studio User Guide 185

Configuring Features in the O-RAN Studio UI 3

 

3 In the ‘Numerology’ tab, perform the following configuration:

a check that the Bandwidth of the carrier and the Numerology are 
configured correctly

b In the ‘PRACH IQ Recovery’ area, select the “Use PRACH IQ 
Recovery Options” check box

i Select the correct “PRACH Format” from the drop-down list.

ii Select the correct “PRACH SCS” value.

iii Enter the correct “Frequency Offset” value.

Values for PRACH SCS and Frequency Offset can be looked up 
in C-plane messages, as text in GUI hints.

Figure 166 Numerology configuration required for PRACH IQ recovery

4 Close the “C/U Plane Builder Configuration Tool” window.

5 Select a U-Plane flow to filter the data.

6 Click the icon to “Filter on Selected Flow”.
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7 Click the icon to “Recover IQ Waveform”.

Figure 167 Performing IQ recovery on the U-Plane flow

8 Click “OK” when the ‘Activity Progress’ on the ‘Progress Dialog’ reaches 
100%.
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9 Select a row in the ‘U-Plane, C-Plane Messages’ area and click a PRB 
slot to view the Constellation diagram for the recovered IQ data.

Figure 168 Performing IQ recovery on the U-Plane flow

10 Launch the 89600 VSA software.

11 From the main menu, click File > Recall > Recall Setup....

12 On the Recall Setup window that appears, navigate to the folder where 
the SETX file, corresponding to the PCAP file captured by the O-RU 
device, is located.

13 Select the SETX file and click Open.

14 From the main menu, click File > Recall > Recall Recording....

15 On the Recall Recording window that appears, all stimulus files are 
displayed, which are associated with the SETX file loaded in the 
previous step. Select the ORB file.

16 On the right pane, under “Padding Selection”, select ‘Repetition’.

17 Modify “Factor” field to ‘3’.
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Figure 169 Loading ORB file to extract IQ data in the 89600 VSA software

18 Click Open.
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The Constellation diagram for the PRACH IQ data is plotted along with 
the summary of the data measured.

Figure 170 Recovered PRACH IQ data in the 89600 VSA software

Note that if the PCAP files are generated by the O-RAN Studio software, 
you do not have to enable the “PRACH IQ Recovery Options” check box.
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Section 3.6: Working with LTE signals

 3.6.1: Configuring LTE along with Multi-Standard Radio (MSR)

Beginning with ver. 1.3 of the U5040A Open RAN Studio software, you can 
load the LTE-FDD / LTE-DD SCP projects directly into the software; 
thereby, skipping the process of generating a Psuedo SCP file using an 
external LTE-FDD / LTE-TDD application.

To generate SCP files for LTE carrier consisting of PRACH bursts, you 
require the N7624C Signal Studio Pro for LTE/LTE-Advanced FDD 
software for LTE FDD signals and the N7625C Signal Studio Pro for 
LTE/LTE-Advanced TDD software for LTE TDD signals.

Currently, the Open RAN Studio software supports the following properties 
in an LTE SCP file:

• Only single carrier per CA

• Carrier BW only 5, 10, and 20 MHz, SCS only 15kHz

• Single frame only

• Radio allocations become slot “blankets”

• PRACH only format 0, only default positions

• No support for UpLink emulation

• No support for MIMO configuration

NOTE
You can neither load nor switch between both SCP files for LTE-FDD and 
LTE-TDD signals in a single instance / session of the U5040A Open RAN 
Studio software. After working on one of the SCP files for either LTE-FDD 
or LTE-TDD signal, you must restart the instance of the Open RAN Studio 
software to work on the other SCP file.



Keysight U5040A Open RAN Studio User Guide 191

Configuring Features in the O-RAN Studio UI 3

 

Loading the SCP file for LTE only

Similar to loading the SCP file for a 5G NR signal, you can now load an 
LTE-FDD / LTE-TDD SCP file in the Open RAN Studio software, using the 
File menu option to Recall Signal Studio Project.

• Click File > Recall > Signal Studio Project....

Figure 171 Opening the LTE-FDD/LTE-TDD SCP file similar to 5G NR SCP file

• From the “Open” dialog box that is displayed, select the SCP file for 
LTE-FDD signal and click ‘Open’.

Figure 172 Accessing LTE-FDD/LTE-TDD SCP file for loading



192 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

The “Select Carrier” drop-down field shows only the “LTE Carrier”.

Figure 173 Appearance of LTE-FDD/LTE-TDD SCP file contents

Loading the SCP files for 5G NR and LTE in the same instance

An alternate way to load the LTE-FDD / LTE-TDD SCP file in the Open RAN 
Studio software is by using the File menu option to Import LTE Setup for 
DSS. However, you must load an SCP file for 5G NR signal first.

• Click File > Recall > Signal Studio Project....
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Figure 174 Opening the 5G NR SCP file

• From the “Open” dialog box that is displayed, select the SCP file for 5G 
NR signal and click ‘Open’.

Figure 175 Accessing 5G NR SCP file for loading

The “Select Carrier” drop-down field shows only the “NR Carrier”.
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Figure 176 Appearance of 5G NR SCP file contents

• To load the SCP file for the LTE carrier, click File > Import > Import LTE 
Setup for DSS....
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Figure 177 Importing the LTE SCP file in addition to 5G NR SCP file

• From the “Open” dialog box that is displayed, select the SCP file for LTE 
signal and click ‘Open’.

Figure 178 Accessing LTE SCP file for importing
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The “Select Carrier” drop-down field shows both the “NR Carrier” and 
“LTE Carrier”.

Figure 179 Appearance of 5G NR and LTE Carrier in the Select Carrier field

• Toggle between the carrier to view the respective Radio Allocations.
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Viewing PCAP files & recovering IQ for 5G NR and LTE in the same instance

After loading both the 5G NR and LTE SCP files, as seen in Figure 179 of 
the previous section, perform the following steps:

1 In the C/U-Plane Builder Configuration Tool, add at least one more 
flow to match the number of carriers.

2 Assign a Flow/eAxC ID to each carrier.

Figure 180 Assigning Flow/eAxC ID to each carrier

3 Without making any further configuration changes, export the O-RAN 
Stimulus file.

4 Switch to the Explorer tab and load the PCAP file.
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Figure 181 Viewing PCAP file contents with the default configuration

5 Launch the “C/U-Plane Builder Configuration Tool”.

6 Click the “Numerology” tab.

7 Perform the following settings to match the properties of the LTE 
carrier.

a Set Bandwidth to “FR1 5 MHz”

b Set SCS to “15kHz”

c Enable “Use LTE IQ Recovery Options” check box.

d Disable “Add null DC subcarrier (use with LTE only)” in case it is 
enabled
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Figure 182 Setting configuration options for recovering IQ from LTE

8 Exit the “C/U-Plane Builder Configuration Tool”.

9 Export the O-RAN Stimulus file again.

10 Load the regenerated PCAP file.

11 Select the flow corresponding to the LTE carrier in the U-Plane area, as 
shown in Figure 183.

12 Click the icon to “Filter selected row”.
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Figure 183 Filtering selected flow to perform IQ recovery

13 Click the icon for “Recover IQ waveform.
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Figure 184 Recovering IQ waveform for the selected flow

The ORB file is generated, which contains the recovered IQ data, is 
required to view the recovered data in the 89600 VSA software. The 
files can be found in the same folder where the PCAP, ORSTX and SCP 
files are located.
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Figure 185 Recovering IQ waveform for the selected flow

Since the IQ data has been recovered from the 5G NR signal, you require 
the SETX and ORB files to view the recovered IQ data in the 89600 VSA 
software. See Recovering IQ flow in O-RAN Studio & 89600 VSA on 
page 128 to see how to view the recovered IQ data in the 89600 VSA 
software

Note that the O-RAN Studio software does not generate a SETX file from 
the SCP file for LTE. Instead, you can proceed with loading the ORB file 
containing the IQ data. See Recovering IQ from LTE on page 241 for more 
information on recovering IQ data from LTE signal using the 89600 VSA 
software.



Keysight U5040A Open RAN Studio User Guide 203

Configuring Features in the O-RAN Studio UI 3

 

 3.6.2: Configuring LTE Coexistence - DSS

DSS (Dynamic Spectrum Sharing), also known as NR and LTE coexistence,
enables 5G to share the same spectrum used by LTE today. This allows
gradual migration from 4G to 5G. Operators can keep LTE service while
deploying 5GNR on top. DSS must make the combined 5G/LTE downlink
to be seamless for LTE UEs because most of the LTE UEs were deployed
before 5G NR was introduced.

When 5GNR subcarrier spacing (SCS) is 15kHz, it is possible to configure
sharing spectrum with LTE, since the LTE subcarrier spacing is the same.
To avoid signal scheduling conflicts, the 5GNR overlay must avoid known
LTE channels and signals (including PDCCH, CRS, PSS/SSS/PBCH) that
are always transmitted. If 5GNR uses these same resources, the LTE UE
will not receive the LTE DL signal correctly. At the same time, 5G NR
devices must detect the 5G synchronization signal block (SSB) to access
the network. To prevent a conflict between 5G SSB and LTE cell-specific
reference signal (CRS), a combination of MBSFN (Multimedia Broadcast
Single Frequency Network) and normal LTE subframes are used.

To configure a combined LTE and 5G NR waveform, we shall use one LTE
MBSFN subframe to transmit NR SSBlock and seven LTE Normal
subframes to transmit 5G NR PDCCH and PDSCH plus LTE control
channels. 

Figure 186 shows a graphical view of the LTE Normal subframe
configuration used in this example (MBSFN not shown). LTE CRS is always
ON. When 5G-NR physical downlink shared channel (PDSCH) uses 15 kHz
SCS, the subcarriers of LTE and 5G-NR are also orthogonal. A 5G-NR user
is configured with the LTE CRS frequency information so that you can
calculate the LTE CRS positions as reserved resources, and the 5G-NR
PDSCH rate will match around those reserved resources. By rate
matching, 5G-NR PDSCH can also be scheduled on the OFDM symbols
with CRS, but on the subcarriers not occupied by CRS, as shown below in
grey and green.

NOTE
Since Open RAN Studio is designed primarily for the measurement of 5G
NR signals, the 5G NR SCP file must be loaded first and subsequently,
you can add the LTE SCP file to obtain DSS. You cannot add 5G NR SCP
after loading LTE SCP file.
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The additional 5G PDSCH Demodulation Reference Signal (DMRS)
additional position should have been on Symbol #11. However, for DSS,
because there is an LTE CRS on Symbol #11, the DMRS must move to
Symbol #12 as shown here. Such configuration is supported by the 89600
VSA software and Signal Studio software. 

Figure 186 Graphical view of the LTE Normal subframe configuration

Perform the following LTE and 5G NR configuration:

Table 9 LTE Configuration for DSS

Parameter Value

Cell ID 0

# of antennas 1

Duplex type FDD

System Bandwidth 20MHz

Allocated Normal subframes #0, #5 

Allocated MBSFN subframe #1

Modulation Type 64QAM

PDCCH symbols 2 (that is, symbols 0 & 1)
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Table 10 5G NR Configuration for DSS

LTE-FDD Configuration in N7624C Signal Studio

Perform the following configuration in the N7624C Signal Studio software:

1 Delete Carrier and add carrier as LTE-A Pro FDD, Advanced FDD 
Downlink CA, E-UTRA Downlink CC.

2 Under the Downlink node on the left under Component Carrier 1, 
select a Predefined Config as Full Filled 64QAM 20MHz (100RB).

3 Confirm Cell ID is set to 0.

4 Under the Channel Setup node on the left, select #1 DCI (first row of 
the table), set PDCCH Allocations to 2,2,2,2,2,2,2,2,2,2. All PDCCHs 
will occupy 2 symbols per subframe. See the pink boxes in the resource 
element diagram in Figure 186.

5 Still under the Channel Setup node, select #3 DL-SCH1, and set 
Transmission Configuration Length (under transmission settings) to 
10 ms.

6 Select the Transmission Configuration row and click […] at the far 
right to open DL-SCH1 Tx Sequence window.

• Under State, clear all except for Subframe #0 and #5 and click OK 
to close.

7 Under Channel Setup, select #13 MCH to make MBSFN settings.

8 Set State to ON.

9 Set Allocation Bitmap = 1,0,0,0,0,0 (only the first possible MBSFN 
subframe will be used to transmit 5G NR SSB).

Parameter Value

Cell ID 0

# of antennas 1

Duplex type FDD

System Bandwidth 20MHz

Allocated subframes #1-4, #6-9

Modulation Type 64QAM

Downlink Control Information (DCI) first symbol 2 (Symbols 0 & 1 used by LTE PDCCH)

PDSCH symbol allocation 3-13

DMRS Additional Position 1 (that is, there is a 2nd DMRS transmitted)
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10 Set Transmit PMCH and MBSFN RS on MBSFN Region to OFF. Note 
that this step is possible only with the latest version of the Signal 
Studio software.

The LTE Channel allocation should appear as shown in Figure 187. Notice 
that nothing (even CRS) is transmitted in the MBSFN region (Slots 2-3 or 
Subframe #1). This makes room for 5GNR to use for SSB transmission. 

Figure 187 LTE Channel Allocation after configuration for DSS

5G NR Configuration in PathWave Signal Generation Desktop 2022

Perform the following configuration in the PathWave Signal Generation
Desktop 2022 software using the default Downlink carrier:

1 Under “Carrier 1 (DL)”, click Full-Filled Config button at the top. In the
dialog that results, select FR1 20MHz for Bandwidth, u=0: 15kHz for
Numerology and 64QAM for Modulation. Then, click OK.

2 Under Channel Setup, click SS/PBCH tab.

3 Set Active Indices to 2:3. The blank space in slots 2 and 3 from the LTE
setup transmits SSB only within the MBSFN subframe, to avoid conflict
with LTE-CRS.

4 Click DCI tab. Select Enabled to ON. Set Allocated Slots to 2:4, 6:9
(ignore the conflict error message that you may see).

NOTE
The “Non-MBSFN Region Length” is set to 2 by default, which shall be 
used for the configuration. MBSFN subframe contains a control region of 
length one or two OFDM symbols, these are same control symbols as the 
normal subframe. The rest of the symbols are used for MBSFN.
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5 Set First Symbol to 2. Note that LTE PDCCH is occupying symbols 0 &
1. Use default settings for the other DCI parameters.

6 Click DL-SCH tab. Under Resource Allocation, set Allocated Slots to
2:4, 6:9. Then, set First Symbol to 3 (after CORESET symbol). 

7 Under DMRS Settings, set DMRS-add-pos to 1 (an additional DMRS 
is transmitted on Symbol #11, which is typically done to help with 
channel estimation. However, it moves to Symbol #12, when DSS is 
enabled).

8 Set DMRS-typeA-pos to 3 (that is, the DMRS is transmitted on the first 
symbol of DL-SCH, which is Symbol #3).

9 Click LTE Coexistence tab. Set Enabled to ON.

10 Set LTE Bandwidth to 20MHz.

11 Set LTE Carrier Offset to Point A to 636. This sets LTE and 5GNR 
center to be the same.

12 Set MBSFN Subframes to 1.

13 Set Number of CRS Antenna Ports to 1 and v-shift to 0. These 
parameters determine LTE-CRS position (which the 5G NR PDSCH 
must avoid from using). ‘v-Shift’ is derived from LTE Cell ID with ‘cell ID 
mod 6’. Set LTE Cell ID to 0, so that v-Shift value is 0.

14 Set additionalDMRS-DL-Alt to ON. This moves the additional 5G 
PDSCH DMRS position to Symbol #12 (from Symbol #11). Note that 
this is a UE capability. The UE must notify the network, where it 
supports this feature.

NOTE
You additionally need the RNTI (that is, 0) and aggregation level (that is,
4) information for ‘Demod.’ Note these values as the VSA default for
these parameters are not the same as that in Signal Studio. 

NOTE
This parameter sets positioning of the LTE carrier against 5G NR. When 
single numerology is selected, Point A is the lower edge of 5G NR carrier. 
The offset specifies the LTE carrier center location from Point A with the 
number of subcarriers. For 20 MHz BW and 15kHz SCS, there are 106 
RBs in the resource grid. So, we use 636 (=53RB * 12) to have the LTE 
and 5G NR center to be the same.
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At this point, the channel allocation should look like that which is shown in 
Figure 188. White line indicates LTE CRS. Notice that 5GNR DL-SCH 
occupies the same frequency as LTE where CRS is transmitted.

Figure 188 LTE Coexistence (5G NR Channel Allocation) configuration for DSS
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Figure 189 Position of additional DMRS

15 Finally, click File/Export Waveform Data, and set waveform file name 
as “5GNR DL 20MHz DSS.wfm”.

MSR Configuration in the N7624C Signal Studio software

1 Under Waveform Setup, click Add Carrier and add Imported 
Waveform. New carrier is added as Carrier 1 and LTE Downlink carrier 
is now Carrier 2.

2 With Carrier 1 selected on the left pane, click Source Waveform File 
Name, click […] and select 5GNR DL 20MHz DSS.wfm that was saved 
in the previous section.

3 Click File/Export Waveform Data, save as DSS 5GNR LTE.wfm. (Or, if 
you are connected to a signal generator, click generate and download 
button, and skip step #5)

4 Load the WFM file to your signal generator for playback.

Configuring DSS in Open RAN Studio software

This section shows the configuration of DSS feature to pair the LTE and NR 
carriers and its functionality with the Extension Type 9 in the Open RAN 
Studio software.

To begin with, perform the same steps as discussed in Loading the SCP 
files for 5G NR and LTE in the same instance on page 192.

1 Load an SCP file for 5G NR signal.

The “Select Carrier” drop-down field shows only the “NR Carrier”.
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Figure 190 Appearance of 5G NR SCP file contents

2 Load the SCP file for the LTE carrier by clicking File > Import > Import 
LTE Setup for DSS....
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Figure 191 Importing the LTE SCP file in addition to 5G NR SCP file
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The “LTE Carrier” is displayed in the C-Plane Builder tab. The LTE 
displays Channels like CRS.

Figure 192 Appearance of LTE Carrier in the C-Plane Builder tab

3 Assign a Flow/eAxC ID to each carrier.

Note that if you assign the same eAxC ID (for example, 0001) to both 
the LTE and NR carrier, it triggers the generation of Extension Type 9 in 
C-Plane for DSS.

4 Launch the C/U Plane Builder Configuration Tool to make the following 
configuration changes.

• In the Options tab, enable the “Use reMask” feature.
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Figure 193 Enabling remask feature in Configuration Tool

• In the DSS tab, 

i Select “Enable DSS” check box.

ii Select the 5G NR Carrier and LTE Carrier in the respective 
drop-down field.

iii Click the ‘+’ icon to pair the LTE and NR carrier.
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Figure 194 Enabling DSS feature in Configuration Tool

5 Exit the C/U Plane Builder Configuration Tool.

6 Export the O-RAN Stimulus file.

7 Switch to the Explorer tab and load the PCAP file.

8 Find the C-Plane message with subframe 2 and symbol 4.

Notice in Figure 195 that in this case the NR PDSCH overlaps with LTE 
CRS. Also,

• There are two C-Plane messages for this symbol, one below LTE null 
DC subcarrier, and one above, which is due to reMask mapping to 
the same resource grid as the carrier type is of DSS.

• There is Extension Type=9 on each section description

• Use of reMask to separate IQ data for LTE and NR, respectively

• One U-Plane message with IQ data for both LTE and NR, which is 
also separate in the part below the LTE null DC subcarrier and the 
part above.
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Figure 195 Viewing PCAP file for the paired LTE and NR carriers

Recovery of time domain IQ data for inspection in VSA

9 Launch the C/U Plane Builder Configuration Tool again to make the 
following configuration changes, as shown in Figure 196.

• In the Numerology tab,

i Configure Bandwidth

ii Configure Numerology

iii Disable “Use LTE IQ Recovery Options”, if enabled

iv Disable “Add null DC subcarrier (use with LTE only)”, if enabled
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Figure 196 Changing Numerology configuration

10 Exit the C/U Plane Builder Configuration Tool.

11 In the U-Plane area,

a Select the flow.

b Click icon to filter the selected row.

c Click icon to recover IQ waveform.



Keysight U5040A Open RAN Studio User Guide 217

Configuring Features in the O-RAN Studio UI 3

 

Figure 197 Filtering and recovering IQ waveform

This creates the “.orb” file containing time domain IQ data for VSA, as 
shown in Figure 198.

Figure 198 Folder contents where ORB file is created

When this ORB file is loaded into the 89600 VSA software with a Repetition 
Factor ‘3’, you can view the NR in Measurement 1 windows to the left and 
LTE in Measurement 2 windows to the right, as shown in Figure 199.

NOTE
A “.setx” file is also created, but that cannot be used for DSS analysis.
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Figure 199 VSA showing NR on left and LTE on right

For more information about how to perform signal analysis in the 89600 
VSA software when DSS is used, see Analyzing the signal using the 89600 
VSA software on page 219.
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Analyzing the signal using the 89600 VSA software

To understand the process to analyze the signal using the 89600 VSA 
software, the following example uses the DSS feature with 
multi-measurement to demodulate the 5G NR and LTE signals, 
simultaneously.

1 Launch the 89600 VSA software.

2 Select NR mode.

From the main menu, click MeasSetup > Measurement Type > 
Cellular > 5G NR.

3 Set the trace layout to Grid 2x3, and configure center frequency, and 
input range.

Figure 200 Setting various characteristics for the NR mode

NOTE
To improve setup speed in the 89600 VSA software, pause the 
measurement until all parameters are correctly configured and then run 
the measurement.
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4 Open 5G NR Demod Properties panel and start by setting the Carrier 
Type to the appropriate bandwidth.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Configuration > Carriers.

Figure 201 Setting 5G NR Demod Properties

5 Configure Bandwidth properties.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Configuration > Bandwidth.
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 Figure 202 Setting Bandwidth properties for 5G NR

6 Configure Bandwidth Part (BWP) properties to configure the DL BWP 
allocation within the component carrier and the control resource set 
(CORESET). CORESET is used for PDCCH configuration.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Configuration > BWP.
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 Figure 203 Setting BWP properties for 5G NR

7 Configure Channel’s SS/PBCH settings.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Channel > SS/PBCH.
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Figure 204 Setting SS/PBCH properties for 5G NR

8 Configure Channel’s PDCCH settings.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Channel > PDCCH.
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Figure 205 Setting PDCCH properties for 5G NR

9 Configure Channel’s PDSCH settings.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Channel > PDSCH.
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Figure 206 Setting PDSCH properties for 5G NR

10 Enable 3GPP Conformance Test and DC Punctured (or Compensate IQ 
Offset).

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Advanced.
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Figure 207 Enabling 3GPP Conformance Test and DC Punctured

The configuration shown in Figure 207 is explained below:

1 As part of conformance test, 3GPP has defined different equalizer 
training and tracking for EVM measurements.

2 5G NR counts the DC subcarrier as a valid subcarrier for 
rate-matching purposes. High LO feedthrough will impact 
demodulation and EVM performance of the input signal. DC 
Puncture will remove the DC subcarrier from EVM computation and 
from all traces (except the IQ Offset reading) in the Summary Table. 
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Compensate IQ Offset will measure & display DC subcarrier and will 
compensate it in the EVM result.

3 Per symbol phase compensation is a 3GPP requirement and it is 
enabled by default. It is used to compensate for phase differences 
between symbols caused by upconversion or downconversion. 
Getting this setting wrong will cause demodulation issue. In this 
example, it is set to ON and it is applied at the center frequency.

11 At this stage, if you run the measurement, you should see a successful 
demodulation, as shown in Figure 208.

Figure 208 Viewing 3D plot for successful 5G NR demodulation

In Trace D, energy (gray color) can be seen at the same power level as 
5G NR channels but it is not recognized as the active channel. These 
are the LTE channels that are not being recognized as 5G NR. VSA 
recognizes the LTE-CRS within the 5G NR application, but not the 
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other LTE channels. In such cases, the LTE application must be used to 
demodulate the LTE channels. However, by viewing the power level, 
we can find it as being present.

12 Remove the inactive Channel from the 3D plot shown in Figure 208.

From the main menu, click MeasSetup > 5G NR Demod Properties… > 
Results & Filters. 

On the right pane, clear the check box for “Inactive” (see Figure 209).

Figure 209 Removing inactive channel from the 3D plot

13 To add LTE measurement, you must first reduce the number of 5G NR 
traces to “4”, so that LTE can be included.

i Add LTE measurement using VSA's multi-measurement feature.

From the main menu, click MeasSetup > + New Measurement 
> Cellular > LTE.
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Figure 210 Menu item to add LTE measurement

ii Setup shared data acquisition for simultaneous 5G and LTE 
measurements.

From the main menu, click MeasSetup > Measurements.
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 Figure 211 Setting up shared data acquisition

iii Set appropriate values for Center, Span and Range.

NOTE
You may delete the additional two traces, so that you have four 5G NR 
and four LTE traces (or, if using an external monitor, you can use more 
traces).
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Figure 212 Setting Center, Span and Range for measurements

iv Change LTE Bandwidth.

In this example, bandwidth is set to 20MHz (100 RB). From the 
main menu, click MeasSetup > LTE Demod Properties… > 
Format.
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Figure 213 Changing bandwidth for LTE demodulation

v Configure the “Normal” (that is, Non-MBSFN) subframe.

From the main menu, click MeasSetup > LTE Demod 
Properties… > Profile.
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Figure 214 Configuring Normal (non-MBSFN) subframes

vi Configure MBSFN subframe (that is, Subframe #1).

From the main menu, click MeasSetup > LTE Demod 
Properties… > Profile.

Figure 215 Configuring MBSFN subframes
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vii Configure Analysis Region.

From the main menu, click MeasSetup > LTE Demod 
Properties… > Time.

Figure 216 Configuring Analysis region

viii Change one of the traces to Detected Allocations.

Figure 217 shows a successful demodulation of both 5G NR (Meas01) 
and LTE (Meas02). The multi-measurement with simultaneous capture 
is a big differentiator of the 89600 VSA software.



Keysight U5040A Open RAN Studio User Guide 235

Configuring Features in the O-RAN Studio UI 3

 

Figure 217 Simultaneous plotting of 5G and LTE demodulated data
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 3.6.3: Configuring LTE signals with PRACH bursts

Figure 218 shows the format of the PRACH burst in an LTE-FDD signal, 
which is generated using the N7624C Signal Studio Pro for 
LTE/LTE-Advanced FDD software. You may configure the format of the 
PRACH burst in an LTE-TDD signal in the same manner, but using the 
N7625C Signal Studio Pro for LTE/LTE-Advanced TDD software.

Figure 218 LTE carrier generated in N7624C Signal Studio with PRACH bursts

The LTE carrier with two PRACH bursts is generated with Preamble Format 
0. When compared with the PRACH bursts for 5G NR, the LTE PRACH has 
a much simpler configuration, wherein, the latter comprises of less formats 
and less numerologies, features simpler frequency offset calculation as 
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there are no k0 and BWP offsets for LTE PRACH in the respective Signal 
Studio software. In the time domain, LTE PRACH always starts at symbol 0 
in slot 0.

As discussed earlier, you may directly load the SCP file generated for the 
LTE carrier into the Open RAN Studio software (same as loading a 5G NR 
carrier file), without having to generate a Psuedo SCP file compatible with 
Open RAN Studio software.

1 Load the LTE SCP file that contains the PRACH bursts into the O-RAN 
Studio software.

Figure 219 Loading LTE SCP file with PRACH bursts
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2 Assign a ‘Flow/eAxC ID’.

3 Without making any configuration changes, export the O-RAN 
Stimulus file to generate the corresponding PCAP file. See Exporting 
O-RAN Stimulus File on page 122 for more information.

4 Load the stimulus / recording PCAP file into O-RAN Studio.

Figure 220 Loading PCAP file for LTE carrier with the PRACH bursts

Similar to the 5G NR carrier, Open RAN standard uses C-plane Section 
Type 3 for PRACH even for LTE carrier. As seen in Figure 220, the U5040A 
Open RAN Studio software currently supports a single C-plane message 
for each PRACH burst. Each PRACH sequence repetition is considered as a 
separate symbol. PRBs are numbered from ‘0’ for each burst.
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Viewing PRACH Type 3 as Type 1 messages for LTE signal

1 Load the stimulus / recording PCAP file into O-RAN Studio that 
contains Section Type 3 C-Plane messages for the PRACH carrier. See 
Figure 221.

2 Launch the “C/U Plane Builder Configuration Tool” window.

3 In the ‘Options’ tab, select the “PRACH Type 3 as Type 1 Message” 
check box in the ‘C-Plane Section handling’ area.

Figure 221 Configuring PRACH Type 3 as Type 1 Message

4 Close the “C/U Plane Builder Configuration Tool” window.
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5 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

6 Load the modified stimulus / recording PCAP file into O-RAN Studio.

Figure 222 Modified PCAP file with the Section Type 1 C-Plane messages

Figure 222 shows Section Type 1 C-Plane Messages instead of Type 3 
Messages for the PRACH burst in the LTE signal.

NOTE
Uplink emulation (generation of UL PCAP files) and consequently, IQ 
recovery are not supported for LTE PRACH in Open RAN Studio software.
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 3.6.4: Recovering IQ from LTE

The Open RAN Studio software helps you recover IQ data from the LTE 
carrier, using the “Add null DC subcarrier (use with LTE only)” feature in 
“Numerology” tab of the C/U Plane Builder Configuration Tool.

The following example uses an LTE FDD DL carrier of 5 MHz bandwidth. 
You may apply the same steps to recover IQ from an LTE TDD DL carrier.

1 Load the SCP file with the LTE carrier with LTE-FDD allocations.

The SCP file contents are visible in Open RAN Studio.

Figure 223 Viewing the LTE FDD SCP file contents in O-RAN Studio
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2 Select the ‘Flow/eAxC ID’ in the C-Plane Builder tab.

3 Make sure that the “Numerology” settings in the ‘C/U Plane Builder 
Configuration Tool’ are configured correctly.

Figure 224 Checking Numerology settings for the loaded SCP file

Scenario 1: “Add null DC subcarrier (use with LTE only)” option disabled 
(default)

4 Export the O-RAN Stimulus File without selecting the “Add null DC 
subcarrier (use with LTE only)” check box in the ‘Option’ area of the 
‘Numerology’ tab in the C/U Plane Builder Configuration Tool.

5 Load the generated PCAP file.

6 Select the flow from the U-Plane messages, which you wish to filter 
and perform IQ recovery.
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Figure 225 Filtering U-Plane flow to perform IQ recovery

The recovered files are stored in the same folder, where the LTE SCP, 
PCAP and ORSTX files are located.

Figure 226 Files generated after recovering IQ waveform

7 Launch the 89600 VSA software.
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8 From the main menu, click MeasSetup > Measurement Type. If you 
see any value other than ‘LTE’ or ‘LTE-Advanced’, point to the 
sub-menu option “Cellular” and select either “LTE” or “LTE-Advanced” 
to be able to view the LTE IQ data.

Figure 227 Checking Measurement Setup option in 89600 VSA

The O-RAN Studio software does not generate a SETX file from the 
SCP file for LTE. Instead, you can proceed with loading the ORB file 
containing the IQ data.
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9 From the main menu, click File > Recall > Recall Recording....

10 On the Recall Recording window that appears, select the ORB file.

11 On the right pane, under “Padding Selection”, select ‘Repetition’.

12 Modify “Factor” field to ‘3’.

13 Click Open.

Figure 228 Opening ORB file in 89600 VSA
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Notice that there is no IQ data recovered when the “Add null DC 
subcarrier (with LTE only)” Numerology option is disabled.

Figure 229 No IQ data when Add null DC Subcarrier (with LTE only) is disabled
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Scenario 2: “Add null DC subcarrier (use with LTE only)” option selected

14 With the Pseudo SCP (or corresponding PCAP) file loaded, select the 
“Add null DC subcarrier (use with LTE only)” check box in the ‘Option’ 
area of the ‘Numerology’ tab in the C/U Plane Builder Configuration 
Tool.

Figure 230 Enabling the Add null DC subcarrier (use with LTE only) option

15 Load the generated PCAP file.

16 Select the flow from the U-Plane messages, which you wish to filter 
and perform IQ recovery.
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17 Switch to the 89600 VSA software.

18 Make sure that the “Measurement Setup” is set to either ‘LTE’ or 
‘LTE-Advanced’.

19 Repeat steps 13 to 17 to open the updated ORB file in the 89600 VSA 
software.

Notice that a proper constellation is plotted and the IQ data is 
recovered successfully in the 89600 VSA software, when the “Add null 
DC subcarrier (with LTE only)” Numerology option is enabled.

Figure 231 Constellation when Add null DC Subcarrier (with LTE only) is enabled



Keysight U5040A Open RAN Studio User Guide 249

Configuring Features in the O-RAN Studio UI 3

 

Section 3.7: Measuring BER / BLER

For seamless transmission of data, it is imperative to measure (and if 
possible, eradicate) errors, if any. Beginning with version 1.2, the Open 
RAN Studio software provides a functionality to measure the Bit Error 
Ratio and the Block Error Ratio by measuring the ratio of incorrectly 
received bits / blocks to the total bits / blocks received from the O-RU.

The Bit Error Ratio (BER) is defined as the ratio of the bits wrongly received 
to all data bits sent. Current measurement type compares the transmitted 
bits with PN9 sequence and calculates error rate (that is, how many bits 
did not match PN9).

A Block Error Ratio (BLER) is defined as the ratio of the number of 
erroneous blocks received to the total number of blocks sent. Current 
measurement type compares the transmitted demodulated data sequence 
and may correct some error bits. For example, if we transmit data 
sequence “00000000”, but the demodulated bits are “01000000” due to 
noise (1 bit error / total 8 bits). After decoding this bit sequence, the 
original bit sequence “00000000” can be obtained, as the decoder correct 
error bits. 

Before we proceed to understand how to measure the BER / BLER, let us 
understand the prerequisites for the O-RAN Studio software to identify the 
data correctly to perform proper measurements.

The SCP file, generated using the PathWave Signal Generation Desktop 
2022 interface, must have the following characteristics, based on which 
the Open RAN Studio software captures data for BER / BLER 
measurements:

• Carrier Type: Uplink (other carrier types are currently not supported for 
BER / BLER measurements)

• Data taken from SCP file for measurements:

• Bandwidth

• Numerology

• Max RB

NOTE
You must install the license option U5040MULA to use the BER / BLER 
measurement application.



250 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Figure 232 SCP file settings in PathWave Signal Generation Desktop

• Channel Setup (UL-SCH)

• Channel Coding = Off (for BER) / On (for BLER)

• Payload Data = ‘PN9’ sequence
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Figure 233 Channel Coding and Payload settings in SCP file for BER

Figure 234 Channel Coding and Payload settings in SCP file for BLER

Generate an SCP file with the characteristics for measuring either BER or 
BLER.

Note that for the purpose of illustration, the SCP files for BER and BLER 
have been saved in two separate folders named ‘BER’ and ‘BLER’ 
respectively, which were manually created, in the local disk (C:) of the 
machine, as shown in Figure 235. The entire folder path is required to 
define the required file names during the BER/BLER measurements using 
the manual process, as is explained further.

Refer to the Measuring BER / BLER using ORAN Studio Solution (v1.2) 
Reference Guide that explains the process of using OpenTAP automation 
for BER / BLER measurement using the U5040A Open RAN Studio 
software.
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Figure 235 Manually created folders to save SCP files for BER/BLER

The following example displays the steps to measure BLER. The flow for 
BER measurement is the same with some differences, which are explained 
along.
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1 Load the SCP file into the Open RAN Studio software.

Figure 236 SCP file loaded in O-RAN Studio

2 Assign a Flow/eAxC ID to the selected carrier.

3 Launch the “C/U-Plane Builder Configuration Tool” window.

4 In the ‘Options tab’, select the “Create Uplink U-Plane” check box in 
the ‘U-Plane Package’ area. See Creating U-Plane messages in Uplink 
Carrier on page 170 for more information.
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Figure 237 Modifying configuration of the loaded file

5 Close the “C/U-Plane Builder Configuration Tool” window.

6 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file, with the ‘_UL’ suffix.

7 From the main menu, click File > Export > Generate BLER XML File.
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Figure 238 Generating XML file for BER/BLER measurement

The following Progress Dialog is displayed when the XML file is being 
generated.

Figure 239 Activity progress for XML file generation

8 Click ‘OK’ after the Activity Progress reaches 100%.

The folder, where the SCP and the corresponding uplink U-Plane 
message PCAP and ORSTX files are located, shows an XML file with 
the same name as the SCP file. The folder in Figure 240 shows the files 
required for BLER measurement. If measuring BER, the file set will be 
similar, as shown in Figure 241.
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Figure 240 Folder for BLER containing all files reqd. for measurement



Keysight U5040A Open RAN Studio User Guide 257

Configuring Features in the O-RAN Studio UI 3

 

Figure 241 Folder for BER containing all files reqd. for measurement

The set of files generated previously (SCP and WFM) and the stimulus 
file generated in this section (PCAP_UL) are used as inputs to a 
BittWare system, with triggering and automation enabled.

After the files required for BER/BLER measurement are generated, you 
may use an OpenTAP automated process to generate the PCAP file for 
measurement of BER/BLER on the BittWare server. Another option is 
to use either a manual process or your own automation application to 
generate the JSON files that contain the measurement data. This is 
depicted in Figure 242.

This document explains the steps for measurement using manual 
process only, which you may automate using your custom methods. 
Refer to the Measuring BER / BLER using ORAN Studio Solution (v1.2) 
Reference Guide to understand how to use the OpenTAP Application’s 
automation.
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Figure 242 BittWare System generating PCAP file for BER / BLER measurement

Note that before proceeding with either the manual or your own 
automation process for BER/BLER measurements, you must automate the 
captured O-RU response on a BittWare setup. This requires coordination 
of the O-DU and the signal generator to make sure that it sends the signal 
when the O-RU expects it. Once the captured file has been created, save it 
in the same folder where the other files (SCP, ORSTX and XML) are placed 
for BER or BLER measurements. Proceed with the measurements either 
manually or through your own automation system.

Measurement using manual process or custom automation

a From the Start menu on your machine, launch the Command 
Prompt window.

b Set the root folder as “C:\Program Files\Keysight\Open RAN 
Studio”, where the ErrorRatioAnalyzer.exe is installed during the 
installation / upgradation of the U5040A Open RAN Studio software 
ver. 1.2 or higher.



Keysight U5040A Open RAN Studio User Guide 259

Configuring Features in the O-RAN Studio UI 3

 

Figure 243 Setting root folder for ErrorRatioAnalyzer

c Type the following syntax and press Enter.

ErrorRatioAnalyzer BER|BLER <scpFilename> <xmlFilename> 
<pcapFilename> <orstxFilename>

Note that in this syntax,

• ErrorRatioAnalyzer is the executable file that is installed in the folder 
“C:\Program Files\Keysight\Open RAN Studio” when you install 
Open RAN Studio software ver. 1.2 or higher.

• Either ‘BER’ or ‘BLER’ must be entered to indicate the measurement 
you are performing

• <scpFilename>: enter full path for the SCP file

• <xmlFilename>: enter full path for the XML file

• <pcapFilename>: enter full path for the captured PCAP file

• <orstxFilename>: enter full path for the ORSTX file

Refer to Figure 244 and Figure 245 for BLER and BER, respectively.

Figure 244 Command for BLER measurement on Command prompt window
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Figure 245 Command for BER measurement on Command prompt window

where,

1 - ErrorRatioAnalyzer

2 - BER or BLER, depending on what you are measuring

3 - Full paths to the SCP, PCAP, XML and ORSTX files (in any order) 
separated by a single space. Note that in the examples above, the 
complete folder location for each file is shown, such as C:\BLER\
UL_BLER.scp and so on.

If successful, the command prompt window displays the message 
Outputing results to <JSON file name>. 

In both cases, the measurement result is written to a file in JSON format. 
File name of this JSON is of the format (name of PCAP file + date + time).

The folder, where the SCP, PCAP, XML and ORSTX files are located, 
now shows the JSON file generated.
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Figure 246 Folder for BLER containing the final JSON file output
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Figure 247 Folder for BER containing the final JSON file output
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The JSON file structure contains:

Figure 248 JSON file contents

• Measurement type

• File name of recording

• Date and time when the measurement was finished

• Error ratio in percentage and frame number for each frame

The JSON file shown above is generated manually. 

For a better understanding of the JSON file would appear, consider the 
following image (Figure 249), which shows a sample JSON file 
generated through the automated process and has result for BER 
measurement with 4 frames in the recording.



264 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Figure 249 JSON file showing BER measurement results for 4 frames

Each frame has PN9 sequence with 11 bits altered.

The Bit Error Ratio (BER) is calculated as 11/511 ~ 2.15%.
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Section 3.8: Mixed Numerology Configuration

For handling mixed numerology, follow normal procedures to configure 
the overall carrier properties:

Figure 250 An example displaying the Mixed Numerology Configuration

To configure the overall carrier properties:

1 Use the “Selected Allocation” combo box to see the different 
numerologies.

2 In the “Numerology” tab, before generating IQ and Stimulus signals, 
make sure that you select the “Slot IDs relative to highest numerology 
in carrier FR” check box. The resource grids are intended to be used for 
IQ extraction and not for stimulus creation. 
You must make sure to select the check box with respect to stimulus 
creation for slot numbering based on highest numerology. 

1

2
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Section 3.9: Conformance to Stock Data Test Models

The Test Models feature enables the Open RAN Studio software to use 
predefined section mapping models. Some Radio Units only accept simple 
C-Plane messaging models. 

A prerequisite to performing Conformance tests in the U5040A Open RAN 
Studio is that the Downlink and Uplink carriers must have the following 
attributes:

• Downlink: 30 KHz subcarrier spacing and 100 MHz Bandwidth, Test 
Model NR-FR1-TM1.1.

• Uplink: 30 KHz subcarrier spacing, QPSK, 100 MHz Bandwidth, Test 
Model G-FR1-A1-5. Note that Stock Data Test Definition D only can be 
applied to Uplink data.

NOTE
While other configuration options may apply, the Beamforming 
methodology or approach is currently not applicable to stock data 
frames for conformance testing.
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 3.9.1: Applying Stock Data Test Definitions

For this “standard mode”, O-RAN Studio software builds sections 
according to Channels and Users. This standard mapping model is focused 
on the signal performance.

To verify whether or not the carrier conforms to the Stock Data Test 
Definitions,

1 Load an SCP file into the Open RAN Studio software.

Figure 251 Loading an SCP file for DL carrier

2 From the main menu, click Test Models > Conformance Tests: 
O-RAN.WG4.CONF.0-v01.00.

3 Click either of the Stock Data Test Definitions for conformance check. 
You shall notice the change in the “Radio Control Plane Data” and the 
“Radio Allocations” for each stock data test definition you select. 
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Optionally, you may also export the O-RAN stimulus file to load the 
PCAP file and view the changes in the Message Interpretation as well.

Selecting “Stock Data Test Definition A”

• This test frame consists of a PDCCH in the first two symbols of every 
slot consisting of 3 PRBs.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 1 Section per Symbol.

Figure 252 Appearance after test model pattern for Stock Data A is applied
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Selecting “Stock Data Test Definition B”

• This test frame consists of a PDCCH in the first two symbols of every 
slot consisting of 3 PRBs.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 2 Sections per Symbol.

Figure 253 Appearance after test model pattern for Stock Data B is applied
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Selecting “Stock Data Test Definition C”

• This test frame consists of a PDCCH in the first two symbols of every 
slot consisting of 3 PRBs.

• Symbol #6 and #7 should be defined with single section including 
gap. This is supported using feature non-contiguous PRB allocation. 
See Allocating non-contiguous PRBs on page 369 for more 
information. SymbolMask should be set to 00000011000000 and 
RBG mask to 101111111111111111 with RBGSize 16.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 1 Sections per Symbol.

Figure 254 Appearance after test model pattern for Stock Data C is applied
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Figure 255 Change in configuration settings after Stock Data C is applied

NOTE
Stock Data Frame C has dependency on the Non-contiguous PRB 
feature. Therefore, it enables the option “Use Extension Type 6” in the 
Options tab of the C/U-Plane Builder Configuration Tool.
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Selecting “Stock Data Test Definition D” (for DL carrier)

• This test frame consists of a PDCCH in the first two symbols of every 
slot consisting of 3 PRBs.

• The control plane message for symbol #3 will include PRBs number 
5 through 23. This C-Plane message will have the rb bit set to ‘one’ 
for this section.

• This test uses PRBs 1 through 5. The corresponding C-Plane 
message will contain a section ID in a single C-Plane message 
describing symbol #6. The C-Plane message will have one section 
with the reMask set to only the odd number resource elements. The 
start PRB will be ‘1’.

• Symbols #3 and #6 should also have single PRB section.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 1 Sections per Symbol.



Keysight U5040A Open RAN Studio User Guide 273

Configuring Features in the O-RAN Studio UI 3

 

Figure 256 Appearance after test model pattern for Stock Data D is applied (DL)

NOTE
Stock Data Frame D enables the options “Use reMask” and “Use RB 
indicator” in the Options tab of the C/U-Plane Builder Configuration Tool.
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Figure 257 Change in configuration settings after Stock Data D is applied
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Selecting “Stock Data Test Definition D” (for UL carrier)

Let us now consider the following SCP file data for an Uplink carrier to see 
how Radio Control Plane Data and Radio Allocations appear when Stock 
Data Test Definition D is applied.

Figure 258 Loading SCP file for UL carrier

• The C-Plane message for symbol #5 should have the reMask set to 
tell the radio to send only every odd resource element. The PRBs 1 
through 5 are used in this section.

• Symbol #5 should also have a single PRB section.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 1 Sections per Symbol.
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Figure 259 Appearance after test model pattern for Stock Data D is applied (UL)
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Selecting “Stock Data Test Definition E”

• This test frame consists of a PDCCH in the first two symbols of every 
slot consisting of 3 PRBs.

• Symbols #5 and #6 consist of Physical Downlink Shared Channel 
data with 2 Section per Symbol with SymInc bit set.

• The first section ID for symbol #6 will have the SymInc bit set 
informing the O-RU that the next section will begin describing 
symbol #6.

• The corresponding C-Plane message will contain 4 section IDs in a 
single C-Plane message describing Symbols #5 and #6.

• All the remaining PRBs in the frame consist of Physical Downlink 
Shared Channel data with 1 Section per Symbol.

Figure 260 Appearance after test model pattern for Stock Data E is applied
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Figure 261 Change in configuration settings after Stock Data E is applied

NOTE
Stock Data Frame E enables the option “Use symInc” in the Options tab 
of the C/U-Plane Builder Configuration Tool.

NOTE
For some of the Stock Data Test Definitions (C, D & E), the corresponding 
C/U Plane Builder Configuration Tool options are enabled automatically, 
which cannot be manually disabled. To restore such configuration 
options, you must reset the current allocation by clicking Test Models > 
Reset.
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 3.9.2: Applying Additional Test Patterns

The “Additional Test Patterns” lets you apply custom test models on 1 
C-Plane Section per entire slot and therefore, is a simplified signaling 
model. The Additional Test Patterns can be applied to arbitrary DL and UL 
SCP projects, but not on a PRACH SCP project.

1 Load an SCP file into the Open RAN Studio software.

Figure 262 Loading an SCP file for DL carrier

2 From the main menu, click Test Models > Additional Test Patterns.



280 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

3 Click either of the patterns available in the sub-menu. You shall notice 
the change in the “Radio Control Plane Data” and the “Radio 
Allocations” for each pattern you select. Optionally, you may also 
export the O-RAN stimulus file to load the PCAP file and view the 
changes in the Message Interpretation as well.
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Selecting “1 Section description per slot; all PRBs”

• All PRBs in the frame consist of data with 1 Section description per 
slot. This test pattern allocates full slot in case any radio allocation 
is present in that slot.

Figure 263 Appearance after first test pattern is applied



282 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Selecting “1 Section description per symbol; all PRBs”

• All PRBs in the frame consist of data with 1 Section description per 
symbol. This test pattern allocates full symbols in case any radio 
allocation is present on that symbol.

Figure 264 Appearance after second test pattern is applied
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Selecting “1 Section description per symbol; used PRBs and gaps”

• Similar to the second test pattern, except that the symbol only 
covers from minimum to maximum PRBs present in the radio 
allocations. Gaps in the middle are ignored. If the test pattern 
symbol allocation is larger than 255, the numPrbc parameter is set 
to zero (full height allocation).

Figure 265 Appearance after third test pattern is applied
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Section 3.10: Applying Compression Methods

The purpose of the Compression tab in the C/U Plane Builder 
Configuration Tool is to assign a compression mode to each eAxC ID 
independently for DL and UL U-Plane IQ data.

The “Compression Method” that appears in a drop-down list under the 
“Compression” tab of the C/U Plane Builder Configuration Tool, for DL and 
UL U-Plane IQ data, are shown in Figure 266 and Figure 267, respectively.

Figure 266 Compression method available for DL U-Plane IQ Data
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Figure 267 Compression method available for UL U-Plane IQ Data

You may select a value for the “IQ Bitwidth” from the drop-down options. 
Default value is ‘15’ for each compression method, except for the 
‘modulation compression’ method in DL U-Plane IQ data compression, 
where the “IQ Bitwidth” is set to ‘16’ and cannot be modified.

By default, the compression methods are dynamic. You may select the 
check box for “Static Compression” to remove the ‘udCompHdr’ parameter 
in the U-Plane messages.
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To understand how the various compression methods work, let us consider 
the following SCP project configuration shown in Figure 268 & Figure 269 
and the corresponding PCAP configuration to understand how the C-Plane 
and U-Plane messages appear in both the Downlink and Uplink carrier 
when “no compression” is applied.

Figure 268 SCP file for the DL carrier
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Figure 269 SCP file for the UL carrier
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 3.10.1: Selecting ‘no compression’

Figure 270 & Figure 271 show the C-Plane messages in the PCAP file 
configuration after you export and load O-RAN stimulus files for the DL 
and UL carrier, respectively, with the default compression method “no 
compression”.

Figure 270 PCAP file showing C-Plane messages (DL) with no compression applied
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Figure 271 PCAP file showing C-Plane messages (UL) with no compression applied

Figure 272 & Figure 273 show the U-Plane messages in the PCAP file 
configuration after you export and load O-RAN stimulus files for the DL 
and UL carrier, respectively, with the default compression method “no 
compression”.

Note that the Uplink carrier contains only C-Plane messages by default. To 
understand the effects of compression on U-Plane messages in the Uplink 
carrier, you can generate Uplink U-Plane messages using the Open RAN 
Studio software. See Creating U-Plane messages in Uplink Carrier on 
page 170 to understand how to Uplink U-Plane messages, prior to 
applying one of the compression methods. Figure 273 shows one such 
example.
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Figure 272 PCAP file showing U-Plane messages (DL) with no compression applied
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Figure 273 PCAP file showing U-Plane messages (UL) with no compression applied
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 3.10.2: Selecting ‘block floating point’

In the ‘block floating point’ compression method, each I and Q sample is 
defined by:

• 1 bit sign

• Multiple bits mantissa = non-zero value

• Multiple bits exponent = position to place the decimal point

Figure 274 I and Q sample definition for block floating point compression

The ‘block floating point’ method reduces number of bits per PRB by 
assigning a common exponent to a common block of ‘12’ I samples and 
‘12’ Q samples. This allows for reducing the amount of bits transmitted.

The common exponent is found by looking at the maximum value within 
the block and scaling to that value.

Figure 275 and Figure 276 show the C-Plane messages and U-Plane 
messages for the Downlink and Uplink carriers, respectively, after the 
block floating point compression method is applied.
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Figure 275 C-Plane and U-Plane messages (DL) with block floating point method



294 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Figure 276 C-Plane and U-Plane messages (UL) with block floating point method
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 3.10.3: Selecting ‘block scaling’

The ‘block scaling’ reduces number of bits per PRB by:

• Finding a common scaler for the block.

• Rescaling the samples to a lower bit width.

• Transmit the reduced PRB and the common scaler. 

This allows for reducing the amount of bits transmitted.

The common scaler is found by looking at the maximum value within the 
block and scaling to that value.

Figure 277 and Figure 278 show the C-Plane messages and U-Plane 
messages for the Downlink and Uplink carriers, respectively, after the 
block scaling compression method is applied.
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Figure 277 C-Plane and U-Plane messages (DL) with block scaling method
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Figure 278 C-Plane and U-Plane messages (UL) with block scaling method
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 3.10.4: Selecting ‘µ-law’

The ‘µ-law’ compression method reduces number of bits per I and Q 
sample by re-quantizing the word to a lower bit width. The μ-law 
quantization is a non-linear function with finer quantization levels for small 
values while coarser quantization levels are for larger values. 

This allows for reducing the amount of bits transmitted.

The common scaler is found by looking at the maximum value within the 
block and scaling to that value.

Figure 279 and Figure 280 show the C-Plane messages and U-Plane 
messages for the Downlink and Uplink carriers, respectively, after the 
µ-law compression method is applied.
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Figure 279 C-Plane and U-Plane messages (DL) with µ-law method
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Figure 280 C-Plane and U-Plane messages (UL) with µ-law method
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 3.10.5: Selecting ‘modulation compression’

The ‘modulation compression’ method reduces the number of bits used to 
represent IQ samples (that is, 16 bits for I and 16 bits for Q for any 
modulation order) to just the number of bits needed to represent the 
constellation (that is, 2 bits for I and 2 bits for Q in 16QAM, and so on).

The whole User data is compressed but not in blocks of 12 PRBs.

There is a “shift” in the modulation, so all possible modulations can 
overlap, if needed. There are a couple of parameters sent via Type 4 or 
Type 5 C-plane messages to know about type of modulation and “shifting”.

Figure 281 shows the C-Plane messages and U-Plane messages for the 
Downlink carrier only, after the modulation compression method is 
applied.
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Figure 281 C-Plane and U-Plane messages (DL) with modulation compression
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Section 3.11: Understanding Configuration of Beam / Ue IDs

This section explains the appropriate ways to configure Beam / Ue IDs and 
assign them to the selected Radio Allocations. We shall also understand 
the structure of the Beamforming Weights files compatible with the 
U5040A Open RAN Studio software.

 3.11.1: Setting Beam IDs / Ue IDs for Radio Allocations

To understand Beam/Ue ID assignments, a simple DL SCP file, with 
PDSCH and SS/PBCH Channels, has been used for illustration.

1 Load the SCP file into the Open RAN Studio software.

Figure 282 Loading an SCP file for DL carrier with two Channels
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By default, the C-Plane Builder tab displays “Beam IDs” area, where the 
‘Select BeamId’ drop-down field shows a single value ‘0’, which is also 
reflect in the last column of the Radio Control Plane Data to the right. The 
value ‘0’ indicates “no beamforming” and can be manually assigned to one 
or more radio allocations.

Figure 283 Default view of the Beamforming tab

2 From the “Beamforming Method” drop-down, select the required 
beamforming method. Refer to Beamforming on page 77 for 
description of each method.

If you select the “Beamforming Method” as 
‘channel-information-based beamforming’ and exit the C/U Plane 
Builder Configuration Tool, the C-Plane Builder tab displays the “Ue 
ID” instead of the “Beam ID”, as shown in Figure 284, where the default 
value in the “Select Ue ID” drop-down field is ‘Reset’. See Applying 
Channel-information-based beamforming on page 341 for more 
details about how this beamforming method works.



Keysight U5040A Open RAN Studio User Guide 305

Configuring Features in the O-RAN Studio UI 3

 

Figure 284 Default view with Ue ID for channel-information-based beamforming

3 Increment the “Size of beam mapping table” counter to add one or 
more rows to the Table Index.

4 Click the red X button to the right to remove a row from the Table 
Index. The row, which is at the bottom of the Table Index, is deleted 
each time you click the X button.

Note that deleting a Table Index row corresponding to a Beam ID 
simultaneously deletes the same row corresponding to the Ue ID. 
Deleting the last remaining Table Index row automatically resets the 
Beam / Ue IDs to default, as shown in Figure 282 and Figure 284.
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Figure 285 Adding rows to Table Index

The Table Index is added simultaneously across all tabs (irrespective of 
the beamforming method selected). By default, the Beam ID is 
assigned the same serial numbering as the Table Index starting from 1. 
However, the ueID under “Beam Channel Information” starts from 0.

Figure 286 Default assignment of ueId values
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5 To modify the value of a Beam ID (under Beam IDs tab) or a Ue ID 
(under Beam Channel Information tab), double-click the entry and type 
a new value, as shown in Figure 287.

Figure 287 Changing values for Beam / Ue IDs

NOTE
You cannot access both Beam ID and Ue ID simultaneously for 
modification. However, adding / removing a Table Index row for the 
Beam ID simultaneously adds / removes the Table Index row for the Ue 
ID and vice-versa. 
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Following images display the Beam Id / Ue ID default values in the C-Plane 
Builder tab after you exit the C/U Plane Builder Configuration Tool.

• For all beamforming methods except channel-information-based 
beamforming

Figure 288 Beam ID displayed for various beamforming methods
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• For channel-information-based beamforming method only

Figure 289 Ue ID values displayed for channel-information based beamforming

The U5040A Open RAN Studio software returns certain warning / error 
prompts, in case the Beamforming data is not configured appropriately in 
the C/U Plane Builder Configuration Tool.

For example,

a Setting Beam Id value to ‘0’ for an allocation is allowed in the 
C-Plane Builder tab, but not in the C/U Plane Builder Configuration 
Tool. If you attempt to set a Beam ID value to ‘0’ for a Table Index 
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row, a warning is prompted, as shown in Figure 290, and the Beam 
ID value reverts to the previous value, when you close the warning 
dialog box.

Figure 290 Warning prompt when Beam ID value is set to ‘0’

b Entering an existing Beam Id value in another row is forbidden in the 
C/U Plane Builder Configuration Tool. If you attempt to do so, a 
warning is prompted, as shown in Figure 291, and the Beam ID 
value reverts to the previous value, when you close the warning 
dialog box.
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Figure 291 Warning prompt when existing Beam ID value is entered

c Similarly, entering an existing Ue Id value in another row is 
forbidden in the C/U Plane Builder Configuration Tool. If you 
attempt to do so, a warning is prompted, as shown in Figure 292, 
and the Ue ID value reverts to the previous value, when you close 
the warning dialog box.
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Figure 292 Warning prompt when existing Ue ID value is entered

d After you assign Beam ID values to specific Radio allocations, 
changing that value in the C/U Plane Builder Configuration Tool 
updates it in the Radio Control Plane Data for all allocations, as 
shown in Figure 293 and Figure 294.
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Figure 293 Changing Beam ID value already assigned to an allocation
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Figure 294 Updated Beam ID values displayed in the Radio Control Plane Data

e Similar to Beam IDs, the Ue ID values undergo the same kind of 
update for the allocations, as shown in Figure 295 and Figure 296.
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Figure 295 Changing Ue ID value already assigned to an allocation
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Figure 296 Updated Ue ID values displayed in the Radio Control Plane Data

f After you assign a specific Beam ID value to one or more Radio 
allocations, removing the Table Index row in the C/U Plane Builder 
Configuration Tool resets the Beam ID value to ‘0’ (default) in the 
Radio Control Plane Data for the corresponding allocations, as 
shown in Figure 297 and Figure 298.
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Figure 297 Removing Table Index row having Beam ID value assigned to an allocation
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Figure 298 Default Beam ID updated in the Radio Control Plane Data

g Similar to Beam IDs, removing the Table Index row in the C/U Plane 
Builder Configuration Tool resets the Ue ID value to ‘Reset’ (default) 
in the Select UeId drop-down field for the corresponding 
allocations, as shown in Figure 299 and Figure 300.
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Figure 299 Removing Table Index row having Ue ID value assigned to an allocation
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Figure 300 Updated Ue ID values displayed in the Radio Control Plane Data
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 3.11.2: Loading Beamforming Weights as File

Beginning with version 1.3 of the U5040A Open RAN Studio software, you 
may load Beam weights from a file. Weights file is determined separately 
for each Beam ID. Therefore, based on the number of Table Index rows, 
you must load the corresponding Weights file for each Beam ID. 

Figure 301 shows part of the structure from an Excel file containing the 
Beam Weights data. The format of the file containing Beam Weights data 
is CSV.

Figure 301 CSV file showing structure of Beam Weights data

1 Launch the C/U Plane Builder Configuration Tool.

2 Click the “Beamforming” tab.

3 In the Beamforming Mappings area, click the “Beam Weights” tab.

Notice, in Figure 302, that the “Beam Weights” column displays the 
value ‘0 0’, by default, for each row. This is a read-only field that 
displays the data from the Beam Weights file, after it is loaded. 

NOTE
Channel-information-based beamforming does not require loading Beam 
Weights.
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Figure 302 Accessing the Beam Weights tab in Beamforming

4 Click “Open”.

The ‘Open’ dialog box appears.

Figure 303 Loading Beam Weights file
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5 Select the Beam Weights file from your local disk and click “Open”.

The contents of the Beam Weights file are displayed in the “Beam 
Weights” column for the corresponding row. The file name is displayed 
in the Weights File Path field.

6 Repeat the previous two steps to add Beam Weights file to rest of the 
Table Index rows for each Beam ID.

Figure 304 Beam Weights data displayed after file is loaded

7 Hereafter, you may select a Compression Method and BitWidth, as 
required, prior to making other configuration changes.
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The U5040A Open RAN Studio software returns certain error prompts, if 
there are issues with the Beam Weights file.

a if selected CSV file is not located in the same directory or 
subdirectory as the ORSTX file.

Figure 305 Error when loading CSV file from a directory different than ORSTX file
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b if the data for weights in the file is out of range.

Figure 306 Error when loading CSV file with out of range data



326 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

c if the format of file or data in the file is incorrect.

Figure 307 Error when loading CSV file that has incorrect data
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d if you load an empty CSV file.

Figure 308 Error when loading CSV file that is empty



328 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

 3.11.3: Specifying Beam ID for SS/PBCH occurrences

The way to specify Beam / Ue IDs for SS/PBCH allocations in the U5040A 
Open RAN Studio is different than the rest of the allocations.

When you perform a Channel Setup in the PathWave Signal Generation 
Desktop 2022 software for the Downlink carrier, the SS/PBCH Channel 
occurrences can be specified using:

• SS block pattern

• Periodicity

• Lmax

• Active indices

Figure 309 Specific PathWave Signal Generation settings for SS/PBCH

1 Load the SCP file, including the SS/PBCH Channel, into the Open RAN 
Studio software.

2 Configure one or more Beam / Ue ID values, as shown in the previous 
sections.

3 In the C-Plane Builder tab of the Open RAN Studio software, select 
“SS/PBCH” from the ‘Select Allocation’ drop-down field.

Notice how the appearance of the GUI changes, where a button 
displayed to “Set BeamID for SS/PBCH” (or “Set UeID for SS/PBCH” in 
case of channel-information-based beamforming). Also, by default, as 
shown in Figure 310, the Beam Id is set to ‘0’ (or blank, in case of Ue 
IDs).
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Figure 310 Button to Set Beam / Ue ID for SS/PBCH

4 Click the “Set BeamID for SS/PBCH” button.

A pop-up dialog box “SS/PBCH Beam/Ue Id Assignment” appears, as 
shown in Figure 311, with Burst Index and BeamId (or, UeId) columns, 
where the Burst Index corresponds to the “Active Indices” set for 
SS/PBCH.



330 Keysight U5040A Open RAN Studio User Guide

3 Configuring Features in the O-RAN Studio UI
 

Figure 311 SS/PBCH Beam/Ue Id Assignment pop-up dialog box

5 Double click the field in the “BeamId” column to modify the values.

NOTE
For the SS/PBSCH, you can set one or more of those BeamId (or, UeId) 
values only, which you have configured for the other Allocations. The 
software returns an error, if you attempt to set a value different than 
what has been already configured in the Beamforming tab of the C/U 
Plane Builder Configuration Tool.
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6 Close the “SS/PBCH Beam/Ue Id Assignment” dialog box.

Notice that the Beam Id (or, Ue Id) for SS/PBCH is configured in the 
same order as you perform the assignment.

Figure 312 SS/PBCH Beam/Ue Id Assignment pop-up dialog box
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 3.11.4: Configuring Flexible Weight Based Dynamic Beamforming

The application of flexible sending of beamforming weights from the O-DU 
to the O-RU enables the O-DU to provide different beamforming weights 
for different PRBs within one section, which facilitates zero-forcing 
precoding. In the Open RAN studio software, this feature provides you the 
flexibility to configure BF weights on the granularity of individual RBs in a 
section.

The contents of the Weights file required for Flexible Weights based 
dynamic beamforming method in the example shown in Figure 313. Note 
that the format of this file is CSV.

Figure 313 Contents of the Beam Weights file for Flexible Weights beamforming

The Weights file for Flexible Weights based dynamic beamforming method 
consists of the following fields:

• numBundPrb (1-255) – number of bundled PRBs.

• BeamID (1-32767) – bundle beam identifier. Current field indicates 
start of its bundle.

• Number of BeamIDs should be greater than or equal to the number of 
bundles, calculated using the formula:

realNumBundle = Ceiling(numPrbs in section / numBundPrb)

• <bfwI>; <bfwQ> - beamforming weights values. Number of “<bfwI>; 
<bfwQ>” is equal to the number of TRXs.

Note that the parameters are defined using separators, which can be 
either colon (:) or semi-colon (;).
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In case you use incorrect values as input in the file, the Open RAN Studio 
software may return either an error or warning prompt, as shown in 
Figure 314.

• The error may appear for the following unsupported / incorrect 
configuration:

• Number of PRBs in section is less than the number bundled PRBs

• Number of Bundles is greater than the number of beam IDs defined 
in the file

• Splitting of PRB bundles is not supported

• Number of bundled PRBs is greater than 255

• Beamforming weights differ for layers when applied together with 
Extension Type 10

• The warning may appear for the following configuration:

• Number of Bundles is less than the number of beam IDs defined in 
the file

• Non-contiguous configuration (Extension Type 6) enabled

Figure 314 Error/Warning displayed for unsupported/incorrect configuration
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To understand how to use the Flexible weight-based dynamic 
beamforming method,

1 Load an SCP file with number of PRBs in section = 273.

By default, no beamforming (BeamId = 0) has been set for the 
allocation.

2 Assign a Flow/eAxc ID to the carrier.

Figure 315 SCP file with number of PRBs in section = 273

3 Export the O-RAN Stimulus file, without making any changes to the 
C/U Plane Builder Configuration Tool.
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4 Switch to the Explorer tab and load the PCAP file.

The Message Interpretation shows that C-Plane Section Type 1 
messages are included.

Figure 316 Corresponding PCAP file with C-Plane Section Type 1 messages

5 Launch the C/U Plane Builder Configuration Tool.

6 Click the ‘Beamforming’ tab.

7 From the ‘Beamforming Method’ drop-down options, select “flexible 
weight-based dynamic beamforming”.
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Figure 317 Flexible Weight based dynamic beamforming configuration option

8 Define the “Size of the beam mapping table”. 

9 In the Beam IDs tab, for each row that you add to the Table Index, you 
may optionally modify the value of the Beam ID. See Setting Beam IDs 
/ Ue IDs for Radio Allocations on page 303 to know how to 
add/remove rows to Table Index and modify corresponding Beam ID 
values.

10 Click the “Flexible Weights” tab.

Note that the “Beam IDs” column under ‘Flexible Weights’ displays the 
value you set under the Beam IDs tab. Assign Beam IDs for proper 
allocation. For each Beam ID, the corresponding elements are 
displayed under each column.

• Weights File Path—Displays the file name/path of the loaded Beam 
Weights file.

• Load Weights—Click “Open” to navigate to the directory, where the 
Beam Weights file (in CSV format) is located. See Figure 318.

• Compression—Select a compression method from the drop-down 
options. By default, “no compression” is selected.

• Bitwidth—select a value between 1 and 16. Default is 15.

• Disable BFWs—Enable/disable BF weights. By default, ‘0’ is 
selected, which indicates that Beamforming weights are enabled.
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• RAD—Resets after PRB discontinuity. Applied when you select the 
configuration option Extension Type6 only. By default, ‘1’ is selected 
indicating that this setting is enabled.

11 From the ‘Open’ dialog box, select the required file and click ‘Open’, as 
shown in Figure 318.

Figure 318 Opening the Weights file for the Flexible beamforming method

Notice that, in Figure 319, the FlexW_4bund.csv file is displayed under 
the “Weights File Path”, ‘block scaling’ is selected as the 
“Compression” method, rest of the columns are left as default.
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Figure 319 Configuration changes made to the Flexible Weights tab

12 Exit the “C/U Plane Builder Configuration Tool”.

13 In the C-Plane Builder tab, assign Beam Id to the Radio Allocations, as 
shown in Figure 320.
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Figure 320 Assigning BeamId to the Radio Allocations

14 Regenerate the O-RAN Stimulus file.

15 Switch to the Explorer tab and load the regenerated PCAP file.

The Extension to Flexible Beamforming Weights is added to the 
C-Plane Section Type 1 messages.
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Figure 321 Flexible Beamforming Weights Extension applied to C-Plane messages
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 3.11.5: Applying Channel-information-based beamforming

The Open RAN Studio software now lets you apply Channel-information 
based beamforming on the Section Type 1 C-Plane messages.

1 Load an SCP file that has one or more Channel allocations, into the 
Open RAN Studio software.

2 Assign a Flow/eAxC ID to the carrier.

Figure 322 Loading an SCP file for DL carrier with multiple Channels

3 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file. See Exporting O-RAN Stimulus File on page 122 for more 
information.
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4 Switch to the Explorer tab and load the stimulus / recording PCAP file 
into O-RAN Studio.

Figure 323 PCAP file showing C-Plane Section Type 1 messages

Notice in the image above that the C-Plane messages appear as 
Section Type 1 messages.
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If you want to include Section Type 6 messages when applying 
channel-information-based beamforming, you require a CI IQ sample 
file, which contains channel information I and Q values, related to 
Section Type 6 and relayed from O-DU to O-RU. Figure 324 shows the 
structure of this text file.

Figure 324 CI IQ Sample text file contents

• File consists of antennas along with associated numbers and IQ 
pairs, that is, line of antenna’s number that is followed by IQ pairs.

• Each antenna should have the same number of IQ pairs.

• Each IQ pair maps to one PRB in Section Type 6.

5 Launch the “C/U-Plane Builder Configuration Tool” window.

6 In the Beamforming tab,

a From the ‘Beamforming Method’ drop-down options, select 
“channel-information-based beamforming”.

b Set the number of ‘Table Index’ rows in the “Size of beam mapping 
table”.

c Under ‘Beamforming Mappings’, click ‘Beam Channel Information’. 
For each ‘Table Index’ row, configure the following parameters:

• Regularization Factor—related to Section Type 6, supports 
MMSE operation within O-RU, when beamforming weights are 
supported. Default value is ‘0’. Double-click to edit the field.

• ueId—label that supports channel information that is sent from 
the O-DU to the O-RU. Default first value is ‘0’. Double-click to 
edit the field.

• File Path—displays the name of the CI IQ sample text file. If you 
leave this empty, the data is not sent in Section Type 6.

• Load—Click ‘Open’ to select the CI IQ sample text file from the 
local disk.

d Set a bit width for the CI IQ data.
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Figure 325 Appearance of tab after loading CI IQ sample file

7 Close the “C/U-Plane Builder Configuration Tool” window.

8 Export the O-RAN Stimulus file for the selected options to be applied.

9 In the C-Plane Builder tab, load the updated SCP file.
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Figure 326 Updated SCP file showing UeId instead of BeamID

Notice that upon choosing Beamforming method as 
“channel-information-based beamforming”, BeamID is replaced with 
‘UeID’, as highlighted in Figure 326.

10 For the Channel name you select from the “Select Allocation” 
drop-down options, select an UeId from the “Select UeId” drop-down 
options. The value ‘Reset’ indicates that no ueID has been assigned to 
that specific Channel.

The table in the ‘Radio Control Plane Data’ is updated as you set a ueID 
for the selected Channel.

11 Switch to the Explorer tab and load the corresponding PCAP file.
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Figure 327 Updated PCAP file showing Section Type 5 messages

Figure 327 shows that data is sent as C-Plane Section Type 5 
messages (instead of Section Type 1) after channel-information based 
beamforming is applied. The O-DU sends UE scheduling information 
on a slot-by-slot basis. However, note that Section Type 5 does not 
replace Section Type 3, if the latter is sent.
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Figure 328 shows that Section Type 6 C-Plane messages are included 
and these are sent on each slot 0, symbol 0. In this case, UE channel 
information is sent generally less often than every slot. As mentioned 
earlier, each IQ pair maps per PRB in Section Type 6, as highlighted in 
the Message Interpretation area. When the row in the table is setup, 
but ueId is not assigned to any allocation, Section Type 6 shall still 
send information setup in that row. If included, each Section Type 6 
contains the same CI IQ data. If the CI IQ data is not sent, that is, if you 
do not load a CI IQ sample text file, data is not sent in Section Type 6.

Figure 328 Section Type 6 messages included with IQ sample data

12 Launch the “C/U-Plane Builder Configuration Tool” window again.
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13 In the Beamforming tab,

a With ‘Beamforming Method’ selected as 
“channel-information-based beamforming”, click the ‘Beam 
Channel Information’ tab.

b Select the check box for “Add Ext Type 8 to Section Type 5”.

Figure 329 PCAP file showing C-Plane Section Type 1 messages

14 Close the “C/U-Plane Builder Configuration Tool” window.

15 Export the O-RAN Stimulus file for the selected options to be applied.

16 Load the PCAP file again to view the changes.
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Figure 330 Extension Type 8 messages included with Section Type 5

Note that because of adding Extension Type 8 to Section Type 5, 
Section Type 6 is not sent. Also, the Message Interpretation area 
displays the Extension Type 8 as well as Regularization Factor is added 
as an extension.

For more information about ueID, regularization factor and CI IQ data, refer 
to Section 5.4.5.10, 5.4.5.12 and 5.4.5.13, respectively in the O-RAN 
specification.
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Section 3.12: Configuring C-Plane Section Handling Options

To understand how the various options impact the C-Plane data, the 
reference signal comprises of a single “RF Transport Block” user data, 
where PDSCH allocation is 64QAM. This signal consists of 1PRB by 14 
OFDM symbols, punctured with PDSCH DMRS and PT-RS reference 
signals (both QPSK).

 3.12.1: Generating PCAP without compression or C-Plane options

1 Load the SCP file with the attributes described above, into the Open 
RAN Studio software.

2 Assign a Flow/eAxC ID to the carrier.

Figure 331 Loading the SCP file with 64QAM PDSCH allocations
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3 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file without using any compression of C-Plane Section Handling 
options.

4 Load the stimulus / recording PCAP file into O-RAN Studio software.

Figure 332 PCAP file contents without compression and C-Plane options

As highlighted in Figure 332, the resulting PCAP file contains only a 
single C-Plane message with a single Section description.

The following sections describe the effects of applying one or more 
C-Plane Handling Options along with Compression.
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 3.12.2: Using reMask only

1 Launch the “C/U-Plane Builder Configuration Tool” window.

2 In the ‘C-Plane Section Handling’ area of the ‘Options’ tab, select the 
“Use reMask” check box.

Figure 333 Applying ‘Use reMask’ to the signal

3 Close the “C/U-Plane Builder Configuration Tool” window.

4 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

5 Load the stimulus / recording PCAP file into O-RAN Studio software.
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Figure 334 PCAP file contents with reMask applied

As highlighted in Figure 334, applying reMask creates:

• 12 Section descriptions

• Section IDs 0, 2, 4 and 6 are reused twice with different masks

• 8 C-Plane messages, Section descriptions refer to different starting 
symbols
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 3.12.3: Using reMask with symInc

1 Launch the “C/U-Plane Builder Configuration Tool” window.

2 In the ‘C-Plane Section Handling’ area of the ‘Options’ tab, select the 
“Use reMask” (if not already selected) and “Use symInc” check boxes.

Figure 335 Applying ‘Use reMask’ and ‘Use symInc’ to the signal

3 Close the “C/U-Plane Builder Configuration Tool” window.

4 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

5 Load the stimulus / recording PCAP file into O-RAN Studio software.
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Figure 336 PCAP file contents with reMask and symInc applied

As highlighted in Figure 336, applying reMask and symInc, 
simultaneously, creates:

• 12 Section descriptions

• Section IDs 0, 2, 4 and 6 are reused twice with different masks

• 1 C-Plane message, Section descriptions refer to first OFDM symbol 
in Transport Block
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 3.12.4: Using Modulation Compression only

1 Launch the “C/U-Plane Builder Configuration Tool” window.

2 In the ‘DL U-Plane IQ Data Compression’ area of the ‘Compression’ tab, 
set ‘Compression Method’ as “modulation compression”.

Figure 337 Applying ‘Modulation Compression’ to the signal

3 Clear the check boxes for the C-Plane Handling Options “use reMask” 
and “use symInc”, if already selected in the ‘Options’ tab.

4 Close the “C/U-Plane Builder Configuration Tool” window.

5 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

6 Load the stimulus / recording PCAP file into O-RAN Studio software.
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Figure 338 PCAP file contents with Ext Type 5 for even-numbered Section IDs

As highlighted in Figure 338, applying modulation compression on its 
own creates:

• 8 Section descriptions, 8 C-Plane messages

• Section IDs 0, 2, 4 and 6 require 2 scalers; therefore, they need 
Extension Type 5
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Figure 339 PCAP file contents with Ext Type 4 for odd-numbered Section IDs

As highlighted in Figure 339, applying modulation compression on its 
own creates:

• 8 Section descriptions, 8 C-Plane messages

• Section IDs 1, 3, 4 and 5 require a single scaler; therefore, only need 
Extension Type 4
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 3.12.5: Using reMask with Modulation Compression

1 Launch the “C/U-Plane Builder Configuration Tool” window.

2 In the ‘C-Plane Section Handling’ area of the ‘Options’ tab, select the 
“Use reMask” check box. Make sure other options are cleared.

3 In the ‘DL U-Plane IQ Data Compression’ area of the ‘Compression’ tab, 
set ‘Compression Method’ as “modulation compression”.

Figure 340 Applying ‘Use reMask’ and ‘Modulation Compression’ to the signal
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4 Close the “C/U-Plane Builder Configuration Tool” window.

5 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

6 Load the stimulus / recording PCAP file into O-RAN Studio software.

Figure 341 PCAP file contents with reMask and Modulation Compression applied

As highlighted in Figure 341, applying reMask and modulation 
compression, simultaneously, creates:

• 8 Section descriptions, 8 C-Plane messages

• Section IDs 0, 2, 4 and 6 are reused twice with different masks

• Triggers the use of Extension Type 4 only; Type 5 is made redundant 
due to the use of reMask
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 3.12.6: Using reMask with symInc and Modulation Compression

1 Launch the “C/U-Plane Builder Configuration Tool” window.

2 In the ‘C-Plane Section Handling’ area of the ‘Options’ tab, select the 
“Use reMask” and “Use symInc” check boxes.

3 In the ‘DL U-Plane IQ Data Compression’ area of the ‘Compression’ tab, 
set ‘Compression Method’ as “modulation compression”.

Figure 342 Applying ‘Use reMask’, ‘Use symInc’ and ‘Modulation Compression’

4 Close the “C/U-Plane Builder Configuration Tool” window.
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5 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

6 Load the stimulus / recording PCAP file into O-RAN Studio software.

Figure 343 PCAP file with reMask, symInc & Modulation Compression applied

As highlighted in Figure 341, applying reMask, symInc and modulation 
compression, simultaneously, creates:

• 8 Section descriptions, 1 C-Plane message

• Section IDs 0, 2, 4 and 6 are reused twice with different masks

• Triggers the use of Extension Type 4 only; Type 5 is made redundant 
due to the use of reMask
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 3.12.7: Using RB Indicator

The “RB Indicator” enables only the even-numbered PRB slots in the 
U-Plane messages of the CSI-RS signal. Currently, the option “RB 
Indicator” in U5040A Open RAN Studio supports the CSI-RS format of the 
Downlink carrier only.

To understand how this option works, let us generate an SCP file in 
PathWave Signal Generation Desktop 2022 software for the DL carrier 
with CSI-RS format and Density as ‘0.5’.

Figure 344 Generating DL SCP file with CSI-RS format

1 Load the SCP file, with the CSI-RS format, into the Open RAN Studio 
software.

2 Assign a Flow/eAxC ID to the carrier.
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Figure 345 Loading the SCP file with CSI-RS format

3 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

4 Load the stimulus / recording PCAP file into O-RAN Studio software.
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Figure 346 Loading the PCAP file with CSI-RS format

As highlighted in Figure 346, there is 1 C-Plane message and 2 
U-Plane messages from PRBs 0 to 198 and PRBs 199 to 254. The 
“RB:0” indicates that RB Indicator is disabled in the C-Plane 
messages.

5 Launch the “C/U-Plane Builder Configuration Tool” window.

6 In the ‘C-Plane Section Handling’ area of the ‘Options’ tab, select the 
“Use RB Indicator” check box.
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Figure 347 Applying ‘Use RB Indicator’ to the signal

7 Close the “C/U-Plane Builder Configuration Tool” window.

8 Export the O-RAN Stimulus file to generate the corresponding PCAP 
file.

9 Load the stimulus / recording PCAP file into O-RAN Studio software.
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Figure 348 C-Plane messages after RB Indicator is enabled

Notice in Figure 348 that the C-Plane messages show “RB:1”, which 
indicates that RB Indicator has been enabled on the user payload.
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Figure 349 U-Plane messages after RB Indicator is enabled

Notice in Figure 349 that U-Plane messages now include only 
even-numbered PRBs. Also, no compression has been applied to this 
signal. You may configure any of the compression methods for DL 
U-Plane data, which is applied to the U-Plane messages along with 
the configured IQ bitwidth and the ‘UdComParam’ parameter.
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 3.12.8: Allocating non-contiguous PRBs

The Extension Type 6 enables allocation of non-contiguous sets of PRBs 
(Resource Block Groups [RBGs]) in frequency and time domain, which 
reduces significantly the C-Plane overhead.

To understand how this Section Extension works, consider the following 
“Resource Allocations” configuration in the PathWave Signal Generation 
Desktop 2022 interface to generate the SCP file.

• RA Type — Type 0

• RBGBitmap — random 0 bits included
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1 Load the SCP file into the Open RAN Studio software.

Figure 350 Loading SCP file with non-contiguous PRB data
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2 Export the O-RAN stimulus file.

3 Switch to Explorer tab and load the generated PCAP file.

The Message Interpretation area shows three separate ‘Section Type1’ 
C-Plane messages for each slot.

Figure 351 Viewing PCAP file contents in Explorer tab

4 Open the “C/U-Plane Builder Configuration Tool” window.

5 In the ‘Options’ tab, under ‘C-Plane Section Handling’, select the “Use 
Extension Type 6” check box.
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Figure 352 Applying Extension Type 6 configuration option

6 Exit the “C/U-Plane Builder Configuration Tool” window.
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7 Switch to the C-Plane Builder tab to view the merged sections when 
Extension Type 6 is applied. Note that RB Number in the “Radio 
Control Plane Data” table is calculated as total number of RBs in the 
non-contiguous section, not including gaps.

Figure 353 Viewing SCP file contents after Ext. Type 6 is applied

8 Export the O-RAN Stimulus file again.

9 Load the updated PCAP file into the Explorer tab.

NOTE
Masks in the SCP and PCAP files are reversed. Mask bit order in the PCAP 
file follows the O-RAN CUS specification.
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Figure 354 Viewing updated PCAP file contents with Ext. Type 6 applied

The Message Interpretation area shows a single ‘Section Type1’ 
C-Plane message along with an additional Non-contiguous PRB 
Allocation Ext., which has the following elements:

• RbgSize— no. of PRBs of the resource block groups allocated 
by the bit mask

• RbgMask—a bit mask where each bit indicates whether a 
corresponding resource block group is allocated.

• SymbolMask—a bit mask where each bit indicates whether the 
rbgMask applies to a given symbol in the slot.
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Interaction of reMask with Ext Type 6 on DL carrier

1 Load an SCP file with Downlink carrier, which has DM-RS and PT-RS 
settings enabled.

Figure 355 Loading DL SCP file with DM-RS and PT-RS settings

The following illustrations describe the impact of various configuration 
options, as enabled / disabled in the “C/U Plane Builder Configuration 
Tool” window.
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Configuration 1: Only “Use reMask” enabled

When only ‘Use reMask’ feature is enabled but ‘Use Extension Type 6’ is 
disabled, the C-Plane Builder tab shows that C-Plane section handling is 
applied with simple contiguous sections. 

• DM-RS is divided into contiguous sections.

• PT-RS is divided into set of contiguous sections.

Figure 356 Usual contiguous sections used for DM-RS in SCP file
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The Message Interpretation area shows reversed masks in the 
generated PCAP file.

Figure 357 Masks are reversed when reMask only is used

Configuration 2: Both “Use reMask” and “Use Extension Type 6” enabled

When both ‘Use reMask’ feature and ‘Use Extension Type 6’ are enabled, 
the C-Plane Builder tab shows that C-Plane section handling is applied 
with non-contiguous sections for PDSCH and DM-RS parts. 

• PT-RS is still divided into set of contiguous sections.
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Figure 358 Non-contiguous sections are used for DM-RS and PDSCH in SCP file

The Message Interpretation area shows DM-RS section as two 
non-contiguous sections with same position and non-contiguous 
parameters, but with reversed ReMask bitmaps.
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Figure 359 Non-contiguous DM-RS sections with reversed masks
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Interaction of Ext Type 6 with DM-RS outside of allocation

1 Load an SCP file with Downlink carrier, which has DM-RS settings 
enabled, but has been placed outside of allocation. For example, the 
DM-RS could be configured on symbol 2 and the starting symbol of 
PDSCH allocation could be set to 5.

Figure 360 Loading DL SCP file with DM-RS settings outside of allocation

The following illustration shows that if the you enable the “Use 
Extension Type 6”, the Message Interpretation area of the regenerated 
PCAP file contains new allocation, which is merged into similar 
non-contiguous section. Therefore, by enabling Extension Type 6 for 
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this DM-RS allocation, non-contiguous section is used for the added 
section and new SymbolMask is generated during PCAP creation, as 
shown in Figure 361.

Figure 361 Non-contiguous section used and new SymbolMask generated
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Interaction of reMask with Ext Type 6 on UL carrier

1 Load an SCP file with Uplink carrier, which has DM-RS and PT-RS 
settings enabled.

Figure 362 Loading UL SCP file with DM-RS and PT-RS settings

When both ‘Use reMask’ feature and ‘Use Extension Type 6’ are enabled, 
the C-Plane Builder tab shows that C-Plane section handling is applied 
with non-contiguous sections for PUSCH and DM-RS parts. 

• PT-RS is still divided into set of contiguous sections.
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Figure 363 Non-contiguous sections are used for DM-RS and PUSCH in SCP file

The Message Interpretation area shows DM-RS section as two 
non-contiguous sections with same position and non-contiguous 
parameters, but with reversed ReMask bitmaps.
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Figure 364 Non-contiguous PRB Allocation Extensions in DM-RS sections

As shown above, both DMRS sections have Non-contiguous PRB 
Allocation Extension with the respective parameters.

For more information about Extension Type 6, refer to Section 5.4.7.6 in 
the O-RAN specification.
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 3.12.9: Group configuration of multiple ports

The Open RAN Studio allows group configuration of section extension on 
Multi-Input-Multi-Output (MIMO) files, which have one carrier with at least 
two antennas. For the purpose of understanding, an SCP file for the DL 
carrier with four antennas has been used in this example.

1 Load the MIMO SCP file into O-RAN Studio software.

Figure 365 Loading MIMO SCP file
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2 If you see only one entry in the Flow/eAxC ID drop-down under the 
C-Plane Builder tab, open “C/U-Plane Builder Configuration Tool” 
window to add more Flow/eAxC IDs to the respective carrier.

Figure 366 Adding Frame/eAxC IDs to match with no. of antennas

3 At this stage, if you exit the “C/U Plane Builder Configuration Tool” and 
generate the Stimulus file, the PCAP file contents loaded in the 
Explorer tab are displayed in Figure 367. 
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Figure 367 Viewing PCAP file without Ext Type 10 and Beam / Ue ID

In this stimulus:

• the U-Plane, C-Plane Messages area displays the C-Plane 
messages for each antenna

• the C Plane area displays the Flow/eAxC assigned to each 
antenna

• the Message Interpretation area displays the C-Plane Secton 
Type 1 for the highlighted C-Plane message only.

To understand the effect of adding Extension Type 10 and 
Beamforming methodology to the MIMO configuration, follow the 
steps described further.
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4 In the ‘Options’ tab, under ‘C-Plane Section Handling’, select the “Use 
Extension Type 10 (MIMO only)” check box, so that Section Extension 
Type 10 is added to all sections in the C-Plane message.

Figure 368 Enabling the Extension Type 10 configuration option

Note that enabling Extension Type 10 in the Configuration Tool 
facilitates the feature to group Flow/eAxC IDs, such that the first 
selected eAxC ID becomes the “representative eAxC ID” for the group.

After you enable the “Use Extension Type 10 (MIMO Only)” in the 
Options tab, you shall notice that a button “Group” appears in the 
Flow/eAxC tab. 
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5 Select an eAxC ID.

Notice that the “Group” button is activated, as shown in Figure 369. In 
this example, ‘0003’ is selected as the “representative eAxC ID” for the 
group.

6 Press CTRL key and select other eAxC IDs you wish to group.

Figure 369 Grouping eAxC IDs with the representative eAxC ID

7 Click “Group”.
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Notice that all the eAxC IDs selected after the “representative eAxC ID” 
are displayed under the ‘Group’ column of the table, as shown in 
Figure 370.

Figure 370 Grouping eAxC IDs with the representative eAxC ID

• If there is a need to change the group or remove one or more eAxC 
IDs from a group, you must first ‘ungroup’ the representative eAxC 
ID.

i To remove grouping of eAxC IDs, select the row with the 
“representative eAxC ID” only.
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Notice that the “Group” button is replaced with “Ungroup”, as 
shown in Figure 371.

Figure 371 Ungroup eAxC IDs from the representative eAxC ID

ii Click “Ungroup” to remove grouping of eAxC IDs.

iii Repeat steps 4 to 6 to perform grouping of eAxC IDs in the 
desired manner.
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8 Click the “Beamforming” tab in the “C/U Plane Builder Configuration 
Tool”.

a To set Beam ID for each antenna,

i Set the ‘Beamforming Method’ to “predefined-beam 
beamforming”.

ii Set the ‘Size of the beam mapping table’ to correspond to the 
number of antennas in the MIMO configuration.

iii By default, the Beam ID has a 1-to-1 mapping with the Table 
Index, which can be seen in the Beam IDs tab under 
“Beamforming Mappings”. However, you may optionally double 
click to manually change the Beam ID values.

NOTE
Starting with ver. 1.3 of the U5040A Open RAN Studio software, 
Beam/Ue ID must be assigned individually to each antenna in a MIMO 
configuration.
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Figure 372 Configuring Beam IDs for each antenna in MIMO

b To set Ue ID for each antenna,

i Set the ‘Beamforming Method’ to “channel-information-based 
beamforming”.

ii Set the ‘Size of the beam mapping table’ to correspond to the 
number of antennas in the MIMO configuration.

iii By default, the Ue ID is assigned default values, starting from 0, 
for each value of Table Index, which can be seen in the Beam 
Channel Information tab under “Beamforming Mappings”. 
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However, you may optionally double click to manually change 
the ueId values.

iv Optionally, open the CI IQ sample file to include Section Type 6 
messages. Also, if required, set the value for “CI IQ Bitwidth” 
and select the “Add Ext Type 8 to Section Type 5” check box to 
include the corresponding extension.

Figure 373 Configuring Ue IDs for each antenna in MIMO

9 Exit the “C/U Plane Builder Configuration Tool”.

10 In the C-Plane Builder tab, assign a Flow/eAxC ID to each antenna.
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Figure 374 Assigning Flow/eAxC ID to each antenna

11 For each Resource allocation, assign the same or different Beam ID / 
Ue ID individually to each antenna.

a From the ‘Select Carrier’ drop-down, select an antenna entry.

b From the ‘Select BeamId’ drop-down, assign the corresponding 
Beam ID value. You may set the same Beam ID for more than one 
antennas.

Figure 375 Assigning Beam ID to each antenna

c Repeat the steps above to assign the corresponding Ue ID value, if 
the Beamforming Method is channel-information-based 
beamforming. Note that selecting “Reset” performs a reset of the Ue 
ID for the selected allocation.

NOTE
Beam Id 0 is reserved for NO BEAMFORMING and may be assigned only 
to allocation manually.
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Figure 376 Assigning Ue ID to each antenna

Also, note that if the selected allocation is “SS/PBCH”, you will see a 
button to set the Beam/Ue Id, instead of a drop-down field. See.

12 Export the O-RAN stimulus file with the modified configuration options.
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13 Switch to Explorer tab and load the MIMO PCAP file.

a For Beam ID

Figure 377 Viewing Group Config in Message Interpretation for Beam ID
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b For Ue ID (without adding Ext Type 8 to Section Type 5)

Figure 378 Viewing Group Config in Message Interpretation for Ue ID
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c For Ue ID (after adding Ext Type 8 to Section Type 5)

Figure 379 Viewing Group Config in Message Interpretation for Ue ID
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In the modified stimulus file,

• BeamGroupType is determined automatically by the software 
based on how Beam/Ue IDs have been assigned to the 
antennas. The following table helps you understand the various 
BeamGroupTypes and the value determined by the software.

Table 11 Understanding BeamGroupTypes

• the U-Plane, C-Plane Messages area displays one C-Plane 
message (combined) for all antennas

• the C-Plane area displays the “Representative eAxC ID”, which 
is used for Extension Type 10

• the Message Interpretation area displays the Section Extension, 
which is added to all sections in the C-Plane message

For more information about Extension Type 10, refer to Section 5.4.7.10 
ExtType=10: Section description for group configuration of multiple ports 
in the O-RAN specification.

 3.12.10: Recovering IQ from MIMO files

The process of recovering IQ data from Multi-Input-Multi-Output (MIMO) 
files is slightly different from that of other signals with DL / UL carrier. In 
this case, you must select the U-Plane flow in a serial order for proper 
recovery of IQ data.

BeamGroupType 
in Software

Corresponding 
specification 
value

Condition

0 00b When all antennas in a carrier are assigned equal 
Beam IDs. For example, BeamID ‘1’ is assigned to all 
four antennas in the illustration above.

1 01b When all antennas in a carrier are assigned 
consecutive Beam IDs. For example, BeamID ‘1, 2, 3, 
4’ is assigned to all four antennas in the illustration 
above.

2 10b When all antennas in a carrier are assigned arbitrary 
Beam IDs.

2 10b When all antennas in a carrier are assigned Ue IDs.
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For the purpose of understanding, an SCP file for the DL carrier with two 
antennas has been used in this example.

1 Load the MIMO SCP file into O-RAN Studio software.

Figure 380 Loading MIMO SCP file
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2 From the Select Carrier drop-down options, check the number of 
antennas configured in the Carrier.

Figure 381 Checking number of antennas in MIMO file

3 Open the “C/U-Plane Builder Configuration Tool” window to add more 
Flow/eAxC IDs to the respective carrier in the Flow/eAxC tab, to match 
the number of antennas checked in the previous step.

Figure 382 Adding Frame/eAxC IDs to match with no. of antennas
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4 Exit the “C/U-Plane Builder Configuration Tool” window.

5 Assign a Flow/eAxC ID to each antenna.

Figure 383 Adding Frame/eAxC IDs to each antenna

6 Export the O-RAN stimulus file.

7 Switch to Explorer tab and load the MIMO PCAP file.

Notice that In the U-Plane area, there are two flows, as shown in 
Figure 384, according to the number of Flow/eAxC IDs assigned 
earlier.

8 Click the first flow in order, that is, 0001. Then, press and hold the 
CTRL key to select the next in order, which is 0002. See Figure 384.

Let us consider a scenario where you have four eAxC IDs that are 
mapped to four layers of MIMO, which appear in the U-Plane in the 
following order in the ‘eAxC’ column:

0004

0002

0003

0001

For the proper recovery of IQ data, it is imperative that you select the 
flow in the following sequence:

• Select 0001

• Press and hold the CTRL key and select 0002

• With the CTRL key pressed down, select 0003

• With the CTRL key pressed down, select 0004
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Figure 384 Selecting U-Plane eAxC flow in serial order with CTRL key

NOTE
Selecting the flow in serial order in a MIMO PCAP file’s U-Plane is 
imperative because the Open RAN Studio software constructs the ORB 
file with the data according to the number of flows you select and filter 
(as channels) and in the correct order.

If you do not select all flows, the 89600 VSA software prompts an error. 
See Figure 389.

If you select all flows but in the wrong order, the 89600 VSA software will 
not prompt any error but will not demodulate.
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9 Click the icons for Filter on Selected Flow followed by Recover IQ 
Waveform. The Progress Dialog is displayed.

Figure 385 Progress dialog indicating extraction of files with IQ data

10 Launch the 89600 VSA software.

11 From the main menu, click File > Recall > Recall Setup....

12 On the Recall Setup window that appears, navigate to the folder where 
the SETX file, corresponding to the PCAP file captured by the O-RU 
device, is located.
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Figure 386 Loading the SETX file in 89600 VSA

13 Select the SETX file and click Open.

14 From the main menu, click File > Recall > Recall Recording....

15 On the Recall Recording window that appears, all stimulus files are 
displayed, which are associated with the SETX file loaded in the 
previous step. Select the ORB file.

16 On the right pane, under “Padding Selection”, select ‘Repetition’.

17 Modify “Factor” field to ‘3’.
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Figure 387 Loading ORB file to extract IQ data in the 89600 VSA software

18 Click Open.

The IQ data is recovered and the constellation diagram is plotted 
accurately, as shown in Figure 388, from MIMO.
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Figure 388 Recovered IQ data and Constellation for MIMO in 89600 VSA
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Figure 389 Error when flow is not selected in ORAN Studio software
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Section 3.13: Missing Configuration for eAxC ID’s

While loading a (recorded) “.pcap” file into Explorer, if the results in 
message lines are displayed in pink, this indicates that those messages 
have non-configured eAxC IDs. To fix this, correct eAxC’s must be 
configured in ORAN Studio by use of “Configuration Tool”. This can be 
fixed by either loading an Open RAN Studio settings (.orstx) file, or 
manually configuring the settings.

Figure 390 Missing configuration for eAxC IDs
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Section 4.1: Using PathWave Signal Generator for Waveform Setup

Perform the following steps for a waveform setup using the PathWave 
Signal Generation Desktop 2022 software:

1 Launch the PathWave Signal Generation Desktop 2022 software.

Figure 391 Waveform Setup process in PathWave Signal Generation Desktop 2022

2 Select “Waveform Setup” branch in the tree.

3 Add/delete carriers from the editing toolbox.

4 View the potential waveform by:

• Clicking “Waveform Generation” button.

• Looking at the information in “CCDF” and “Waveform” tabs.
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Section 4.2: Using PathWave Signal Generator for Channel Setup

Perform the following steps for a Channel setup using the PathWave 
Signal Generation Desktop 2022 software.

Figure 392 Channel Setup process in PathWave Signal Generation Desktop 2022

1 On the PathWave Signal Generation Desktop 2022 application, select 
“Carrier x (DL)” branch in the tree.

2 Click “Full-filled Config” button to quickly create fully filled channels at 
different numerologies and modulations schemes.
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Figure 393 Full-filled Configuration window

3 Click “DL Test Model” button to quickly create 3GPP antenna 
conformance test patterns for different numerologies.
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Figure 394 Viewing Downlink Test Model window

4 Click the “Waveform” tab if you wish to see the generated waveform.

5 When ready, click the “Export Signal Setup” button. This will open a 
dialog that allows you to save the RF design to use with Open RAN 
Studio. The file will be saved in (.SCP) format.

The steps described above pertain to Channel Setup for the Downlink 
carrier. Similarly, you may perform Channel Setup for the Uplink and 
PRACH carrier, respectively.
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Channel Setup interface for Uplink Carrier

Figure 395 Channel Setup for Uplink carrier
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Channel Setup interface for PRACH Carrier

Figure 396 Channel Setup for PRACH carrier
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 4.2.1: Channel Setup for LTE Support

The Open RAN Studio LTE TDD Support application requires an SCP file 
generated using the N7625C Signal Studio for LTE and LTE-Advanced 
TDD software (version 2.2.0.0). Similarly, the Open RAN Studio LTE FDD 
Support application requires an SCP file generated using the N7624C 
Signal Studio for LTE and LTE-Advanced FDD software (version 2.2.0.0). 
While the functionality is the same as that explained in these sections, the 
appearance of the Signal Studio interface is slightly different.

Appearance of the N7625C Signal Studio for LTE and LTE-Advanced TDD software

Figure 397 Channel Setup for LTE TDD carrier
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Appearance of the N7624C Signal Studio for LTE and LTE-Advanced FDD software

Figure 398 Channel Setup for LTE FDD carrier
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Section 4.3: Using PathWave Signal Generator for Mixed Numerology Carrier Setup

Perform the following steps for mixed numerology carrier setup using the 
PathWave Signal Generation Desktop 2022 software.

1 On the PathWave Signal Generation Desktop 2020 application, select 
“Carrier x (DL)” branch in the tree.

2 Create a carrier as normal, but set the “Numerology Mode” to “Multiple 
Numerologies”.

Figure 399 Mixed Numerology Carrier Setup

3 Select “BWP Setup” branch in the tree. Create bandwidth parts for the 
different numerologies and enable the active grids.
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Figure 400 Configuring information for BWP Setup

4 Select “Channel Setup” branch in the tree. Create channels and assign 
to bandwidth parts.
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Figure 401 Configuring information for Channel Setup
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Section 5.1: Overview

The Open RAN Studio Player software and the Integrated Hardware 
Appliance will playback Open RAN Studio Builder generated stimulus files 
to an O-RU Radio Unit over an Ethernet based interface. The Open RAN 
Studio Player emulates and is seen by the DUT (O-RU) as an O-DU. The 
Keysight Open RAN Studio Player application is provided for use on the 
Integrated Hardware Appliance.

To ensure compliant frame synchronization, the Open RAN Studio Player 
can also act as a PTP master and ensure that O-RAN messages are played 
honoring specified timestamps – enabling positive and negative testing of 
required timing windows.

The player also generates frames using the System Frame Number (SFN) 
algorithm in Section 9.7.2 of the O-RAN specification.

For further details on its application and key features, refer to the product 
datasheet available on www.keysight.com.

The Open RAN Studio provide a set of toolbar buttons, which controls the 
playback and capture handled by the connected DU Emulator (Player). If 
these buttons are dimmed it indicates that no O-DU Emulator is found 
running. (Configuration and availability test of O-DU Emulator is done via 
the “Configuration Tool”).

https://www.keysight.com/
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Section 5.2: Playback and Capture Toolbar

The tool bar provides the following convenient functions:

Table 12  Player toolbar

Elements Name Function

Load Stimulus This button loads a stimulus PCAP file for playout on the Open RAN 
O-DU Emulator.

Play Stimulus This button starts playout of a previously loaded “stimulus” file on the 
Open RAN O-DU Emulator.

Pause Stimulus This button toggles the O-DU Emulator state between stopped and 
running.

Single / Continuous Sweep This is a toggle button that controls single or continuous “stimulus” 
playout mode on O-DU Emulator. In single mode, the stimulus file is 
played “once” per click of the Play (or Pause) Stimulus button.

Record This button starts/stops recording on the Open RAN O-DU Emulator of 
traffic between the O-DU Emulator and the O-RU DUT. Note that this 
feature interleaves downlink and uplink traffic into a single “.pcap” 
recording.

Recording Length This button controls the maximum number of RF frames recorded by 
the O-DU Emulator. You can chose a number of frames from the pull 
down menu or enter a value like “100” RF frames. Value “0” will be 
captured continuously.
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Section 5.3: Play Continuous 

Perform the steps below to play the stimulus file continuously in an Open 
RAN O-DU Emulator:

1 Set the “Sweep” button  or  to “Continuous” mode .

2 When you click the “Play” button , its background changes to gray 

in color , implying that the O-DU Emulator is on and “playing”. 

Simultaneously, the “Pause” button  changes to black indicating 
the O-DU Emulator is running.

3 The “Sweep” button  or  is set to “Continuous” mode; thus, 
the play action continues until paused by clicking the “Pause” button 

.

4 When you click the “Pause” button  while the O-DU Emulator is 
playing (indicated by the “Play” button being gray), the O-DU Emulator 
will stop playing.

5 You can resume playing by either clicking the “Pause”  or the 

“Play” button .
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Section 5.4: Play Single Sweep

Perform the steps below to play stimulus file single sweep in an Open RAN 
O-DU Emulator:

1 Set the “Sweep” button  or  to “Single” mode .

2 When you click the “Play” button , its background changes to gray 

in color , implying that the O-DU Emulator is on and “playing”. 

Simultaneously, the “Pause” button  changes to black indicating 
the O-DU Emulator is running. These indications last only as long as it 
takes to play a single sweep (that is, to play the stimulus file once).

3 The “Sweep” button  or  is set to “Single” mode ; thus, the 
play action will just play the stimulus file once.

4 After playing the stimulus file, once the O-DU Emulator stops 
automatically, it is indicated by the “Play” button's background turning 

black  and the “Pause” button's background turning gray .

5 You may trigger a new sweep by either clicking the “Pause”  or the 

“Play” button .
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Section 5.5: Capture Number of Radio frames

Perform the following steps to use the O-RAN studio to capture a number 
of radio frames:

1 The “Record” button together with the associated combo-box controls 
the O-DU Emulator capture function.

2 When the  “Record” button is clicked, a Stop icon is displayed and 

the button’s background changes to gray in color , implying that 
the O-DU Emulator is on and “capturing”. The O-DU captures a 
number of radio frames as specified in the combo-box. The captured 
data contains both DL (played by “player”) and UL traffic (received from 
DUT). The file is formatted as a “.pcap” file.

3 As a special case, the recording length can be specified to “Until Full”. 
This implies that recording is running infinitely – or until the file is full. 
In this mode, no DL traffic is captured and the recorder works as a 
sniffer, simply capturing everything received.

4 The recording does not automatically stop. The recording continues 
until the radio frame count specified in the combo-box has been 
reached, or until the Stop button is clicked.

NOTE
This mode should capture at least the specified number of radio frames 
based on the size of the input stimulus. In most cases, it will capture at 
least one additional radio frame to guarantee that a full frame is 
captured.
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Section 5.6: Capture and Load a File

Perform the following steps to capture a file and open in the O-RAN Studio 
Explorer:

1 When the recording is completed by clicking the Stop button, a dialog 
box pops up as the captured file is being stored. The captured file, 
named captured <year-month-day-hour-min-sec>.pcap, is stored on 
the file system in the same folder as the stimulus that was loaded (or in 
the user’s “Documents” folder if no stimulus was loaded).

The destination of the saved captured file is shown in the “Progress 
Dialog” window when file transfer is completed.

Figure 402 Progress Dialog displaying status of file capturing activity

2 When the file transfer is completed, the captured file can automatically 
be opened in Explorer by selecting “Open captured file in Explorer” 
check box before you click “OK”.
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Figure 403 Progress Dialog option to open file in Explorer

“Progress Dialog” window is closed after you click “OK” and the 
captured file opens in the Explorer. 

The file name is shown in the Status bar as highlighted below:

Figure 404 Captured file location displayed on Status bar
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Appendix I: IQ Scaling Flow  
 
Signal Studio I/Q ⇒ Scale within dBFS Circle ⇒ Scale with Additional IQ Power Scaling AND* FS Adjustment ⇒ Scale to Configured IQ Width 

 

Modulation 
Type 

Signal Studio I/Q 
(Value_0) 

Scale within dBFS Circle 
Single Constellation OR 256 QAM Scaling 
(Value_1) 

Scale with Additional IQ Power Scaling AND* FS Adjustment 
(Value_2)  
*In practice you’d probably only use one of them. 

Scale to Configured IQ Width 
(Value_3) 

  Single** Constellation 
Scaling 
** carrier can have multiple kinds of 
modulations. In this case we apply the 
“largest” 

With 256 QAM Scaling 
 

Additional IQ Power Scaling by 
-X dBFS 

FS Adjustment by Y 
FS_Offset 

No Compression  
OR 
Block Scaling Re(fPRB) / 
Im(fPRB) 

Block Floating Point 
Re(fPRB) / Im(fPRB) 

µ-Law 
Compression 
prbI / prbQ 
 

4QAM Value_0 
 
e.g. 
1/√2 = 0.707 

 

(Value_0 / 1) 
 
e.g. 
0.707/1=0.707 
 

(Value_0 / 1.62715) 
 
e.g. 
0.707/1.62715=0.4345 

(Value_1/10^(X/20)) 
 
e.g. 
Single Constellation Scaling 
& -6 dBFS Additional Power 
Scaling 
 
I/Q= (0.707/10^(6/20)) 
 
e.g. 
256 QAM Constellation Scaling 
& No Additional Power Scaling 
 
I/Q = 0.4345 
 
 

(Value_1/sqrt(1/2^-Y))  
 
e.g. 
Single Constellation 
Scaling 
& FS Adjustment by 2 
FS_Offset 
 
I/Q= (0.707/sqrt(1/2^-2)) 
 
e.g. 
256 QAM Constellation 
Scaling 
& No FS Adjustment 
 
I/Q = 0.4345 

(Value_2 * 2^(IQWidth -1)) 
 
e.g. 
Single Constellation Scaling 
& 16-bit IQ Width 
I/Q=0.707*2^15=23166 
 
Single Constellation Scaling 
& -6 dBFS Additional Power 
Scaling  
& 16-bit IQ Width 
I/Q= (0.707/10^(6/20))*2^15 = 
11610 
 
Single Constellation Scaling 
& FS Adjustment by 2 FS_Offset 
& 16-bit IQ Width 
I/Q= (0.707/sqrt(1/2^-2))*2^15 
= 11583  

(Value_2 
*(2^(mantissaBW-1)) * 
(2^(2^exponentBW)-1)) 
 
mantissaBW  : Mantissa 
bitwidth is user configured 
bitwidth 
exponentBW  : 4 bits for 
Exponent 
 
e.g. 
Single Constellation 
Scaling 
& Block Floating Point (IQ 
Width 16) 
 
I/Q = (0.707 *(2^15) * 
(2^(2^4)-1)) = 759135469 

(Value_2 * 2^15) 
 
IQ Width fixed to 
16 
 

16QAM Value_0 
e.g. 
3/√10 = 0.94 

 

(Value_0 / 1.329561528) 
 
e.g. 
0.94/1.329561528=0.707 
 

(Value_0 /1.62715) 
 
e.g. 
0.94/1.62715=0.577 

Same as above Same as above Same as above Same as above Same as above 

64QAM Value_0 
e.g. 
7/√42 =  1.08012 

 

(Value_0 / 1.527751061) 
 
e.g. 
1.0802/1.527751061=0.707 
 

(Value_0 / 1.62715) 
 
e.g. 
1.0802/1.62715=0.66 

Same as above Same as above Same as above Same as above Same as above 

256QAM Value_0 
e.g. 
15/√170 =  1.1504 

 

(Value_0 / 1.62715) 
 
e.g. 
1.1504/1.62715=0.707  
 

(Value_0 /  1.62715) 
 
e.g. 
1.1504/1.62715=0.707 

Same as above Same as above Same as above Same as above Same as above 
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